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1.	 Introduction

1.1	 Revision History

Version Revision Date

1.0 2014.07

1.1 2014.11

1.2 2015.04

1.3 2015.10

1.4 2016.08

1.5 2017.05

1.6 2018.08

This instruction guide and the corresponding intellectual property rights belong to ACEA 
Biosciences, Inc. This instruction manual may not be reproduced, transmitted, tran-
scribed, translated, or stored in a retrieval system in any form without the written consent 
of ACEA Biosciences, Inc.

1.2	 About the NovoExpress Software

The NovoExpress® Software provides users with the ability to control data collection and 
analysis on the NovoCyte® and NovoCyte QuanteonTM Flow Cytometer. The software con-
tains features to control Quality Control (QC) test, sample acquisition, data analysis, and 
report generation. The NovoExpress Software is the property of ACEA Biosciences, Inc. 
and cannot be copied or modified in any way without the written consent of ACEA Biosci-
ences, Inc.

1.3	 Conventions

Text Conventions

To impart information that is consistent and easy-to-read, the following text conventions 
are used in this guide:

Format Description

Numbered Listing 
1  2  ......

Describes the steps in a procedure that must be performed 
in the listed order.

Italic Font, gold Points to a different chapter in this guide, which should be 
referred to for better understanding.
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Format Description

Italic Font Describes buttons, icons or functions when operating the 
NovoExpress software. In addition, important notes and in-
formation notes are also shown in italic font. 

→ Indicates the sequence of the menu operation in NovoEx-
press software. For example, File → Print means to select the 
Print function from the File menu.

Ctrl+X When used with keyboard characters, + means to press two 
keys simultaneously. For example, Ctrl + C means to hold 
down the Control key while pressing the letter C key. 

Symbols

The following table lists the symbols used in this guide:

Symbol Meaning Description

IMPORTANT NOTE This symbol indicates information which is critical to 
the success of the procedure or use of the product. 

ADDITIONAL  
INFORMATION

This symbol provides additional information about the 
current topic or procedure. 

uuu Table continues on the next page. 

n End of a table.
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2.	 Installation

This chapter will introduce the installation and un-installation of the NovoExpress Soft-
ware and the software user management feature.

2.1	 Installation Requirements

Before installing the NovoExpress Software, ensure that your computer meets the follow-
ing minimum requirements:

Hardware:

►► �Processor: 1 GHz

►► �Computer Memory: 2 GB

►► �Hard Drive: 2 GB free space

►► �Screen Resolution: 1024×768 pixels or higher

Software:

►► �Operating System: Windows XP SP3/Windows Vista SP2/Windows 7 SP1/Windows 
8/Windows 10

►► �PDF Reader Software

 �To analyze high event-count samples (event count greater than 1 million), 8 GB mem-
ory and quad-core 2.5 GHz CPU are required.

2.2	 Installing the NovoExpress Software

Install the NovoExpress Software using the following instructions:

1 Download the NovoExpress Software installation package from website http://www.ace-
abio.com/novoexpress and unzip it. Double-click the SetupEn.exe file in the NovoExpress 
installation directory to start the installation process.

2 The NovoExpress Software installation wizard will display. Click Next to continue.

uuu

http://www.aceabio.com/novoexpress
http://www.aceabio.com/novoexpress
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3 Please read the license agreement and accept by selecting the check box and clicking 
Next.

4 Choose the installation location. By default, the NovoExpress Software will be installed 
in C:\Program Files (x86)\NovoExpress. To install the software to another location, enter 
the target location or click Browse to select a destination folder. If the selected path does 
not exist, the installation wizard will automatically create the directory. After selecting the 
destination folder, click Install to continue.

uuu
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5 After the installation is complete, click Finish to finish the installation and start the soft-
ware. If you would not like to immediately start the software, uncheck the Run NovoEx-
press box, and click Finish.

n

 �The installation of PDFCreator 1.7.1 is included with the NovoExpress Software instal-
lation. Please do not uninstall or update PDFCreator, as doing so may cause exporting 
to PDF files through the NovoExpress Software not working properly.

2.3	 Starting the NovoExpress Software

After the successful installation of the NovoExpress Software, the program can be started 
by the following methods:

►► �Desktop Shortcut

►► �Start Menu
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2.4	 Uninstalling the NovoExpress Software

The NovoExpress Software can be uninstalled by the following methods:

►► �Control Panel

Start → Control Panel → Program and Features

In the new window, select NovoExpress and select Uninstall/Change.

►► �Start Menu

2.5	 NovoExpress License

NovoExpress is available for a 30-day free trial. Registration will be needed to use the soft-
ware after the trial expiration. NovoExpress Software License Key comes with NovoCyte 
Flow Cytometer, and can also be purchased separately from ACEA.
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2.5.1	 NovoExpress Registration

The Register NovoExpress window will automatically pop up when starting the NovoEx-
press software if the software is not registered yet. You can also click File → About → 
Register NovoExpress to open the Register NovoExpress window. There are two ways to 
register NovoExpress.

►► �If the computer is connected to the internet, enter a valid ACEA Biosciences issued 
license key and click the Register button to register NovoExpress.

►► �If the computer is not connected to the internet, click the Offline Registration button 
to switch to offline registration mode. Write down the Machine Code displayed in the 
window, and go to another computer that is connected to the internet and open the 
Get Registration Code web page (http://www.aceabio.com/novoexpress). On the web 
page, enter the Machine Code into the specified textbox, type a valid ACEA Biosci-
ences issued license key, and then click Get Registration Code. Write down the Regis-
tration Code, enter it to the Register NovoExpress window, and click Register button to 
register NovoExpress.

 �A license key is required for NovoExpress software registration or license transfer. Keep 
a safe record of license key assigned to each computer or user. 

2.5.2	 NovoExpress Dissociation

NovoExpress supports license transfer to another computer. Each license may be trans-
ferred up to 5 times. If you want to transfer the NovoExpress license to another computer, 
click File → About → Dissociate NovoExpress to open the Dissociate NovoExpress window.

http://www.aceabio.com/novoexpress
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Enter the original license key in the text box and click the Dissociate button to dissociate or 
decouple NovoExpress from this computer. After dissociation, the license key can be used 
to register NovoExpress on another computer.

 �Please connect the workstation to the internet when dissociating the license. Contact 
ACEA technical support for how to dissociate the license if no connection to the internet 
is available.

2.6	 User Management

A user management feature is included with the NovoExpress Software allowing for sepa-
rate user settings to be saved in different accounts.

When starting the NovoExpress Software, a login window will appear. By checking the 
Auto Login box, the software will automatically login with the associated user account and 
the login window will not appear in the future. 

The NovoExpress Software initially includes a system administrator account with user-
name as “administrator”. The default password for this account is “administrator”. This 
system administrator account has the highest privilege and the username “administrator” 
cannot be changed. This system administrator and users with the Administrator privilege 
can add, delete, and modify information for all the other users and user groups. There is 
no limit to the number of user groups or user accounts. Each user belongs to a specific 
user group. The methods for adding, modifying and deleting a user group are described 
in Section 2.6.1. The methods for adding, modifying, and deleting a user account are de-
scribed in Section 2.6.2. A user can directly enter the username and password to log in the 
software, or select the specific user group first, select the username, and enter the correct 
password to log in the software.

2.6.1	 User Groups

NovoExpress contains a user group management feature to allow groups of multiple users. 
Only users with Administrator privilege can add, modify, and delete user groups. The root 
parent group “Organization” is included by default. Users can only add group under this 
root group.

2.6.1.1	 Adding a User Group

New user groups can only be added through an account with Administrator privilege. To 
add a new user group:

1 Log into the software using an account with Administrator privilege.

uuu
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2 Select the Setting tab.

3 Click User → Management. The User Management window will appear.

4 Click Add Group. The Add User Group window will appear.

5 Enter the group name and select the desired parent group for the created user group in 
the prompted window. 

6 Click Add and the new user group is created.

n

2.6.1.2	 Modifying a User Group

User groups can only be modified through an account with Administrator privilege. To 
modify a user group:

1 Log into the software using an account with Administrator privilege.

2 Select the Setting tab.

uuu
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3 Click User → Management. The User Management window will appear.

4 Select the group to be modified. Click Modify. The Modify Group window will appear.

5 Modify the group name and select the desired parent group for the modified user group 
in the prompted window.

6 Click Modify and the user group is modified.

n

2.6.1.3	 Deleting a User Group

User groups can only be deleted through an account with Administrator privilege. To de-
lete a user group:

1 Log into the software using an account with Administrator privilege.

2 Select the Setting tab.

uuu



17

22
Installation

User Management

3 Click User → Management. The User Management window will appear. Select the group 
to be deleted. Click Delete.

4 Click Yes in the prompted window and the selected user group is deleted.

n

 �When the selected user group is deleted, the user accounts in the group will automati-
cally be moved to the deleted group’s parent group.

 �The root parent group Organization cannot be deleted. 

2.6.1.4	 Display the Users in a User Group

The right half of the User Management window displays the users contained in the user 
groups with check box checked in the left half of the window. All displayed usernames are 
automatically listed in alphabetical order.
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2.6.2	 Users

NovoExpress contains a user management feature to allow different settings and privileges 
for each user account. Only users with the Administrator privilege can add, modify, and 
delete user accounts.
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2.6.2.1	 Adding a New User

New users can only be added through an account with Administrator privilege. To add a 
new user:

1 Log into the software using an account with Administrator privilege.

2 Select the Setting tab.

3 Click User → Management. The User Management window will appear.

4 Select a user group. Click Add User. The Add User window will appear.

5 Enter username and password and assign user privilege (User or Administrator) for the 
created account in the prompted window. 

6 Click Add and the new user account is created.

n
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2.6.2.2	 Modifying User Information

Accounts with Administrator privilege can modify username, user privilege, access privi-
lege, and password for each user, while other accounts can only modify its own username, 
user group name, and password.

►► From the administrator account or an account with Administrator privilege:

1 �After logging in, select the Setting tab.

2 Click User → Management. The User Management window will appear. Select the 
user group, and then the user account you would like to modify.

3 �Click Modify. The Modify window will appear allowing the user to make changes to 
the account.

n
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►► From individual user accounts:

1 �After logging in, select the Setting tab.

Click User → Modify. The Modify window will appear allowing the user to make 
changes to the logged in account. Please note User Privilege and Access Privilege 
can only be modified by accounts with Administrator privilege.

n

2.6.2.3	 Access Privilege

Several functions in NovoExpress are only accessible to accounts with specified Access 
Privileges, including:

►► Photodetector Gain Adjustment

►► View Transaction Log

►► View System Log

►► Decontaminate Instrument

►► Delete Sample Events

►► Calibrate the Fluidics Station

►► Purge Instrument

►► Power Down/Up NovoSampler

►► Post Gain Adjustment

►► Customize Optical Configuration

To modify the Access Privilege for users, click the  button in the Modify window and 
then select or unselect checkboxes in the popup Access Privilege window. Click OK to 
confirm changes.
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2.6.2.4	 Deleting a User

User accounts can only be deleted through an account with Administrator privilege. To 
delete a user account:

1 Login to the software as the administrator or an account with Administrator privilege.

2 Select the Setting tab.

3 Click User → Management. The User Management window will appear.

4 Select the user account that you would like to delete.

5 Click Delete.

6 In the confirmation window, click Yes.

n
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3.	 Using the NovoExpress Software

3.1	 NovoExpress Software Interface

After starting the NovoExpress Software, the initial interface will include a Title Block, 
Menu, Cytometer Setting Panel, Toolbar, Experiment Manager Panel, Cytometer Control 
Panel, Work Space, and Status Bar.
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3.2	 Title Block

The Title Block displays the data file name in the center. It also provides options for open-
ing, saving, and closing an experiment file.

Icon Description

Clicking this button displays a drop-down menu with options to 
resize the display window and close the software.

Saves the experiment file.

Creates a new experiment file.

Opens an experiment file.

Undo drawing gates, deleting gates, zooming in or zooming out on 
a plot, etc. This operation is only effective for plot related functions. 

Redo drawing gates, delete gates, zooming in or zooming out on a 
plot, etc. This operation is only effective for plot related functions.

Displays the data file name (*.ncf).

Minimizes window.

Maximizes window.

Restores window.

Closes window.

n
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3.3	 Menu 

The Menu contains functions for instrument control and data analysis.

3.3.1	 File

Icon Description

New experiment file

►► �New Experiment: Creates a new experiment file.

►► �New from Template: Imports a template (*.nct) for the new experiment.

►► �New from Experiment File: Creates a new experiment file with the ex-
periment setting and data analysis method inherited from an existing 
experiment file. 

uuu
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Icon Description

Open experiment (*.ncf) file

►► �Open Experiment File: Opens an experiment file.

►► �Import FCS files: Imports selected file to the current specimen.

►► �Import FCS Files from Folder: Imports all FCS files in a selected folder 
to the current FCS specimen.

Closes the current experiment file and creates a new experiment file.

Saves the experiment data, experiment setup, and data analysis of the 
current experiment file.

Saves the current experiment file to a specified location.

Prints sample report/batch print reports

►► Print Report for Active Sample: Prints the report for the current sample.

►► Batch Print Reports: Opens the Batch Print Reports window.

uuu
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Menu 

Icon Description

About: Contains the software version, copyright information, help files, 
and registration information.

►► �About NovoExpress: Displays the software version and copyright in-
formation. 

►► �Register NovoExpress: Registers the NovoExpress software. 

►► �Help Document: Opens the help file.

Options: Opens the Options window. See Section 3.3.8 Setting for details.

Recent Documents: Shows recently opened data files. Up to 10 files can 
be displayed. Click the file name to directly open the corresponding file.

Logout: Exits and logs out of the current account. The login window will 
appear.

Exit: Exits the software.

n
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3.3.2	 Home

Icon Description

Clipboard

Copy: Copies the selected gate or selected data.

Paste: Pastes the copied gate to other plots, or pastes the copied item in the 
Experiment Manager.

Duplicate: Creates a duplicate of the plot (the gates will not be included.), or 
creates a duplicate sample or specimen.

Editor

Undo drawing gates, deleting gates, zooming in or zooming out on a plot, etc. 
This operation is only effective for plot-related functions. 

Redo drawing gates, delete gates, zooming in or zooming out on a plot, etc. 
This operation is only effective for plot-related functions.

Select All: Selects all the gates in the current plot.

Delete: Deletes the selected gate.

Compensation Settings

Auto Compensation: Opens the Automatic Compensation Settings window. 

Compensation Matrix: Displays the current compensation matrix for the se-
lected sample.

Quick Compensation: Displays the Compensation scrollbars on the active plot 
for quick compensation.

Experiments

Work List: Users may view and edit the work list.

Statistical Table: Creates a statistical analysis table.

Heat Map: Creates a heat map for the defined parameter in a plate layout 
format.

Tools

Batch Print Reports: Prints or creates PDF of multiple test reports.

uuu



29

33

Using the NovoExpress Software

Menu 

Icon Description

Free Unused File Space: When events of a sample or entire samples are de-
leted, the file space is not automatically released. Click on this icon to free the 
file space. The file space can also be released by saving the file to the hard 
drive. Large files may take longer to release.

Export to LIS: 

This function allows a user to export data analysis results in the designated 
format to CSV file and such CSV file can be parsed by a Laboratory Informa-
tion System (LIS) or read by other programs.

►► Statistical table template: Sets the proper statistical table template to ex-
port the data. To add a statistical table template, export the statistical table 
as a template to the default folder “User data root folder\Statistical Table 
Templates”.Refer to Section 5.7.6 Statistical Table Management for details.

►► Export plots in Specimen/Sample report as image: Once selected,  plots in 
the specimen report or sample report will be exported as images in the 
selected image file format to the designated folder.

►► Image file format: Sets the image file format of the export plots, including 
PNG, JPEG, Bitmap, GIF and TIFF format.

►► Export: Exports the data and the plots into designated folders. The data will 
be exported into *.csv file in UTF-8 code. * is the same as the experiment 
name. The created csv file will be automatically saved in “User data root 
folder\LIS Results” folder, and plots will be saved in “User data root fol-
der\LIS Plots” folder. The default user data root folder is “D:\NovoExpress 
Data\administrator” and can be changed. Refer to 3.3.8 Setting for details 
of changing the default user data root folder.

uuu
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Menu 

Icon Description

Transaction Log: Displays the Transaction Log window. Records can be filtered 
by Time, Computer, User, and Action. Only accounts with the View Transaction 
Log privilege can access the Transaction Log. 

System Log: Displays the System Log window. Only accounts which have the 
View System Log privilege can access the System Log. The System Log window 
records information including user login and log out, and instrument operating 
activities including data acquisition, fluidic maintenance, etc.

Technical Support Request: Technical Support Request Creation Wizard 
automatically collects NovoCyte configurations, NovoExpress system 
logs, current screenshot, current experiment file and other informati-
on that helps diagnosis and troubleshooting of NovoCyte instrument. 
You can also attach any other files using this function. Refer to Sec-
tion 9 Troubleshooting for details.
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3.3.3	 Instrument

3.3.3.1	 NovoCyte Instrument

Icon Description

Instrument

Information: Displays the instrument information. 

Configuration: Displays and modifies the NovoCyte Flow Cytometer excitation 
laser and detection channel and options for the NovoSampler and NovoSam-
pler Pro. See Section 4.4 Instrument Configuration for details.

QC Test Report: Displays results from QC tests. The results can be viewed 
individually or plotted over a time interval in a Levey-Jennings chart. 

Operation

Shut Down: Starts the shutdown process. After completion, the NovoCyte in-
strument will automatically turn off. To clean sample injection probe while 
shutting down NovoCyte, see NovoCyte® Flow Cytometer Operator’s Guide for 
more information.

QC Test: Runs the instrument QC test.

uuu



32

33

Using the NovoExpress Software

Menu 
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Calibrate Fluidics Station: Long distance transportation, movement and other 
reasons may cause the fluidics station system malfunction. Use this function 
to re-calibrate the fluidics station. After clicking the button, it will ask to re-
move the instrument reagent containers from the fluidics station before cali-
bration. Only accounts with the Calibrate Fluidics Station privilege can calibrate 
the fluidics station.

Replace Fluidic System Consumables: Click the button to open the Replace 
Fluidic System Consumables window, and follow the instructions to replace 
fluidic system consumables. See NovoCyte® Flow Cytometer Operator’s Guide 
for more information.

 �NovoCyte flow cytometer monitors the accumulated running time of 
the fluidic system consumables to ensure the consumables are changed 
in a timely manner for optimal flow cytometry results. When the ac-
cumulated running time is reached, NovoExpress software will prompt 
a message to remind the users to replace the consumables.

Fluidics Maintenance

Debubble: Removes the air bubbles from the fluidic system. 

Cleaning: Uses a cleaning solution to decontaminate the biohazards that may 
exist in the fluidic system. 

Rinse: Rinses the fluidic system using a rinsing solution. 

Extensive Rinse: Performs an extensive rinse of the fluidic system.

Priming: After the instrument has not been in use for a period of time, this 
function clears the air bubbles and primes the fluidic system with fresh sheath 
fluid. 

Unclog: Clears blockage from the flow cell. 

Backflush: Clears blockage from the sample injection probe.

Purge: If the NovoCyte flow cytometer needs to be shipped, click this button 
and follow the procedure shown on the popup window to purge the fluidic 
system before packaging and shipment. Only accounts with the Purge Instru-
ment privilege can perform the purge operation. Refer to Section 2.7 Purge 
Fluidic System before Shipment in the NovoCyte® Flow Cytometer Maintenance 
Guide for detailed procedure.

Decontamination: If the NovoCyte flow cytometer is known to have bacte-
rial contamination or to prevent the occurrence of bacterial contamination, 
click this button and follow the instruction shown in the popup window to 
decontaminate the instrument. Only accounts with the Decontaminate Instru-
ment privilege can perform this decontamination operation. Refer to Section 
2.5 Decontamination in the NovoCyte® Flow Cytometer Maintenance Guide for 
detailed procedure.
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3.3.3.2	 NovoCyte Quanteon Instrument

Icon Description

Instrument

Information: Displays the instrument information. 

Configuration: Displays and modifies the NovoCyte Quanteon Flow Cytometer 
excitation laser and detection channel and options for the NovoSampler Q. 
See Section 4.4 Instrument Configuration for details.

QC Test Report: Displays results from QC tests. The results can be viewed 
individually or plotted over a time interval in a Levey-Jennings chart. 

Operation

Shut Down: Starts the shutdown process. After completion, the NovoCyte 
Quanteon instrument will automatically turn off. To clean sample injection 
probe while shutting down NovoCyte Quanteon, see NovoCyte QuanteonTM 
Flow Cytometer Operator’s Guide for more information.

QC Test: Runs the instrument QC test.

Calibrate Fluidics Station: Long distance transportation, movement and other 
reasons may cause the fluidics station system malfunction. Use this function 
to re-calibrate the fluidics station. After clicking the button, it will ask to re-
move the instrument reagent containers from the fluidics station before cali-
bration. Only accounts with the Calibrate Fluidics Station privilege can calibrate 
the fluidics station.

uuu



34

33

Using the NovoExpress Software

Menu 

Icon Description

Replace Fluidic System Consumables: Click the button to open the Replace 
Fluidic System Consumables window, and follow the instructions to replace 
fluidic system consumables. See NovoCyte QuanteonTM Flow Cytometer Opera-
tor’s Guide for more information.

 �NovoCyte flow cytometer monitors the accumulated running time of 
the fluidic system consumables to ensure the consumables are changed 
in a timely manner for optimal flow cytometry results. When the ac-
cumulated running time is reached, NovoExpress software will prompt 
a message to remind the users to replace the consumables.

Fluidics Maintenance

Debubble: Removes the air bubbles from the fluidic system. 

Cleaning: Uses a cleaning solution to decontaminate the biohazards that may 
exist in the fluidic system.

Rinse: Rinses the fluidic system using a rinsing solution. 

Priming: After the instrument has not been in use for a period of time, this 
function clears the air bubbles and primes the fluidic system with fresh sheath 
fluid.

Unclog: Clears blockage from the flow cell. 

Purge: If the NovoCyte Quanteon flow cytometer needs to be shipped, click 
this button and follow the procedure shown on the popup window to purge 
the fluidic system before packaging and shipment. Only accounts with the 
Purge Instrument privilege can perform the purge operation. Refer to Section 
2.5 Purge Fluidic System before Shipment in the NovoCyte QuanteonTM Flow 
Cytometer Maintenance Guide for detailed procedure.

Decontamination: If the NovoCyte Quanteon flow cytometer is known to have 
bacterial contamination or to prevent the occurrence of bacterial contamina-
tion, click this button and follow the instruction shown in the popup window to 
decontaminate the instrument. Only accounts with the Decontaminate Instru-
ment privilege can perform this decontamination operation. Refer to Section 
2.3 Decontamination in the NovoCyte QuanteonTM Flow Cytometer Maintenance 
Guide for detailed procedure.
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3.3.4	 Sample

Icon Description

Import and Export

Import FCS File: Users may select FCS format files to import.

Export FCS File: Exports the current data into a FCS file.

Export CSV File: Exports the current data into a CSV file.

Export Plots: Exports the plots of the active sample into files in PNG, JPEG,

Bitmap, GIF, or TIFF format.

Switch Active Sample

Previous: Switches the Active Sample to the previous sample.

Next: Switches the Active Sample to the next sample.

Select: Switches to an Active Sample from the prompted drop-down menu.

Other

Delete Events: Deletes events from a sample. Users may select events inside a 
gate, outside a gate, or all events to delete. If the threshold or the photodetec-
tor gain has been adjusted during data acquisition, the Prior to last threshold 
or photodetector gain change radio button will be available to allow event dele-
tion before the last adjustment. Only accounts with the Delete Sample Events 
privilege can perform this operation.

 �After deleting the events from a sample, the file size does not automati-
cally decrease. When saving the file, the software will prompt a win-
dow, asking if the unused file space is to be released or not. To manually 
release the unused space, refer to Section 3.3.2 for details.
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Absolute Count Setting: Sets up absolute counting conditions for active sam-
ple.

►► Dilution Factor: 

The Dilution Factor is conversion coefficient used to calculate the absolute 
counting results for the original sample. For instance, if the original sample 
is diluted 10 times and is run on NovoCyte flow cytometer, enter 1:10 in 
the Dilution Factor. NovoExpress software will show the absolute count-
ing results for the original sample by multiplying the concentration of the 
sample run on NovoCyte by 10. 

►► Absolute Count Unit: 

The Absolute Count Unit is parameter to set the unit for the absolute 
counting. User can select one of the units (i.e. No./µL, No./mL, or No./L) 
to present absolute count result for number of interested particles per 
microliter, per milliliter, or per liter.

►► Set as Default: 

Set the Absolute Count setting (i.e. Dilution Factor and Absolute Count 
Unit) as default for new samples.

 �Changing the settings in File → Options → Absolute Count tab 
also sets the settings as default. 

►► Show Absolute Count in Statistics: 

Show Absolute Count column in the statistical table of the plots in the 
workspace.

 �There are three states of the checkbox:
l    : Show Absolute Count column for all plots of the sample.
l    : No change.
l    : Hide Absolute Count column for all plots of the sample.

►► Apply to All Samples in the Experiment File: 

Set Absolute Count Setting for all samples in the experiment file.

►► Apply to All Samples in the Same Specimen: 

Set Absolute Count Setting for all samples belonging to the same speci-
men as the active sample.

Further information on absolute count calculations are described in Section 
5.3.2.

Remove Post Gain: Click this button to remove Post Gain of all parameters of 
the Active Sample. Only accounts with the Post Gain Adjustment privilege can 
perform this operation. To adjust Post Gain, refer to Section 5.9.
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3.3.5	 Plot

Icon Description

Properties

Plot Type: Changes the plot type for the selected plot.

Overlays: Opens the Edit Overlays window. Overlay is 
only available for dot plots and histograms.

Gating: The gate and its events are selected as the 
current data source for plotting.

Show Title on Plot: Toggle on and off the display of a 
title on plots. This is set for all data analysis plots in 
the Workspace.

Plot Name: Sets the name of a plot.

X -Axis, Y –Axis

►► Sets plot properties for the X and Y-axes including 
the plotted parameter, scale (linear, logarithmic, or 
biexponential), and the display range.

►► Custom Range: Uses the input boxes to set the 
minimum and maximum displayed values for the 
selected parameter.

►► Automatic Range  : Automatically sets the ran-
ge of the X and Y-Axes according to the range of 
the dataset.

►► Full Range  : Sets the full range of the X and Y-
Axes. The default range is 224=16,777,216.

Format
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Format the cell cycle plot 

Format the cell proliferation 
plot

Format dot plots, density plots, 
histograms, contour plots

Format: Controls format settings for the plots. Avail-
able settings depend on the type of the selected plots.

►► �Smooth: Smooths the data in histogram and den-
sity plots.

►► �Pseudocolor: Density plots are displayed in pseu-
do-color to visualize event density.

►► �Cell Cycle Setting: Opens the Cell Cycle Setting 
window to set the parameters for cell cycle ana-
lysis.

►► Cell Proliferation Setting: Opens the Cell Prolifera-
tion Setting window to set the parameters for cell 
proliferation analysis.

►► �Number of Events Displayed: Opens a window to 
set the number of events to be displayed in the 
plot.

►► �Show Fitting Result: Displays the results for the cell 
cycle analysis.

►► �Filling: Sets the histogram fill mode: None, Filled, 
or Tinted.

►► �Contour Level: Sets the contour levels in contour 
plots. The three levels are: 10%, 5%, and 2%.

►► Show Outlier: Show outlier events as dots on con-
tour plot.

Output

Save As Image: The plot can be exported in JPEG, 
BMP, PNG, GIF, TIFF, and EMF formats. EMF format 
is a vector format which, when exporting, uses 600dpi 
resolution TIFF format.

Copy: Selects from the drop-down menu to copy to the 
clipboard. The plots can then be pasted into Micro-
soft® Word, PowerPoint, Excel, and other documents. 

Pull-down options include: 

►► Copy Plot (Bitmap): Copies the selected plot as a 
Bitmap.

►► Copy Plot with Statistics (Bitmap): Copies the se-
lected plot and associated statistical information 
as a Bitmap. 

►► Copy Vector Graphics (EMF): Copies the selected 
plot as an EMF.

►► Copy Statistics (Text): Copies the statistics for the 
selected plot in text format.
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3.3.6	 Gate

Icon Description

Current Selection

Provides a drop-down menu of all available gates. A gate can be 
selected from this list. The Edit button is available only when a logic 
gate is selected. Click the Edit button to open the Edit Logic Gate 
window for modifying the setting of a logic gate.

Format

Formats the selected gate. 

Gate Name: Sets the name for the selected gate.

Color: Sets the color for the selected gate.

Show Percentile: Shows the percentage of the gated events relative 
to the total number of events on the plot.

If the Show population percentile in gate label in Setting → Analysis 
is not checked, the Show Percentile option here will be disabled.

Show Name: Shows the gate name in gate label on plot.

If the Show gate name in gate label option in Setting → Analysis is 
not checked, the Show Name option here will be disabled.

Apply Gate

Gating: Applies the current gate to the selected plot.

Create Plot: Creates a new plot and applies the current gate to the 
new plot. 

Export Events: Exports data for the events inside the current gate in 
either FCS or CVS format.
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3.3.7	 View

Icon Description

Show

Shows or hides the corresponding panel.

Reset Layout: Resets the layout of the panels to the default 
layout.

Zoom

Zoom to: Selects the scaling of the size of the plots inside 
the workspace in the drop-down menu (50%-150%).

This function is equivalent to adjusting the sliding bar at 
the bottom-right corner of the software. 

100%: Restores the size of the plots inside the workspace 
to the default setting.

This function is equivalent to adjusting the sliding bar at 
the bottom-right corner of the software to 100% value. 

Zoom out: Decreases the size of the plots inside the work-
space.

This function is equivalent to adjusting the sliding bar at 
the bottom-right corner of the software. One click corre-
sponds to 1% increment. 

Zoom in: Increases the size of the plots inside the work-
space. One click corresponds to 1% increment. 
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3.3.8	 Setting

Icon Description

User

Management: Use this function to manage all user groups and user accounts. It al-
lows for adding, deleting, and modifying user groups and user accounts. This func-
tion is only available on the accounts with the Administrator privilege.

Modify: Use this function to change the username and password of the currently 
logged in account.

Options

General 

►► Automatically login with User: 

If this box is checked, the current user will automatically be logged in when the 
software starts and the login window will not appear.

►► Display Language: 

Sets the display language. 

►► Shut down NovoCyte every day at:

If this box is checked, the NovoCyte will automatically shut down at the selected 
time. For example, if the time is set to 22:00, the software will prompt a message 
window as shown below at 22:00 o’clock every day. The system will automati-
cally shut down in 1 min if there is no operation from the user.

Only user with Administrator privilege can enable this function. If the instrument 
is not in the “Ready” status at the set time (i.e. the instrument is performing 
fluidic maintenance or data acquisition etc.), the software will wait until the in-
strument enters the “Ready” status before shutting down the instrument. If the 
instrument cannot enter the “Ready” status 30 mins after the set time, automatic 
shutdown function will be cancelled automatically. 
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 �The NovoExpress software should be opened at the selected time to per-
form this function. 

 �User can also double click the icon  in the status bar to access this 
function. User can view the current status of this function (i.e. “Instru-
ment will be shut down at the set time” or “Automatically shutting down 
instrument is disabled”) by placing the mouse on the icon . User can 
also enable or disable this function by left clicking the  icon in the 
status bar.

►► Maximum number of events for display during acquisition: 

Sets a limit to the number of events displayed on plots during sample acquisi-
tion. For example, if this is set to 20,000 events, only the last 20,000 events col-
lected will be displayed. The maximum setting is 50,000 events.

►► Ctrl+C to copy selected table content with header, Shift+C without header: 

When selected, statistical data copied from either the Statistical Table or the 
table below the plots will include a header when copied using Ctrl+C and will 
not include a header when selected using Shift+C.

►► Copy plot with border: 

When selected, plots copied will include a dotted line border.

►► Only one NovoExpress software application is allowed to run at one time:

When selected, only one instance of NovoExpress is allowed to run at a time. 
An error message will be displayed when user tries to run a second instance of 
NovoExpress.

►► Synchronize plot scale between plots of same sample:

When selected, the axis range and scale of same parameter on different plots of 
same sample will be automatically synchronized when user change axis range 
or scale. 

Click Synchronize Plot Scale button  on workspace toolbar to quick switch 
this setting. Refer to Section 3.4 for more information.

Experiment: 

►► User data root folder:

Sets the default folder directive for saving the experiment file. 

►► Default sample name starts with: 

Sets the prefix for the name of the sample. 

►► Default specimen name starts with: 

Sets the prefix for the name of the specimen.
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►► Automatically save experiment file in default experiment file in default experiment 
file folder with default name for new experiment:

This setting determines how to save a current experiment file when a new ex-
periment is started. 

If selected, the current file is automatically saved when a new experiment is 
started. The file is saved at the default experiment file folder with the name 
based on the current time in the format of YYMMDD_hhmm.ncf.

If not selected, a Save As window appears when a new experiment is started. 
The user then has the option to set a name and location to save the current 
experiment file. 

►► Automatically export samples to FCS/CSV files after data acquisition completed:

If selected, the software will automatically generate and export a FCS or CSV 
file after data acquisition is completed. Click Export Settings to open the Export 
Events window. Export Settings, including file format (i.e. FCS 3.0, FCS 3.1, or 
CSV), can be defined in this window.

►► Keep time gap fixed when appending sample events for Calcium Flux Assay:

If this option is selected, the software will keep the time gap fixed when append-
ing sample events for some specific assay (e.g. calcium flux assay). 

Analysis: 

Set the default plot properties when creating a new plot:

►► Histogram plot filling type: 

Sets the filling type for the histogram plots. Options include None, Filled, and 
Tinted. 

►► Smooth histogram plot: 

If selected, this option smooths data on histogram plots.
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►► Levels of contour plot: 

Sets the contour plot level (2%, 5%, and 10%).

►► Normalize histogram overlays: 

If selected, the histogram overlays are normalized to a 100% scale. 

►► Use pseudocolor for density plot: 

If selected, density plots are displayed in pseudocolor.

►► Smooth density plot:

If selected, density plots are smoothed.

►► Show legend for overlay plots: 

If selected, plots with overlays include a legend.

►► Showing fitting results for cell cycle analysis: 

If selected, the fitting results for the cell cycle analysis are displayed on the plot.

►► Use height or area parameter:

Sets the default parameter for plots to either Height or Area.

►► Show outlier for contour plot:

If selected, outlier events are shown as dots on contour plots.

►► Format:

Click Format… button to open the Plot Format window to define plot default 
format. Click the Restore Defaults button in the window to restore factory de-
fault plot format. Refer to Section 5.1.8.5 for more details about plot format.

Set plot Display Options:
►► Show color for new gates: 

If selected, new gates are displayed with default color. If not selected, new gates 
are in black.

►► Show gate name in gate label:

If selected, gate name is displayed in gate label on the plot.

►► Decimal places of mean and median values: 

Sets the number of digits displayed after the decimal point when computing 
mean and median values.

►► Show population percentile in gate label:

If selected, gate label is displayed with the percentage of the population within 
the gate.

►► Plot Title Options: 

If clicked, a drop-down menu will show as below:
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zz Show Plot Title: If selected, plot titles are displayed on workspace plots.

zz Sample Name: If selected, the sample name is displayed in the workspace 
plot title.

zz Specimen Name: If selected, the specimen name is displayed in the work-
space plot title.

zz Gating Name: If selected, the gating name is displayed in the workspace 
plot title.

zz Gating Hierarchy: If selected, the gating hierarchy is displayed in the work-
space plot title. 

Absolute Count:

Set Default Absolute Count setting for new samples.

►► Dilution Factor:

Sets the default dilution factor for new samples. The Dilution Factor is a conver-
sion coefficient used to calculate the absolute counting results for the original 
sample. For instance, if the original sample is diluted 10 times and is run on No-
voCyte flow cytometer, enter 1:10 in the Dilution Factor. NovoExpress software 
will show the absolute counting results for the original sample by multiplying 
the concentration of the sample run on NovoCyte by 10. 

►► Absolute Count Unit: 

Sets the default absolute count unit for new samples. The Absolute Count Unit 
parameter is used to set the unit for the absolute counting. User can select one 
of the units (i.e. No./µL, No./mL, or No./L) to present absolute count result for 
number of interested particles per microliter, per milliliter, or per liter.

Further information on absolute count calculations is described in Section 5.3.2.
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Statistical Table:

►► Group

Customize Name allows the user to re-name the Group column header in the 
statistical table. If Default Visibility is selected, the Group column will appear in 
the statistical table by default.

►► Specimen ID:

Customize Name allows the user to re-name the Specimen ID column header in 
the statistical table. If Default Visibility is selected, the Specimen ID column will 
appear in the statistical table by default.

►► Specimen:

Customize Name allows the user to re-name the Specimen column header in the 
statistical table. If Default Visibility is selected, the Specimen column will appear 
in the statistical table by default.

►► Sample:

Customize Name allows the user to re-name the Sample column header in the 
statistical table. If Default Visibility is selected, the Sample column will appear in 
the statistical table by default.

►► Sample ID:

Customize Name allows the user to re-name the Sample ID column header in 
the statistical table. If Default Visibility is selected, the Sample ID column will 
appear in the statistical table by default.

►► Operator:

Customize Name allows the user to re-name the Operator column header in the 
statistical table. If Default Visibility is selected, the Operator column will appear 
in the statistical table by default.

►► Run Time:

Customize Name allows the user to re-name the Run Time column header in the 
statistical table. If Default Visibility is selected, the Run Time column will appear 
in the statistical table by default.

►► Gate:

Customize Name allows the user to re-name the Gate column header in the 
statistical table. If Default Visibility is selected, the Gate column will appear in 
the statistical table by default.
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Report Options:

Set Default Report Options for New Report.

The settings in Plot Options panel are used for customizing plots inside report. They 
are effective for both auto and manual report mode.

►► Show Gate Name in Gate Label: If selected, gate name is displayed in gate label 
on the plot.

►► Show Population Percentile in Gate Label: If selected, gate label is displayed with 
the percentage of the population within the gate.

►► Plot Title Options: If clicked, a drop down menu will show as below:

zz Show Plot Title: 

If selected, plot titles are displayed on report plots.

zz Sample Name:

If selected, the sample name is displayed in the report plot title.

zz Specimen Name:

If selected, the specimen name is displayed in the report plot title.

zz Gating Name:

If selected, the gating name is displayed in the report plot title.

zz Gating Hierarchy:

If selected, the gating hierarchy is displayed in the report plot title.

The settings in Auto Report Mode Options panel are used for customizing auto re-
port. They are only effective for auto report mode.

►► Number of Plots per Row: Sets how many plots are shown in one row.

►► Plot Statistics: If selected, shows gate statistics of plot.

►► Sample Statistics: If selected, shows gate statistics of sample.

►► Compensation: If selected, shows compensation matrix.

►► Photodetector Gain: If selected, shows photodetector gain of parameters. 

►► Insert Page Break Before Each Sample: Only available for specimen report. If 
selected, a page break will be inserted before each sample.

►► Show Statistics Columns: Selects statistical items to display.
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Reagent Lots:

►► Reagent Type: Sets the type of the reagent.

►► Lot ID: Sets the ID of the active lot. 

►► Import: Import the lot file download from http://www.aceabio.com/novocyte/
qc-particles. The lot ID will be listed after importing the lot file.

►► Expiration Date: Sets the expired date of the active lot. 

►► Lot File: Display the lot file associated to the selected Lot ID. 

n

3.4	 Workspace Toolbar

Icon Description

Dot Plot: Creates a dot plot.

Density Plot: Creates a density plot.

Histogram: Creates a histogram.

Contour Plot: Creates a contour plot.

Gate Pointer: Use to select charts, gates, and statistical data.

Rectangular Gate: Draws a rectangular gate. To use, select the tool, click and 
drag inside a plot to draw a rectangle gate.

Elliptical Gate: Draws an elliptical gate. To use, select the tool, click and drag 
inside a plot to draw an elliptical gate.
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Polygon Gates: Draws a polygon gate. To use, select the tool, click inside a plot 
to begin creating the polygon. Click at additional locations inside the plot to add 
vertices to the polygon. To close the gate, either click on the first point of the 
polygon or double click on the last point.

Quadrant Gate: Draws a quadrant gate. To use, select the tool, and click inside 
the plot to divide it into quadrants.

Logic Gate: Creates logical gates. Click the icon to open the Create Logic Gate 
window. In the window, select two current gates and define the logic gate with 
AND or OR. Select one gate if you wish to define logic gate with NOT. The logic 
gate name and color can also be defined in this window.

Range Gate: Draws a range gate. 

Bi-Range Gate: Draws a bi-range gate. 

Zoom In: Zooms in on a specified area of a plot. To use, select the tool, click and 
drag inside a plot to create a rectangle. The plot will be zoomed in on the area 
inside the rectangle. To zoom in only along one axis, click and drag along either 
the X-axis or the Y-axis on the plot. 

Zoom Out: Zooms out on a specified area of a plot. To use, select the tool, and 
click on a plot to zoom out. Continue to click to zoom out further. To zoom out 
only along one axis, click on either the X-axis or Y-axis on the plot. 

Auto Range: The display range for the X-axis and Y-axis are automatically ad-
justed to fit the experimental data.

Full Range: The display range for a plot is set to the maximum.

Move: Use to adjust the display parameters of a plot by dragging the plot area. To 
use, select the tool, click and drag inside the plot to achieve the desired display 
range. To only adjust along one axis, click and drag along either the X-axis label 
or Y-axis label. The display range will only be adjusted along the selected axis.

Synchronize Plot Scale: When selected, the axis range and scale of same param-
eter on different plots of same sample will be automatically synchronized when 
user change axis range or scale.

Adjust Threshold: Use this tool to adjust threshold value on plot. Refer to Section 
4.1.4 Threshold Settings for detailed procedures.

uuu
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Icon Description

Adjust Post Gain: Use this tool to adjust Post Gain. Only accounts with the Post 
Gain Adjustment privilege can perform this operation. Refer to Section 5.7.1 Ad-
just Post Gain for detailed procedures.

Quick Compensation: Allows for quick fluorescence compensation through 
scrollbars. To use, select the tool. Scrollbars appear on plots to allow for adjust-
ment of fluorescence compensation.

Show Statistics: Shows or hides the statistical tables below plots.

Cell Cycle Plot: Creates a cell cycle analysis plot.

Cell Proliferation Plot: Creates a cell proliferation plot.

Bi-Variate Plots: Opens Bi-Variate Plots window.

Previous Plot: Switches the active plot to the previous plot. Use this tool when the 
plot window is maximized.

Next Plot: Switches the active plot to the next plot. Use this tool when the plot 
window is maximized.

n

3.5	 Cytometer Setting Panel

The Cytometer Setting panel sets the data collection parameters, stop conditions, flow rate, 
and threshold. Please refer to Section 4.1 for cytometer settings.
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3.6	 Cytometer Control Panel

The Cytometer Control panel contains the Active Sample Information and the Experiment 
Control panel. Please refer to Section 4.3 for cytometer controls.

►► Active Sample Information

The Active Sample Information panel provides information regarding sample collec-
tion during acquisition. Information includes the number of events collected, the 
number of events collected per second, the sample volume collected, and the sample 
collection time.

►► Experiment Control

The Experiment Control panel contains the Next Sample and Run buttons and Rinse 
after sampling check box. Clicking Next Sample switches the active sample to the next 
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sample. If a next sample has not already been created, clicking Next Sample automati-
cally creates a new sample. Clicking Run begins sample acquisition. The Run button 
changes to a Stop button after sample acquisition begins. Clicking the Stop button 
stops sample acquisition. Refer to Section 4.3 for a detailed description of Cytometer 
Control.

3.7	 Experiment Manager

The Experiment Manager contains the sample hierarchy structure and functions for copy-
ing, pasting templates, and importing and exporting sample data. Please refer to Section 6 
for experiment management.

3.8	 Cytometer Status Panel

The Cytometer Status panel displays the fluidic component status, photodetector gains, 
and laser powers. This panel is hidden by default. To show this panel, click on the Cytom-
eter Status box in the Show group of the View tab.

3.8.1	 Cytometer Status Panel for NovoCyte Instrument
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3.8.2	 Cytometer Status Panel for NovoCyte Quanteon Instrument

3.9	 Gate Manager Panel

The Gate Manager displays all gates of the active sample in list mode or tree mode. It pro-
vides user interface to modify gate name, color and color precedence and also shows gate 
hierarchy and gate statistics.
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3.10	 Status Bar

The status bar located at the bottom of the monitor displays the instrument’s status through 
color indicators. If the instrument is connected, the indicator can be green, red, or yellow, 
indicating a normal condition, an error, or a warning, respectively. If the instrument is not 
connected to the computer, the indicator is black.

3.10.1	 Green Indicator

The indicator light is green if the instrument is connected and without warnings or errors. 

The status bar will display Ready if the instrument has completed the initializing sequence 
and is ready for additional commands.

The status bar displays Instrument initializing after powering on the instrument. The ini-
tializing sequence flushes the fluidic lines in the instrument to prepare for sample acquisi-
tion.

The status bar displays Instrument shutting down after shutting down the instrument. The 
shutting down sequence flushes the fluidic lines and automatically powers off the instru-
ment when complete.

The status bar displays Sample acquiring during sample acquisition.

3.10.2	 Flashing Red Indicator

If an error occurs, the indicator flashes red. An error message is displayed with the cause 
and possible solutions. Please see Section 9 Troubleshooting for details.

Clicking on the indicator displays the message box.
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3.10.3	 Flashing Yellow Indicator

If a warning occurs, the indicator flashes yellow. A warning message displays the cause of 
the problem and possible solutions. Please see Section 9 Troubleshooting for details.

Clicking on the indicator displays the message box.

3.10.4	 Black Indicator

If the instrument is not connected to the computer, the indicator is black. This may be due 
to the instrument being off or a problem with the USB connection between the computer 
and instrument. Also, if multiple instances of the NovoExpress Software are running, only 
the first instance of the software will connect to the instrument. The remaining instances 
will not connect to the instrument and the indicator light will be black. 



56

44

Sample Acquisition

Cytometer Setting

4.	 Sample Acquisition

This chapter will cover how to set the sample acquisition conditions using the Cytometer 
Setting panel and Work List, how to begin sample acquisition, and how to monitor the 
sample acquisition status.

4.1	 Cytometer Setting

The Cytometer Setting panel contains the Parameters, Stop Condition, Flow Rate, and 
Threshold controls. The panel displays the settings of the sample being acquired.

4.1.1	 Parameters Settings

The parameters settings specify which parameters are collected during sample acquisition.
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The list includes all of the parameters that the instrument is capable of collecting. Area 
and height measurements can be collected for each parameter. To enable data collection 
for specific parameters, check the corresponding check boxes under the A (area) and H 
(height) columns. The selection of parameters can no longer be modified once sample 
acquisition has started. The FSC height and SSC height parameters are required for data 
collection and cannot be unselected. Fluorescent parameters can be renamed by double 
clicking the name under the alias column.

To adjust photodetector gain of one parameter, double click the cell on the specified pa-
rameter row and Gain column, the photodetector gain adjustment tool will show as below:

Drag the slider bar or directly enter the target value to change the photodetector gain. 
Click the Reset link button to set as default value. If currently logged in user does not have 
photodetector Gain Adjustment privilege, only Reset button will be available. To grant pho-
todetector Gain Adjustment privilege, refer to Section 2.6.2.3.

Every channel has its default photodetector gain setting. An underlined photodetector 
gain value as shown above for the B586 channel means the photodetector gain has been 
modified and is not the default value. A non-underlined photodetector gain indicates that  
it is the default setting. 

 �Click the Gain column header and select the Reset All context menu item to reset  the 
photodetector gains of all parameters to default value. When NovoExpress is restarted 
or new blank experiment file is created, the photodetector gains will be reset to default 
value too. Click the A or H column header to check or uncheck area or height check 
boxes for all parameters.

 �For NovoCyte instrument, different parameters may share the same photodetector, for 
example B675 and R675. If the photodetector  gain of one parameter is changed, the 
other one will be changed too. For NovoCyte Quanteon instrument, the photodetector 
gain for each parameter can be changed independently. 

 �The photodetector gain can be changed during sample acquisition. When changing 
photodetector gain  during acquisition, the plot will only display events after the gain 
adjustment. Please note the events are not deleted, and will be shown on the plots when 
the acquisition is completed. If previous events before photodetector gain adjustment 
are not wanted, click the Restart button to restart the acquisition. Refer to Section 4.3.2 
for the Restart function. You can also delete the previous events after the acquisition is 
completed by using the Delete Events function (refer to Section 3.3.4). 

 �For NovoCyte instrument, the photodetector gain of FSC and SSC cannot be changed. 
For NovoCyte Quanteon instrument, the photodetector gain of FSC and SSC can be 
changed.



58

44

Sample Acquisition

Cytometer Setting

4.1.2	 Stop Condition Settings

The Stop Condition Settings are used to stop sample acquisition after a specific set of con-
ditions has been met. The conditions may include: number of events collected, collection 
time, and / or collection volume. To enable a condition, check the box next to the condi-
tion.

Stop Conditions

►► �Events: Used to specify the number of events to acquire. Acquisition stops when the 
set number of events has been collected. When the drop-down menu is set to Un-
gated, the acquisition stops after the total number of events reaches the set value. If 
the drop-down menu is set to a gate, the acquisition stops after the number of events 
in the gate reaches the set value. The number of events collected can range between 
1~10,000,000. 

►► �Time: Used to stop sample acquisition after a set sample collection time. The collec-
tion time can be set between 0 and 60 minutes and 0 to 59 seconds.

►► �Volume: Used to stop sample acquisition after a set sample volume has been analyzed. 
The sample volume can be set between 10 and 5000 µL for NovoCyte instrument, and 
between 5 and 5000 µL for NovoCyte Quanteon instrument.

Multiple stop conditions can be concurrently set. When multiple stop conditions are set, 
the sample acquisition stops after the first stop condition is met. If no stop conditions are 
set, the sample acquisition stops after one of the system’s maximum limits for events, time, 
and volume as described is reached. 

 �After sample acquisition has started, stop conditions based on number of events can be 
modified but stop conditions based on time and volume cannot be changed.

 �The number of events displayed in a plot during sample acquisition can be set in Set-
tings. See Section 3.3.8. The maximum number of events displayed is 50,000 events.

 �File size can be excessively large if you acquire a large number of events, i.e., 1,000,000 
events. Therefore, it is always important to consider disabling unnecessary parameters 
(Section 4.1.1) before acquisition in order to reduce the file size. If events have already 
been acquired or collected, you can delete events (See Section 3.3.4) to discard parts of 
unnecessary events in the sample. 

4.1.3	 Flow Rate Settings

The three standard settings for flow rate include Slow (14 µL/min), Medium (35 µL/min), 
and Fast (66 µL/min). In addition, custom flow rates can be set using the slider bar. Sample 
flow rates can range between 5~120µL/min. The bottom of the panel includes information 
on the current sample’s flow rate and the corresponding core diameter.



59

44

Sample Acquisition

Cytometer Setting

4.1.4	 Threshold Settings

The threshold settings determine which events are recorded during sample acquisition. 

Only events that exceed the set threshold values are recorded.

To set the threshold:

For sample acquisition, the primary threshold can be set on either FSC or SSC height, or a 
fluorescence signal height if firmware supports. If desired, a secondary threshold can also 
be set on the height of a second parameter. The Storage Gate is used to filter out events out-
side the gate. All events exceeding the primary and secondary threshold will be recorded 
when Storage Gate is set to Ungated. Threshold values can range from 10 to 500,000,000.

To adjust threshold value on plot, first click the Adjust on Plot link button in the Threshold 
window or the Adjust Threshold tool  in the workspace toolbar. Then move the cursor 
to the target position on a plot with either primary, secondary or both thresholds set as 
displayed axis parameter. As shown below, the right edge of the dark gray area is the cur-
rent threshold value and the right edge of the light gray area is the target threshold value 
to be set. Left-clicking the cursor sets the threshold value to the new value which is shown 
on the lower left corner.

 �Threshold channels cannot be changed after data acquisition begins. Threshold values 
and Storage Gate can be changed during acquisition, but the events already acquired 
will not be processed. When changing threshold values during acquisition, the plot will 
only show events after threshold adjustment. Please note the events are not deleted, and 
will be shown when the acquisition is completed. If previous events are not wanted, click 
the Restart button to restart the acquisition. Refer to Section 4.3.2 for Restart function. 
You can also delete the previous events after the acquisition is completed by using the 
Delete Events function (refer to Section 3.3.4).
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4.2	 Work List

Before starting the experiment, the Work List can be used to set up the sample list. The 
work list allows users to create new specimens and samples, import specimens or samples 
from a template, duplicate specimens or samples, import specimen information from a 
CSV file, and copy and paste sample information. Please see Section 6 Experiment Man-
ager for additional details.

The Work List contains all specimens and samples listed in rows. The columns include the 
specimen name, specimen ID, template, sample name, acquisition parameters, stop con-
ditions, threshold settings, compensation settings, and analysis and report information.

4.2.1	 Opening the Work List

The Work List can be opened using two methods:

►► �From the Experiment Manager panel, click the Work List icon at the top of the window.

►► �From the Home tab in the menu bar, click on the Work List icon in the Experiment 
group.

4.2.2	 Work List Management

4.2.2.1	 Insert a New Specimen or Sample

To create a new specimen or sample, right click on the first column of a sample row or 
an empty row. Click Insert Specimen to create a new specimen, or click Insert Sample to 
create a new sample. The new sample will be placed in the selected row and under the cor-
responding specimen for that row.

4.2.2.2	 Copy and Insert the Copied Specimen or Sample

Pertaining to copying and inserting of specimens or samples: 
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1 To select the specimens or samples for copying, click and drag in the first column of the 
Work List. The selected rows become highlighted. 

2 To copy the selected specimens or samples, right click and select Copy or use the key-
board shortcut Ctrl+C. A dash line borders the copied rows.

3 To insert the copied samples, right click and select Insert Copied Samples. The samples 
are inserted at the selected location. Select Insert Copied Specimens or use the keyboard 
shortcut Ctrl+V to insert the specimens at the selected location. 

n

4.2.2.3	 Delete Specimen or Sample

Pertaining to deleting of specimens or samples:

1 To select the specimens or samples for deleting, click and drag in the first column of the 
Work List. The selected rows become highlighted.

2 To delete the selected specimens or samples, right click and select Delete or press the 
Delete key on the keyboard.

n

4.2.2.4	 Importing a Specimen or Sample from a Template

►► To import a specimen from a template:

In the Work List window, click on the Import Specimen from Template icon  , from 
the toolbar at the top of the window and select the template file to open. The template 
of the first specimen in the file gets imported to the work list. 

►► To import a sample from a template:

In the Work List window, click on the Import Sample from Template icon  , from the 
toolbar at the top of the window and select the template file to open. The template of 
the first sample in the file gets imported to the work list. 

4.2.2.5	 Creating a Duplicate Specimen or Sample

To duplicate a specimen or sample:

1 To select the specimens or samples for duplicating, click and drag in the first column of 
the Work List. The selected rows become highlighted.

uuu
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2 After selecting the samples, click the Duplicate as Sample icon  , to duplicate the 
samples and add them under the last specimen of the Work List.

Or, after selecting the specimens, click the Duplicate as Specimen icon  , to duplicate 
the specimens and create them as new specimens.

n

4.2.3	 Editing a Work List Cell

4.2.3.1	 Editing Specimen, Specimen ID and Sample Names

To modify a specimen, specimen ID or sample cell, double-click on the cell in the Work 
List. Enter the new value and press Enter key.

When a sample name is entered into an empty specimen, a new sample is created after 
Enter key is pressed.

When a specimen, specimen ID, or template is entered into in an empty row, a new speci-
men is created after the edit is done.

4.2.3.2	 Editing Template

To modify a template, double-click on the Template cell in the Work List. After a new 
template is selected, the template is applied into the current specimen. See Section 6.3 
Templates for additional details.

To edit template in an empty row, the template’s first specimen would be imported into 
Work List after the edit is done.

4.2.3.3	 Editing Acquisition Parameters

To modify the acquisition parameters, double-click on the channel cell to enter edit mode. 

In this mode, the fluorescence parameter alias and photodetector gain can be modified, 
and the height and area measurements can be enabled or disabled.
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When in non-edit mode, the character * after photodetector gain text indicate the voltage 
is not default value. For more information about photodetector gain, refer to Section 4.1.1.

4.2.3.4	 �Editing Stop Conditions, Sample Flow Rates, and Threshold Set-
tings

To set the sample stop conditions, double-click the stop condition cell to enter edit mode.

To set the sample flow rate, double-click the flow rate cell to enter edit mode.

To set the sample threshold, double-click the threshold cell to enter edit mode.

4.2.3.5	 Copying and Pasting Cells

Pertaining to copying and pasting cells between samples:

1 To select the cells for copying, click and drag in the Work List. The selected cells become 
highlighted.

2 To copy the selected cells, right-click and select Copy or use the keyboard shortcut 
Ctrl+C. A dashed line borders the copied cells.

3 To paste the selected cells, select the target cells and right click and select Paste or use 
the keyboard shortcut Ctrl+V. The target cells location must have matching columns. 

After pasting, a green background in the cells indicates that the pasting was successful.

n
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 �You can copy sample names in a column from a spreadsheet program like Microsoft 
Excel, then select sample cells of multiple rows in Work List and press Ctrl+V to paste 
them into Work List.

4.2.4	 Other Tools Buttons

The Apply Modification icon  can be used to save the changes made to the Work List. 
After applying the modification, the Experiment Manager panel updates to reflect the 
changes.

The Hide Disabled Parameters icon  is used to hide the acquisition parameters that are 
currently disabled.

The Hide Samples Containing Events icon  is used to hide the samples that contain 
events.

The Hide  Photodetector Gain icon  is used to hide the photodetector gain value in 
parameters columns.

4.3	 Cytometer Control

The Cytometer Control panel contains the Active Sample Information and the Experiment 
Control panel.

4.3.1	 Active Sample Information

In the Experiment Manager panel, the active sample is indicated by the red arrow. The ac-
tive sample can be switched by double-clicking on a new sample or by using the keyboard 
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shortcuts Ctrl + and Ctrl – to switch to the next and previous sample, respectively. 

In the Active Sample Information panel, the number of events collected, the average events 
collected per second, the collected volume, and the collection time are displayed. During 
sample acquisition, this information is updated in real-time.

The current sample information box at the bottom of the panel displays the sample name 
of the current sample. To rename the sample from this box, double-click the name to enter 
edit mode. The specimen name cannot be edited from this box.

4.3.2	 Experiment Control

The Experiment Control panel includes the Next Sample and the Run buttons.

►► Next Sample

The Next Sample button can be used to switch the active sample to the next sample in 
the Experiment Manager panel. If the active sample is the last sample in the Experi-
ment Manager, clicking the Next Sample button creates a new sample. The new sample 
has the same template as the previous sample with the same Cytometer Setting, Com-
pensation, Report and Analysis.

To create a new sample without the template settings, click on the arrow on the right 
side of the Next Sample button and select Without Template. The new sample contains 
the same cytometer settings as the previous samples, but analysis, report and compen-
sation settings are not transferred.

►► Run

The Run button is used to begin sample acquisition.

If the active sample does not contain event data, the Run button appears with a solid 
green triangle. Click the Run button to begin sample acquisition.

If the active sample already contains event data, the Run button appears with a striped 
green triangle.
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Clicking the Run button causes a dialog window to appear. Click Append to add ad-
ditional events to the existing events. Click Overwrite to delete the existing events 
and collect new events. If the “Keep fixed time gap when appending sample events for 
Calcium Flux Assay” function is enabled in the Experiment Setting window, the check 
box in front of the “Keep time gap fixed for Calcium Flux Assay” will be automatically 
selected.

►► Restart

The Restart button is used to restart sample acquisition while sample acquisition is in 
process and the previously acquired events are desired to be deleted. Restart button is 
particularly useful when user wants to adjust the photodetector gain or threshold first 
to a proper value and then collect the data.

When Restart is clicked, the previously acquired events will be deleted and the acqui-
sition status including sampling volume and sampling time will be reset to zero. Then 
the sample acquisition will restart until one of the defined stop conditions is met. The 
Restart button is only visible after acquisition has started.

 �The Run button is only available when the instrument status is Ready. The Run 
button is not available when the instrument is not connected, when the instrument 
is powered off, when there is an instrument error, or during the initialization, shut-
ting down, and reagent maintenance sequences.

During sample acquisition, the Run button switches into a Stop button. Click the Stop 
button to manually stop the acquisition.

Checking the Rinse after sampling checkbox enables SIP rinse function after each 
sample acquisition.
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4.4	 Instrument Configuration

To open the Instrument Configuration window, click the Configuration icon from the In-
strument tab of the Menu Bar. The user can view and modify the instrument configuration 
from this window. 

NovoExpress Software automatically detects the fluorescence parameters, excitation la-
sers, and detection channels of a connected NovoCyte instrument or NovoCyte Quanteon 
instrument. The software also detects if the NovoSampler or NovoSampler Pro is con-
nected while connecting NovoCyte instrument, and detects if the NovoSampler Q is con-
nected while connecting NovoCyte Quanteon instrument. Users are allowed to switch to 
other optical configurations provided by the software or to customize user-defined optical 
configurations in this window. 

If using the software while the instrument is powered off or not connected to the work-
station, use the Instrument Configuration window to select the correct instrument and 
configuration to display the correct fluorescence parameters.

4.4.1	 Instrument Configuration with the NovoCyte Connected

The Instrument Configuration window displays the instrument type, the name and sche-
matic of the current optical configuration, parameter window, and status of NovoSampler 
(Pro). When the NovoCyte instrument is connected to the workstation and powered on, 
the software will detect the excitation laser and photodetectors connected to the system, 
and display the schematics of the compatible optical configurations. The schematic of each 
configuration shows the position and type of each bandpass filter, dichroic mirror, photo-
detectors and the excitation laser. User can switch to other available configurations pro-
vided by the software or define their own customized configuration in this window. Please 
refer to Section 4.4.4 for more details on this function. The parameter window shows the 
Parameter, Excitation Laser, Detection Channel and the Default Alias for each fluorescence 
channel. The Default Alias can be modified by double-clicking. 

The status of the NovoSampler (Pro) is displayed in the lower left corner of this window. 
When the workstation is connected to the NovoCyte instrument and the instrument is 
powered on, it can automatically detect the installed NovoSampler (Pro) and this box will 
be automatically checked.
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4.4.2	 Instrument Configuration with the NovoCyte Quanteon Connected

The Instrument Configuration window displays the instrument type, the name and sche-
matic of the current optical configuration, parameter window, and status of NovoSam-
pler Q. When the NovoCyte Quanteon instrument is connected to the workstation and 
powered on, the software will detect the excitation laser and photodetectors connected to 
the system, and display the schematics of the compatible optical configurations. The sche-
matic of each configuration shows the position and type of each bandpass filter, dichroic 
mirror, and the excitation laser. User can define their own customized configuration in 
this window. Please refer to Section 4.4.5 for more details on this function. The parameter 
window shows the Parameter, Excitation Laser, Detection Channel and the Default Alias 
for each fluorescence channel. The Default Alias can be modified by double-clicking. 

The status of the NovoSampler Q is displayed in the lower left corner of this window. 
When the workstation is connected to the NovoCyte Quanteon instrument and the in-
strument is powered on, it can automatically detect the installed NovoSampler Q and this 
box will be automatically checked.

4.4.3	 Instrument Configuration with the NovoCyte (Quanteon) Disconnected 

When there is no instrument connected to the workstation or the instrument is powered 
off, user can select NovoCyte or NovoCyte Quanteon instrument, and all the available 
optical configurations of the selected instrument will be displayed in the Optical Configu-
ration field. User can select any one of the configurations and view the associated optical 
schematic. After selecting the optical configuration, click OK, and the software will restart. 
After restarting, the Cytometer Setting panel, the Cytometer Control panel, the Experiment 
Manager panel, and the Work List are all updated according to the new configuration 
settings. When the NovoCyte or NovoCyte Quanteon is connected to the workstation 
and powered on, the software will automatically detect the current hardware setting, and 
restore the correct optical configuration.
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4.4.4	 Modifying NovoCyte Instrument Optical Configuration 

Users can modify the existing optical configuration to the alternative configurations pro-
vided by the software, or customize their own optical configuration. Users need to replace 
the appropriate optical filters and dichroic mirrors of the system and enter the changes 
into the Instrument Configuration window. To make the new optical configuration ef-
fective, a QC Test with automatic adjustment of photodetector gain will be performed 
to optimize instrument performance. This function provides user with more flexibility 
and convenience to match NovoCyte optical configuration with expanded fluorochrome 
panel. 

To modify the instrument optical configuration:

1 Ensure the instrument is properly connected and powered on. Click Instrument → Con-
figuration to open the Instrument Configuration window.

2 Click the Optical Configuration field. Click and select the desired optical configuration, 
and click OK to continue.

 �By default, only the standard configurations (i.e. recommended by ACEA) will 
be displayed in this window. If configurations other than the ones listed in this 
window are needed, follow the instructions in Step 3.

uuu
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3 If optical configurations other than the ones listed by the software are needed (i.e. users 
need create their own customized configuration), the Customize Optical Configuration in 
the Access Privilege window for the current user account needs to be enabled first as 
described in Section 2.6.2.3 in NovoExpress® Software Guide. To make the customized 
optical configuration, click Create Copy in the Instrument Configuration window to gener-
ate an editable copy of the configuration. Click Rename to rename the configuration if 
needed. Click the bandpass filter or dichroic mirror to be replaced and select the appro-
priate filter or mirror from the pop-up list. Once all the filters and mirrors desired to be 
replaced have been edited, click OK to continue. A customized optical configuration can 
also be deleted by clicking Delete.

 �Only the user-defined optical configurations can be deleted.

 �The software will automatically check the validity of user-defined configuration. 
The following error message will pop up if the user-defined optical configuration 
is not valid.

uuu
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4 Ensure to read the instructions from the prompted window as below. To change the opti-
cal filters, press the power button on the front panel of NovoCyte to turn off the instru-
ment first. Insert the NovoCyte key into the keyhole on the left side of the instrument to 
open the top cover of the instrument. 

Remove the two mounting screws and open the cover of the filter module as shown 
below.

   

5 Gently hold the selected optical filter or dichroic mirror and pull it upward to remove it 
from the slot. Insert the new optical filter or dichroic mirror into the slot as shown in fol-
lowing figure. Record the position, wavelength and arrow direction for each optical filter 
and dichroic mirrors. Install the filter module cover by screwing in the two mounting 
screws. Close the top cover of the instrument. Press the power button on the front panel 
of NovoCyte to turn on the instrument. 

 �Ensure all the new optical filters and mirrors are fully inserted in the correct filter 
slot and in the correct orientation as indicated by the arrows (i.e. the arrow of 
each optical filter and dichroic mirror should point away from the corresponding 
photodetector).

   

6 Wait until the instrument initialization process is completed. Click OK in the prompted 
window shown in step 4 to continue.

7 Ensure that the recorded optical configuration (i.e. the position, wavelength, and the 
orientation of each bandpass filter and dichroic mirror) matches the schematic of the 
selected optical configuration. Click Apply to continue.

uuu
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8 Click Restart in the next window to restart the software to apply the new optical configu-
ration setting.

9 After NovoExpress is restarted, the following window will appear. Click QC Test to con-
tinue.

10 Properly prepare 1 mL ACEA QC particles sample as described in the NovoCyte® Flow 
Cytometer Operator’s Guide. Place the sample tube in the tube holder or NovoSampler 
(Pro). Fill in the test information in the pop-up window. Click Next to continue. 

uuu
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11 Ensure all the test information is correct and the sample tube is properly installed on the 
tube holder, click Run to start. The software will automatically adjust the photodetector 
gain by running the QC particles. When the adjustment is completed, the software will 
automatically perform the QC Test. Click Report when the QC test is completed.

QC Test: Step 2 and Sep 3

uuu
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12 Ensure the result shows Pass for all the channels. Click Finish to close the window and 
complete the optical configuration modification.

 
QC Test: Step 4

 �If the result of certain detection channels shows Acceptable or Failed as below, 
make sure the optical filters configured in the hardware matches with the selected 
optical configuration in the software and the QC particles are properly prepared. 
Run the QC particles once again after the correct actions have been taken. Ensure 
there is at least 300 μL sample remaining in the sample tube. Click Repeat Test 
to repeat the QC test. The photodetector gain will be automatically re-adjusted. 

 �Please contact ACEA technical support if the QC test failed for three times in a 
row. 

QC Report Indicating Failed QC Test

n



75

44

Sample Acquisition

Instrument Configuration

4.4.5	 Modifying NovoCyte Quanteon Instrument Optical Configuration 

Users can customize the optical configuration on NovoCyte Quanteon. NovoCyte Quan-
teon has a sensor on each optical filter, and the instrument can directly read the infor-
mation of each optical filter and automatically updates the optical configuration. A QC 
Test with automatic adjustment of photodetector gain will be conducted to optimize the 
instrument performance. This function on NovoCyte Quanteon provides a flexible and 
convenient way to reconfigure the optical detection channel to match a specific fluoro-
chrome panel. 

To modify the instrument optical configuration:

1 Ensure the instrument is properly connected and powered on. Click Instrument → Con-
figuration to open the Instrument Configuration window.

2 The Customize Optical Configuration in the Access Privilege window for the current user 
account must be enabled first as described in Section 2.6.2.3 in NovoExpress® Software 
Guide. To make the customized optical configuration, click Create Copy in the Instrument 
Configuration window to generate an editable copy of the configuration. Click Rename 
to rename the configuration if needed. Click Change Optical Configuration to continue. A 
customized optical configuration can also be deleted by clicking Delete.

 �Only the user-defined optical configurations can be deleted.

3 Open the top cover of the instrument. Insert one end of the Allen wrench through the 
hole. Gently hold the proper optical filter or dichroic mirror and pull it upward to remove 
it from the slot. Insert the new optical filter or dichroic mirror into the slot as shown in 
following figure. Close the top cover of the instrument.

  

uuu
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4 Click Complete to read new optical configuration.

5 Click OK to confirm the new configuration.

 �If the new optical configuration is invalid, there will be message in Instrument 
Configuration window.

uuu
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6 Click Restart in the next window to restart the software to apply the new optical configu-
ration setting.

7 After NovoExpress is restarted, the following window will appear. Click QC Test to con-
tinue.

8 Properly prepare 1 mL ACEA QC particles sample as described in the NovoCyte Quan-
teonTM Flow Cytometer Operator’s Guide. Place the sample tube in the tube holder or 
NovoSampler Q. Fill in the test information in the pop-up window. Click Next to continue. 

uuu
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9 Ensure all the test information is correct and the sample tube is properly installed on the 
tube holder, click Run to start. The software will automatically adjust the photodetector 
voltage by running the QC particles. When the adjustment is completed, the software will 
automatically conduct the QC Test. Click Report when the QC test is completed.

10 Ensure the result shows Pass for all the channels. Click Finish to close the window and 
complete the optical configuration modification.

 

uuu
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 �If the result of certain detection channels shows Acceptable or Failed as below, 
make sure the QC particles are properly prepared. Run the QC particles once 
again after the correct action has been taken. Ensure there is at least 400 μL 
sample remaining in the sample tube. Click Repeat Test to repeat the QC test. The 
photodetector voltage will be automatically re-adjusted.  

 �Please contact ACEA technical support if the QC test failed for three times in a 
row. 

n
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5.	 Data Analysis

Data analysis tools in the NovoExpress Software include plots, gates, and statistical analy-
sis functions. The plots enable users to visualize events based on measured parameters, 
and gates allow for separation of subpopulations for further statistical analysis. 

5.1	 Plots

The NovoExpress Software includes dot plots, density plots, contour plots, histograms, 
and the option for cells cycle diagrams for cell cycle analysis.

Plot Type Icon Display  
Parameters

Description Example

Dot Plot Two- 
parameter

The intensities of two 
parameters are repre-
sented by the coordi-
nates of the plot. Each 
point on the plot repre-
sents at least one event 
with the corresponding 
intensity values.

Density Two- 
parameter

The intensities of two 
parameters are repre-
sented by the coordi-
nates of the plot. The 
color of each point rep-
resents the density, or 
number of events, at the 
corresponding intensity 
values.

Contour Two- 
parameter

The intensities of two 
parameters are repre-
sented by the coordi-
nates of the plot. Con-
tour lines are drawn to 
represent the density 
distribution of the popu-
lation.

Histogram Single-
parameter

The intensity of a param-
eter is represented along 
the horizontal axis, and 
the number of events at 
each intensity value is 
represented along the 
vertical axis.

uuu
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Plot Type Icon Display  
Parameters

Description Example

Cell Cycle 
Analysis

Single-
parameter

DNA content is rep-
resented along the 
horizontal axis, and 
the number of events 
at each value is repre-
sented along the verti-
cal axis. The cell cycle 
fitting algorithm is used 
to separate the popula-
tion into G1, S, and G2 
phases of the cell cycle. 
See Section 5.5 for more 
information.

Cell Prolifer-
ation Analy-
sis

Single-
parameter

Cell Proliferation Analy-
sis can be used to ana-
lyze the samples con-
taining cell proliferation 
information and show 
the fitting results. See 
Section 5.6 for more in-
formation.

n

5.1.1	 Creating a Plot

In the NovoExpress Software, plots can be created through the toolbar, the Experiment 
Manager, and the Gate Manager. In addition, plots can be duplicated in the Workspace, 
copied in the Experiment Manager, and imported from templates.

5.1.1.1	 Creating a Plot with the Toolbar

Use the plot buttons in the Workspace toolbars to create new plots. The button will create 
a new plot for the active sample.

5.1.1.2	 Creating a Plot with the Experiment Manager

In the Experiment Manager panel, right-click on either the sample or the Analysis node 
under the sample. Select Create Plot and select the plot type. 
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5.1.1.3	 Creating a Plot from a Gate

In the Workspace, new plots can be created using gates from previously created plots. New 
plots created through gates will only display events within the gate. There are multiple 
methods for creating a new plot through a gate:

►► �Double-Clicking a Gate

Double-clicking on a selected gate creates a new plot. The new plot has the same pa-
rameters and plot type as the plot containing the gate. The plot type and parameters 
can then be modified.

►► �Selecting a Gate within the Workspace

Click on a gate within a plot to select the gate. The gate label is italicized to indicate 
that it is selected. Right-click on the gate and select Create Plot and select the plot type. 
The new plot will have the same parameters as the plot containing the gate. The plot 
parameters can then be modified.

►► �Selecting a Gate using the Menu Bar

In the Gate tab of the Menu Bar, a gate can be selected from the drop-down menu 
in the Current Selection group. Click the Create Plot icon in the Apply Gate group to 
select a plot type.

►► �Selecting a Gate using the Experiment Manager or Gate Manager

In the Experiment Manager or Gate Manager panel, right click on a gate heading. Se-
lect Create Plot and select a plot type.

5.1.1.4	 Creating a Duplicate Plot

Click a plot in the workspace to select it. To duplicate the selected plot, click the Duplicate 
icon in the Home tab of the Menu Bar or use the keyboard shortcut Ctrl+D. The plot type 
and parameters of the new plot will match the previous plot, but the gates will not be 
replicated.

5.1.1.5	 Copying and Pasting a Plot with the Experiment Manager

When using this method, the parameters of a plot from one sample can be applied to plot 
the data of a different sample. In the Experiment Manager panel, locate the initial plot by 
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expanding the Analysis node under the corresponding sample. Right-click the plot to be 
copied and click Copy. Select the Analysis node under the sample where the plot will be 
pasted. Right-click on this Analysis node and click Paste. The new plot uses parameters 
from the copied plot to plot data from the new sample. This can also be accomplished by 
doing a click and drag on the plot to be copied and dropping it into the desired sample.

 

 �If the Analysis node is copied, all of the plots for the sample are included. Pasting this 
to the Analysis node of a new sample replicates all of the plots. Any plots currently in 
the sample are replaced.

 �Pasting to a specimen node pastes to all of the samples under the specimen.

5.1.1.6	 Importing from a Template

In the Experiment Manager panel, select the Analysis node under the sample where the 
plots are to be imported. Right-click on the Analysis node and click Import…. Select the 
template file to open. Upon selecting, the plots from the first sample in the template file 
are imported into the selected sample. 

5.1.2	 Opening and Closing a Plot Window

There are multiple methods for opening and closing a plot window.

To open a plot window:

►► �In the Experiment Manager panel, double-click on a plot node or right-click and select 
Open to open the plot.

►► �In the Experiment Manager panel, double-click on a gate node or right-click and se-
lect Open to open the plot containing the gate.

►► �In the Experiment Manager panel, right-click and select Open Plots on a sample to 
open all of the plots associated with the sample.

►► �In the Experiment Manager panel, right-click and select Open Plots on a specimen to 
open all of the plots associated with the specimen.

►► �In the Experiment Manager panel, right-click and select Open Plots on a group to open 
all of the plots associated with the group.

To close a plot window:

►► �Click the Minimize button in the top right corner of a plot window to close the plot.
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►► �In the Experiment Manager panel, right-click and select Close Plots on a plot to close 
the plot.

►► �In the Experiment Manager panel, right-click and select Close Plots on a sample to 
close all of the plots associated with the sample.

►► �In the Experiment Manager panel, right-click and select Close Plots on a specimen to 
close all of the plots associated with the specimen.

►► �In the Experiment Manager panel, right-click and select Close Plots on a group to close 
all of the plots associated with the group.

 �Click the Close button  , in the top right corner of a plot window to delete the plot.

5.1.3	 Editing Plots

5.1.3.1	 Plot Gating

To analyze subpopulations, plots can be set to only display events from within a specific 
gate. For this method, a gate from a previous plot will be applied to a newer plot. The new 
plot can then be used to analyze the subpopulation or to further gate for more specific 
populations.

If plots are gated, the gate will be displayed on the header of the plot as shown below. The 
header will display the sample name and the gate. In the example below, the sample name 
is Blood and the gate is LY.

There are multiple methods for gating a plot. These methods include:

►► �In the plot header, right-click to display a drop-down menu. In the drop-down menu, 
select the gate. If Ungated is selected, the plot is not gated and all events are displayed 
in the plot. 
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►► �Right-click in the plot, select Gating and select the gate. If Ungated is selected, the plot 
is not gated and all events are displayed in the plot.

►► �Click on the plot to be gated to select the plot. In the Plot tab of the Menu Bar, select 
the gate in the drop-down menu from the properties group. If Ungated is selected, the 
plot is not gated and all events are displayed in the plot.

►► �Select a gate in the Gate tab of the Menu Bar, and click Gating, select the plot to be 
gated. If All following plots is selected, all the plots listed will be gated.

►► �Select a gate in the workspace, and drag it into the title of the plot to be gated.

5.1.3.2	 Parameter Plot Settings

As shown in the figure below, the plot parameters are labeled next to the axes.

To change the plot parameters:

Right-click on the plot label and select the desired parameter. In the drop-down menu, the 
scatter and fluorescent parameters are separated in height and area measurements. Addi-
tional parameters include Width, the width of the individual event signal, Time, the time 
of the individual event signal, and Count, the number of events at a specific parameter.
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5.1.3.3	 Setting Plot Types

There are two methods for setting or changing the plot type of a plot.

►► �Within a plot, right-click and select Plot Type and select the desired type of plot.

►► �Click on the plot to be modified to select the plot. In the Plot tab of the Menu Bar, 
click on the Plot Type icon and select the desired type of plot from the drop-down 
menu.

 �When the plot is switched from a two-parameter type (dot, density, or contour plot) 
to a single-parameter plot (histogram), all two dimensional gates (rectangular, ellipse, 
polygon, and quadrant gates) are deleted.

5.1.3.4	 Renaming Plots

There are three methods for renaming a plot.

►► �Click on the plot to be renamed to select the plot. In the Plot tab of the Menu Bar, edit 
the plot name in the Plot Name box.

►► �In the Experiment Manager panel, right-click on the plot node and select Rename to 
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enter a new name.

►► �In the Experiment Manager panel, click the plot node, and type a new name directly.

5.1.3.5	 Deleting Plots

There are multiple methods for deleting a plot.

►► �Click the Close button in the top right corner of the plot window to delete the plot.

►► �In the Experiment Manager panel, right-click on the plot node and select Delete to 
delete the plot.

►► �In the Experiment Manager panel, right-click on the sample node or Analysis node 
and select Delete Plots to delete all of the plots associated with the sample.

5.1.4	 Setting the Coordinates of the Axis

As shown in the figure below, the coordinates of an axis are labeled next to the axis. The 
axis multiplier is labeled within parentheses in the axis label.

5.1.4.1	 Setting the Coordinate Range

By default, the coordinates for each parameter will be shown over a full range. During 
analysis, it may be necessary to reduce the display range to focus on a specific population.

There are multiple methods for changing the coordinate range including zooming, the 
auto range tool, the move tool, and manually entering the coordinate range. Select these 
tools either from workspace toolbar  or plot right-click popup mini toolbar.

►► �Pointer  : When the pointer is selected, maximum or minimum axis value can be 
directly adjusted on the plot.

Move the cursor to the maximum or minimum position of the X or Y coordinate. The 
cursor will change to  for X coordinate or  for Y coordinate. Click and move the 
cursor to change the maximum or minimum value of the corresponding value. Dou-
ble clicking the arrow will set the axis to Auto Range on the corresponding coordinate.

►► �Zoom In  : This tool enlarges the display by narrowing the coordinate range. 

There are multiple methods to access this tool. This tool can be activated by clicking 
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on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl++, or right-
clicking on a plot and selecting Zoom In.

To use the tool, click and drag in a plot over the area to be enlarged. A rectangle is 
drawn, and the range of the rectangle becomes the range of the zoomed in plot.

 

 �To zoom in only along one parameter, click and drag along the parameter’s coor-
dinate label. This method zooms in on the selected parameter, while the second 
parameter’s coordinate range remains unchanged.

►► �Zoom Out  : This tool compresses the display by widening the coordinate range.

There are multiple methods to access this tool. This tool can be activated by clicking 
on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl+-, or right-
clicking on a plot and selecting Zoom Out.

To use the tool, click within a plot. The range increases by 20% of the current range. 

Click repeatedly until the desired range is reached.

 �To zoom out only along one parameter, click on the parameter’s coordinate label. 
This method zooms out on this parameter, while the second parameter’s coordinate 
range remains unchanged.

►► �Auto Range/Full Range

Auto Range  : This tool automatically sets the coordinate range based on the maxi-
mum and minimum values of the data set.

Full Range  : This tool automatically sets the coordinate range to the maximum and 
minimum values possible for the parameter.

There are multiple methods to access these tools. These tools can be activated by click-
ing on the icons in the Workspace toolbar, using the keyboard shortcuts Ctrl+A for 
Auto Range and Ctrl+F for Full Range, or right-clicking on a plot and selecting Auto 
Range or Full Range.

►► �Move  : This tool allows the user to pan the graph with the coordinate range auto-
matically adjusting.

There are multiple methods to access this tool. This tool can be activated by clicking 
on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl+M, or right-
clicking on a plot and selecting Move.

To use this tool, click and drag in a plot to move the display region. The coordinate 
range then automatically adjusts.
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 �To pan the plot only along one parameter, click and drag along the parameter’s 
coordinate label. This method causes the plot to pan along the selected parameter, 
while the second parameter’s coordinate range will remain the same.

►► �Manually Setting the Coordinate Range through the Axis Setting Window

To access the Axis Setting window, right-click on the coordinate label of a plot and 
select Setting. 

The Axis Setting window includes boxes to set the maximum and minimum value for 
both parameters.

►► �Manually Setting the Coordinate Range in the Plot tab of menu bar.

5.1.4.2	 Setting the Coordinate Scale

The available coordinate scaling types available in the NovoExpress Software include lin-
ear, logarithmic, and biexponential. In general, linear scaling is used for scatter channels, 
logarithmic scaling is used for the fluorescent channels, and biexponential scaling is used 
for fluorescent channels where fluorescence compensation has resulted in negative values.

To set the coordinate scaling, right-click on the coordinate label and select the axis scaling.
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The axis scaling can also be set through the Plot tab of the Menu Bar using the Scale drop-
down menu for each axis.

5.1.4.3	 Displaying a Biexponential Plot

Biexponential display uses biexponential scale to transform data, especially for those 
where cells become piled up in the first decade at the axis. This is displayed as fluorescence 
values <0 even for uncompensated data. Biexponential transformation incorporates linear 
scaling for low values together with log scaling for high values. Biexponential scaling gets 
rid of cells being piled up at axes origins, allowing visualization of cells with negative or 
dim fluorescence. The plots below are the result of different scales, left side is with logarith-
mic scale and right is with biexponential scale. 

 

Below Zero Value of biexponential scale

Biexponential transformation can be seen as combination of near linear and near loga-
rithmic scales. It goes smoothly from near linear within the reflection point to the near 
logarithmic within range further away from the reflection point. The width of near linear 
transformation interval can be changed, which is calculated by the Below Zero Value of 
biexponential scale in NovoExpress software.

Manually enter the Below Zero Value in Axis Setting dialog or click Reset button to let No-
voExpress software calculate the value automatically. When resetting, software calculates 
the Below Zero Value according to the events data in current gating of plot. The minimum 
value of the axis will be automatically set by the linear minimum of biexponential scale, 
which is determined by the current Below Zero Value.
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Another way to reset the Below Zero Value is to right-click on the coordinate label and 
select the Reset Below Zero Value menu item.

To adjust the Below Zero Value directly on plot, move the cursor to a coordinate axis with 
biexponential scale, a triangular symbol will appear on the position of below zero value. 
Click and drag the triangular symbol to adjust the Below Zero Value, and the plot will 
reflect the change dynamically while dragging the triangular symbol.

5.1.5	 Adjusting the Size of Plots

►► �Maximizing and restoring a plot window

Plot windows can be maximized by clicking on the maximize button , in the top 
right corner of the window or by double-clicking in the plot. To restore the plot after 
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maximizing it, either click on the restore button (as shown below) or double-click in 
the plot.

►► �Resizing all plot windows

To resize all of the plot windows, use the zoom slider on the right side of the Status Bar 
(as shown below) or the Zoom tool in the View tab of the Menu Bar.

 �Adjusting the size of the plot window does not affect the coordinate range of the 
plots. To adjust the coordinate ranges, see Section 5.1.4.1.

5.1.6	 Copy or Save Plots

Plots from the NovoExpress Software can be copied and saved.

►► �To copy a plot to the clipboard

Right-click in a plot. Select Copy and select the format to copy the plot. Plots can also 
be copied using the Copy button in the Plot tab of the Menu Bar. Using the keyboard 
shortcut Ctrl+C copies the selected plot in bitmap format.

►► �To save a plot

Select a plot by clicking on it, and click the Save as Image button  from the Plot tab 
of the menu bar. The image format can be selected in the Save Image window. 

5.1.7	 Overlays

Multiple overlays can be included in dot plots or histogram plots. When a plot is created, 
it only contains the data from one sample. Overlays can display the data from multiple 
samples and gates in one plot with different colors. Below show the example of the dot and 
histogram plots with overlays from different samples.
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►► �Add overlays by using the drag and drop method: 

Hold down the Ctrl key on the keyboard, use the mouse to drag a sample or multiple 
samples to a plot from the Experiment Manager, and the new overlays are added to 
the plot. The gate of new overlay is from the sample of the overlay, it always take the 
same name as the gate of plot. It will be the All gate, if no gate with the name is found 
in the sample of the overlay.

►► �Edit overlays: 

Right-click a plot to access the shortcut menu, select Edit Overlays to generate the 
Edit Overlays dialog window as shown below. In the dialog, all overlays of the plot are 
listed. One can select an overlay, set the overlay’s sample, gate or color, and make a 
choice to show or hide the selected overlay on the plot. Adding new overlays or delet-
ing overlays can also be done here. Click Add button to open the Add Overlay window, 
press Ctrl or Shift key while clicking the selected sample (s), click Add or Add & Close 
in this window to add selected sample (s) to the Edit Overlays window. Click Apply 
and OK to complete adding the new overlays to the current plot.
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►► Display legend: 

When the overlays are added, the legend will automatically appear on the overlay. 
User can move the legend to any location inside the plot by left-clicking and dragging 
the legend. To remove the legend from the plot, right-click the legend and uncheck 
the Show legend in the menu.

 

5.1.8	 Plot Formatting

Each plot type has different formatting and settings options. This section describes the 
formatting options associated with each plot type. To format a plot, right click on a plot 
window and select corresponding format menu item.

5.1.8.1	 Dot Plot Formatting

With dot plots, there is an option to only display the most recently collected events. This 
option allows the user to set a number or percentage of the most recently collected events 
to display. To open the Events Displayed window, right click on the dot plot and select 
Events Displayed….

In the window, selecting Preview modifies the dot plot display as the user is changing the 
settings. Selecting Apply to all open plots applies the setting to all open dot plots.
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5.1.8.2	 Density Plot Formatting

►► �Smooth density plot: In this view, the density plot data are smoothed. To use this view, 
right-click on the density plot and select Smooth or select Smooth from the Plot tab 
of the Menu Bar. A comparison of a standard pseudocolor density plot (left) and a 
smooth pseudocolor density plot (right) is shown below. 

 

►► �Pseudocolor density plot: By default, density plots are displayed in pseudocolor. In 
this view, areas of the plot with a higher density of events are shown in warmer colors 
(colors toward the right of the color bar below) and areas of the plot with a lower den-
sity of events are shown in cooler colors (colors toward the left of the color bar below).

To switch from a pseudocolor to a gray-scale density plot, right-click on a density plot 
and unselect Pseudocolor or unselect Pseudocolor from the Plot tab of the Menu Bar. 
A comparison of a grayscale density plot (left) and a pseudocolor density plot (right) 
is shown below.

5.1.8.3	 Histogram Plot Formatting

►► �Smooth histogram: To smooth the edges of a histogram, right-click on a histogram 
plot and select Smooth or select Smooth from the Plot tab of the Menu Bar. A compari-
son of a standard histogram plot (left) and a smooth histogram plot (right) is shown 
below.
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►► �Histogram fill type: Histogram plots can be viewed with different fill types. To select 
a fill type, right-click a histogram plot and select Filling and select the fill type, or se-
lect the fill type from the Filling drop-down menu in the Plot tab of the Menu Bar. A 
comparison of the filling types is shown below. The options include None (left), Filled 
(middle), and Tinted (right).

►► �Histogram layering: When overlaying histogram plots, different overlay styles can be 
selected. To select an overlay style, right-click in a histogram plot with layers and se-
lect Style to select the overlay style. The overlay style options, as shown below, include 
Overlaid (left), Offset (middle), and Half Offset (right).

5.1.8.4	 Contour Plot Formatting

Contour levels: Different contour levels are available for contour plots. Higher contour 
levels indicate a larger density interval in between contour lines on the plot. The available 
contour levels include 10%, 5%, and 2%. A contour plot is shown below with a 10% con-
tour level (left) and a 5% contour level (right).
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Show Outlier: If selected, outlier events are shown as dots on contour plots. A contour plot 
is shown below with Show Outlier selected.

5.1.8.5	 Plot Format

The Plot Format defines plot appearance. The font, size, style, color, line weight, and vis-
ibility can be customized. To open the Plot Format window, right click inside plot area and 
select the Format... menu item in the popup menu.

 

►► Using Default Format:

Check this box to set plot using system default format.

►► Objects:

Select objects that the format is applied to. The objects are listed in tree mode. Select 
parent node will apply to all its child nodes.
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►► Font:

Set font name and font size for the selected objects.

►► Style:

Set font style for the selected objects. Check button B for bold, button I for italic. 

►► Default Color:

Set color for the selected objects. Check Default Color box if the software default color 
is to be used. For gate label on plot or plot title, the default color is the color of the gate. 
For the other objects, the default color is black.

►► Visible:

Check this box to set the object visible.

►► Line Weight:

Select line weight of selected objects.

►► Set as Default:

Check this box to set the format settings as the default when Apply or OK button is 
clicked.

►► Apply to:

Select which plot(s) to apply the format settings.

►► Apply:

Click to apply changes and keep this window open.

►► OK:

Click to apply changes and close this window.

►► Cancel:

Click to close this window without applying any changes.

5.1.8.6	 Default Plot Settings

To change the default settings for plots, go to File → Options and select the Analysis tab. 
See Section 3.3.8 Setting for details.
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5.1.9	 Bi-Variate Plots

Bi-Variate Plots window can be used to create a matrix of plots with selected parameters 
plotted against each other. To create bi-variate plots, click  icon in the workspace tool-
bar to open Bi-Variate Plots window.

►► �Parameters: 

List all the parameters of the selected sample in the Sample drop-down box. Click-
ing the OK button after selecting the parameters in the drop-down list will create the 
N×N plots of the selected parameters. Check Select All Parameters to check all the 
parameters.
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►► Height: 

Select to set the parameter of the plots to Height.

►► Area: 

Select to set the parameter of the plots to Area.

►► Gate: 

List all the gates of the selected sample in the Sample drop-down box. The first item is 
Ungated. When select a gate, only the data in the gate will be displayed on the plots.

►► Plot Type: 

Select plot type for the created bi-variate plots, including Dot Plot, Density Plot, and 
Contour Plot.

►► Sample: 

Select which sample in the experiment file to be plotted. Be default, the current ac-
tive sample will be selected when the window is opened. Used  icon to switch 
samples forward and backward.

►► Compensation: 

Click to open Compensation window to change the compensation settings. The cre-
ated plots will be refreshed according to the modified compensation settings. For 
details of the fluorescence compensation setting, refer to Section 5.4.2 for detailed 
description.

►► Overlay Uncompensated: 

Select to overlay uncompensated data on the created bi-variate plots.
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►► Plot Size: 

Move the slider can change the size of the plots.

►► Select: 

Click on the pop-up selection menu to select different section of the bi-variate plots 
(Bottom Left Plots, Top Right Plots, and Histograms) or unselect all plots. The plot 
can also be selected by clicking individual plot. To select a group of plots, pressing the 
left mouse button and drag an area across all the plots to be selected. Once selected, 
a red border will show on the plot. Clicking on the selected plot one more time will 
cancel the selection.  Selected plots can be added into the workspace by clicking Cre-
ate Selected button.

►► Create Selected: 

Click to create the selected plots in the workspace.

►► Close: 

Click to close Bi-Variate Plots window.

5.2	 Gates

Gates allow for the analysis of subpopulations from the total population collected. As de-
scribed in Section 5.1.3.1 gates can be applied to subsequent plots to focus in on a specific 
population. These plots can then be further gated and new plot created to focus on a more 
specific population.

The Workspace Toolbar includes icons for creating rectangular gates , elliptical gates 
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, polygonal gates , quadrant gates , logic gates , range gates , and bi-range 
gates .

The gating tools can be also selected from theright-click popup mini toolbar on plots.

All gate types can be created on dot plots and density plots. Range gates and bi-range gates 
can be created on histograms. Gates can also be combined to create a logic gate.

5.2.1	 Creating Gates

►► �To create a rectangular gate: Click the rectangular gate icon  , in the Workspace 
Toolbar. Click and drag in the plot to enclose the target population within the rect-
angle. Release the mouse button to create the gate.

►► �To create an elliptical  , range  , or bi-range gate  : Follow similar procedures 
as for creating the rectangular gate.

►► �To create a polygonal gate: Click the polygonal gate icon  , in the Workspace Tool-
bar. Left click in the plot to create the first vertex of the polygon. Click in a new loca-
tion to create the second vertex of the polygon. Continue moving around the target 
population and creating vertices until the target population is enclosed. On the last 
vertex, double-click to complete the polygon and create the gate.

The following figures include a rectangular gate GR, an elliptical gate MO, a polygonal 
gate LY, a range gate M1, and a bi-range gate separating CD3- and CD3+.

►► �To create a quadrant gate: Click the quadrant gate icon  , in the Workspace Toolbar. 
Click in the plot to create the center of the quadrants and create the gate. As shown 
below, the center, endpoints, and lines of the quadrant gate can be moved to enclose 
the correct populations.
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►► �To create a logic gate: Click the logic gate icon  , in the Workspace Toolbar to open 
the Create Logic Gate window. In this window, the user can create a logic gate for the 
sample in the selected plot.

There are three types of logic gates: AND gates, OR gates, and NOT gates. In the win-
dow, a drop-down menu includes the three logic gate types.

When AND or OR is selected from the drop-down menu, there are two additional 
drop-down menus to select gates. With an AND gate, the new gate includes events 
that are included in both of the selected gates. With an OR gate, the new gate includes 
events that are included in either one of the selected gates.

When NOT is selected from the drop-down menu, there is one additional drop-down 
menu to select a gate. With a NOT gate, the new gate includes all of the events ex-
cluded from the selected gate.

In the Experiment Manager panel, logic gates can be found under the sample’s Analy-
sis node.

 �If you want to create multiple gates of the same type, double click the gate icon (a blue 
outer line will show on the gate icon). The gating tool will then remain active and you 
can create multiple gates of the selected type. Once completed, press the Esc key on the 
keyboard to exit. 

5.2.2	 Editing Gates

All gates can be moved and resized after being created. If a gate is edited, all gate statistics 
and subsequent plots dependent on the gates are updated to reflect the changes.

There are multiple methods to select a gate for editing. Options include:

►► �Click the pointer icon  , in the Workspace Toolbar to activate the cursor. Select the 
gate by clicking on a vertex or edge of the gate.

►► �Click on the gate label.

►► �From the Gate tab of the Menu Bar, select the gate from the drop-down menu in the 
Current Selection group.

►► �Double-click on an area within the gate. This does not work for quadrant gates.

After the gate is selected, the gate’s control points are displayed (as white boxes). To change 
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the size of a gate, click and drag the control points to modify the gate.

 �Extra grey control points are displayed when a polygon gate is selected, which can be 
used to scale the gate as a whole.

To move the gate, select the gate as described above and drag within the gate or press 
keyboard arrows. While moving, the cursor should change into the crossed arrow symbol 

 .

After editing is complete, click outside of the gate to unselect the gate.

To delete a gate, select the gate as described above and press the Delete key on the key-
board. When a gate is deleted, the subsequent gates and plots that depend on it are reset.

5.2.3	 Gate Display Format

The NovoExpress Software allows users to format the color and labels of gates. Gate color 
determines the color of events displayed on the dot plot, as well as the color of the histo-
gram when the gate is applied to a histogram. 

5.2.3.1	 Set the Color of the Gate

The color of each gate can be set. In dot plots, the events included in the gates are displayed 
in the chosen color. If additional dot plots are created, these events are displayed in the 
same color for easy identification.

To remove the color from gates, select the gate and right-click on the gate and unselect 
Show Color or select the gate and unselect Color from the Gate tab of the Menu Bar.

The plots shown below have a gate with the color unselected.



105

55

Data Analysis

Gates

The plots below have a gate with the color selected.

To change the color of a gate, select the gate, right-click and select Change Color… or select 
the gate and change the color from the drop-down menu next to Color in the Gate tab of 
the Menu Bar. Gate color can also be changed via color column of Gate Manager.

When an event is inside more than one gate, its color on dot plot is determined by the 
color precedence of the gates. The plots below show that gate CD3+CD4+ has higher color 
precedence than does gate Lym. To view or modify color precedence of gate, refer to Sec-
tion 5.2.7.
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5.2.3.2	 Gate Labels

Gate labels are displayed near the gates and include the gate name and the percentage of 
the events included in the gate relative to the total number of events displayed on the plot. 

To change the name of a gate, select the gate and click on the gate name to edit or select the 
gate and edit it from the Gate Name box of the Gate tab in the Menu Bar.

To hide the population percentage, unselect Show Value from the Gate tab of the Menu 
Bar, or unselect Show population percentile in the gate label in the Analysis Tab of Options.

If the alias of a parameter is labeled in the Parameters panel as a CD (Cluster of Differ-
entiation) marker, quadrant and bi-range gates can be used to easily label positive and 
negative populations. To use this setting, the parameter’s alias must be labeled as CD and a 
number. Right-click on the quadrant or bi-range gate and select Name with CD to rename 
the gates according to the CD markers. 

5.2.4	 Applying a Gate to a Plot

There are multiple methods for applying a gate to a plot. When gates are applied to plots, 
the plots only display events included within the specified gate. Gates can be applied to a 
plot if the creation of the gate is not dependent on the plot.

To apply a gate to a plot:
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►► �Within the workspace, hold down the keyboard Ctrl key while dragging the gate to 
the plot. The dragged gate is applied to the plot where it was dropped.

►► �Select a gate in the workspace, and drag it to the title of the plot to be gated.

►► �Select the gate and right-click on the gate. Select Gating and select the plots to have 
the gate applied.

►► �Select the gate from the Gate tab of the Menu Bar, select the Gating button and select 
the plots to have the gate applied.

5.2.5	 Copying and Pasting Gates

There are multiple methods to copy and paste a gate:

►► �Select the gate and use the keyboard shortcut Ctrl+C to copy the gate. Select a plot 
and use the keyboard shortcut Ctrl+V to paste the gate into the selected plot.

►► �Select a gate. Drag and drop the gate into a different plot. The dragged gates are pasted 
into the plot where it was dropped.

►► �To duplicate a gate within the same plot, select a gate and use the keyboard shortcut 
Ctrl+D or select the gate and use the Duplicate button from the Home tab of the Menu 
Bar. The duplicate plot appears at the same location as the original gate.

5.2.6	 Export Gate Events

The data from a gate can be exported in either CSV or FCS file format. To export:

1 �Select the gate.

2 �In the Gate tab of the Menu Bar, click the Export Events button to open the window shown 
below.

3 �In the window, set the export path, file format, parameter range and post gain. Click OK 
to export the data.

n

 �For more information regarding this window, see Section 6.4.2.
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5.2.7	 Gate Manager

The gate manager displays all gates of the active sample in list mode or tree mode. It pro-
vides user interface to modify gate name, color and color precedence and also shows gate 
hierarchy and gate statistics.

5.2.7.1	 Toolbar of Gate Manager

Icon Description

Show Gate Hierarchy: When checked, the table displays output in tree mode. 
Child gates are indented.

Show Columns: Choose which statistical columns to display in the table. Refer 
to Section 5.3.2 for further information on calculation of gate statistics.

Modify Color Precedence: When checked, the table displays output as list 
mode. The table is sorted by color precedence – the gate with highest color 
precedence is displayed on the top.

Reset to Default Color Precedence: Sets color precedence of all gates to de-
fault values. By default, newer gates have higher precedence than do older 
gates. Child gates have higher precedence than do parent gates. Logic gates 
have higher precedence than do gates which compose the logic gates.

To Top: Sets color precedence of selected gate to the highest precedence. Only 
available when Modify Color Precedence is checked.

Up: Sets color precedence of selected gate higher. Only available when Modify 
Color Precedence is checked.

Down: Sets color precedence of selected gate lower. Only available when 
Modify Color Precedence is checked.

To Bottom: Sets color precedence of selected gate to the lowest precedence. 
Only available when Modify Color Precedence is checked.

Copy Text: Copies all gate name(s) and statistics as text to clipboard.

n

5.2.7.2	 Modify Gate Color and Color Precedence

A gate can be set with a color, and the color will be used to draw the gate label. On dot 
plots, events inside a gate are shown as colored dots defined by the gate color. When an 
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event is inside more than one gate, its color on a dot plot is determined by the color pre-
cedence of the gates. To understand more about gate color and color precedence, refer to 
Section 5.2.3.1.

To modify gate color precedence, check the Modify Color Precedence tool in the toolbar. 
The color column in Gate Manager is shown below:

The number in the Color column is the gate color precedence. Number 1 indicates high-
est color precedence. The gate rows are sorted by color precedence. To change the color 
precedence of a gate, drag the gate row and drop it to desired position. Click the check box 
to set whether to show gate color (black color indicates no color is shown). Click the color 
square box to change gate color in a pop up tool window. 

5.2.7.3	 Context menu

The context menu is shown below for right clicking on only one gate.

Create Plot: Creates a new plot including the events from the selected gate.

Gating: Selects plots to apply the gate.

Open: Opens the plot containing the gate.

Copy: Copies the gate.

Delete: Deletes the gate.

Rename: Renames the gate.

Name with CD Marker: If a fluorescence parameter is labeled as a CD (Cluster of Differen-
tiation) marker in the Parameter panel by setting the Alias as CD and a number, this labels 
the gate using the CD marker(s) specified.

Change Color: Modifies the color of the gate.
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Show Color: Sets whether to display the gate in color.

Color Precedence: Modifies color precedence of the gate.

Show Name: Shows the gate name in gate label on plot. If the Show gate name in gate label 
option in Setting → Analysis is not checked, the Show Name menu item here will be dis-
abled.

Show Percentile: Shows the percentage of the gated events relative to the total number 
of events on the plot. If the Show population percentile in gate label option in Setting → 
Analysis is not checked, the Show Percentile menu item here will be disabled.

Format: Opens Plot Format dialog to define gate format.

Export Events: Exports data for the events inside the current gate in either FCS or CVS 
format.

 �When multiple gates are selected in Gate Manager, only Delete, Show Color, Color 
Precedence, Show Name and Show Percentile are available.

5.3	 Statistics

In the NovoExpress Software, a table of statistical information can be found under plots.

5.3.1	 Display Statistical Information

In the following figure, the statistical information chart is displayed below the plot.

5.3.1.1	 Open the Statistics Chart

There are two methods to open the statistical information chart.

►► �From the plot, click the button on the lower right corner to expand the plot and dis-
play the statistics chart.
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►► �From the Workspace Toolbar, click the Show Statistics button  , to show/hide the 
statistics chart of a plot.

5.3.1.2	 Statistics Layout

In the statistics chart, the first column is the Gate column, and the remaining columns 
list the statistical parameters. As labeled by the Gate column, the first row of the chart 
contains statistical information for all events, and the remaining rows contain statistical 
information for individual gates.

To hide or show individual statistical parameters in the chart, right-click within the chart 
and select the parameters to hide or display. Check Set as Default to set the current setting 
as the default setting of new plot. And click Apply to All to hide or show individual statisti-
cal parameters to all plots of current sample.

5.3.1.3	 Copy Statistical Information to Clipboard

Data from the statistics chart can be copied to the clipboard. The copied data can by pasted 
to a spreadsheet program, such as Microsoft Excel, for further analysis.

There are two methods to copy statistical information to the clipboard:

►► �Select the statistical information from the chart by clicking and dragging or by us-
ing the keyboard shortcut Ctrl+A to select all. Use the keyboard shortcut Ctrl+C or 
Shift+C to copy the selected information. With Ctrl+C and Shift+C, one may copy the 
information with the column header and one may copy the information without the 
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header. This can be set under File → Options → General.

►► �Right-click in the plot, select Copy, and select Copy Statistics (Text).

5.3.1.4	 Statistic Layers

For plots with multiple layers, the statistical table includes additional columns. The first 
column, #, indicates the layer on the plot. The second column, Sample, indicates the sam-
ple plotted in the layer. The third column, Gate, indicates the gate. The remaining columns 
describe the statistical parameters.

If a gate belongs to a sample which is different from the first layer’s sample, an asterisk ap-
pears next to the gate name to indicate such situation. In the figure below, the statistics of 
the second row is for gate LYM which applies to the sample named Negative as indicated 
by the asterisk next to the gate name to distinguish it from the LYM gate which applies to 
the sample named Positive.
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For gates in a layered plot, the statistical information is displayed for all layers. In the fig-
ure below, statistical information for Gate M3 is displayed for both the layer correspond-
ing to the Positive sample and the layer corresponding to the Negative sample. The statistic 
in the last row is for gate M3 which belongs to the sample named Positive; since this is the 
same as the first layer, no asterisk shows next to the gate name.

5.3.2	 Calculation of Statistics

In calculating the statistics, linear scale data are used regardless of the coordinate scale 
displayed by the plot. The calculation also takes into account any fluorescence compensa-
tion applied to the data. 

In addition, the calculations update automatically if the data set, gates, fluorescence com-
pensation, or plot parameters are modified.

The statistics include the total number of events, absolute count, percentage gated, mean, 
coefficient of variation, half-peak coefficient of variation, median, and geometric mean.

►► �Count

The number of events collected in the specified gate.

►► �Absolute Count

The abbreviation of Absolute Count. The concentration of events defined as:

Absolute Count = Count / Ve / DF / Absolute Count Unit

Where Count is the number of events in the gate, Ve is the sample acquisition volume, 
DF is the dilution factor, and Absolute Count Unit is the absolute number of units. To 
set the dilution factor and the absolute number of units, click on Absolute Count Set-
ting from the Sample tab of the Menu Bar.
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►► �%Parent 

Percentage of events included within the gate relative to the number of events within 
parent gate.

►► �% Grandparent

Percentage of events included within the gate relative to the number of events within 
grandparent gate.

►► % All

Percentage of events included within the gate relative to the total number of events 
collected.

►► �Mean

The mean is defined as 
1
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Where n is the number of events and Xi is the parameter value of the number i event.

►► �SD

The standard deviation indicates the variation in the data set and is defined as 
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Where n is the number of events, Xi is the parameter value of the number i event, 
and X  is the mean of the set.

►► rSD (Robust SD)

The robust SD is relatively insensitive to outliers comparing to the classical standard 
deviation. It is equal to 0.75 multiplied by the interquartile range (IQR). The inter-
quartile range is the 75th percentile channel minus the 25th percentile channel. 

The RSD is defined as

0.75 0.75 ( 3 1)RSD IQR Q Q= × = × −

Where Q1 is the 25th percentile channel and Q3 is the 75th percentile channel.

►► �CV

The coefficient of variation indicates the variation of the data set expressed as a per-
centage and is defined as 

( / ) 100%CV SD X= ×
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Where SD is the standard deviation and X  is the mean.

►► rCV (Robust CV)

Robust CV is calculated by Robust SD divided by population median.

/RCV RSD Median=

►► �HPCV

The half-peak coefficient of variation is expressed as a percentage and is defined as 

/ (2.36 ) 100%HPCV FWHM X= ×

Where FWHM is the full width at half maximum of the peak and X  is the mean of 
the set.

►► �Median

The median value separates the data set so that number of events larger and the num-
ber of events smaller than the median are equal.

►► �Geom. Mean

The geometric mean is defined as

1

1 log
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Where, n is the number of events and Xi is the parameter value of the number i event.
Note that the geometric mean cannot be calculated for events with negative values. 
If you include the geometric mean for populations with negative values, the resulting 
statistics will be invalid.

►► Stain Index

The Stain Index is a normalized functional measure of the reagent brightness, defined 
as

1 2 2_ ( ) / (2 )Stain Index MFI MFI SD= − ×

Where MFI1 is the Mean Fluorescence Intensity of the positive population, MFI2 is 
the Mean Fluorescence Intensity of the negative population and SD2 is the standard 
deviation for the negative population. The Stain Index function is only available in 
statistical table but not statistics chart below the plot.

5.4	 Fluorescence Compensation

In multicolor flow cytometry, where a sample is stained with a combination of different 
fluorophores, each of the different fluorophores has a unique emission spectrum, and in 
many cases, the different emission spectra overlap. If the overlap occurs within a specific 
fluorophore’s channel, fluorescence compensation can be used to correct for the overlap 
by removing the signal from the fluorophores that do not correspond to the channel. 

The NovoExpress Software provides three methods for the user to adjust fluorescence 
compensation. These methods include an automatic method, a compensation matrix ad-
justment method, and a quick compensation method.
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5.4.1	 Automatic Compensation

The automatic compensation method automatically calculates the compensation matrix 
and also allows for the compensation matrix to be applied to additional samples. Auto-
matic Compensation matrix can be generated from samples acquired on NovoCyte in-
strument and from samples imported with FCS files. Section 5.4.1.5 describes the details 
on how to generate automatic compensation matrix using imported FCS files.

5.4.1.1	 Set Automatic Compensation

In the Home tab of the Menu Bar, click the Auto Compensation button, or in the Experi-
ment Manager panel, right click on the file name or a group and select New Auto Compen-
sation…. The New Auto Compensation window appears.

In the New Auto Compensation window, the user can select the channels for compensa-
tion, whether to compensate using area or height measurements, and whether to calculate 
compensation based on the measured mean or median. 

To set up the automatic compensation:

1 Select the channels to compensate: Use the checkboxes to select the channels to com-
pensate. If an unstained sample is to be used to assist in compensation, select the Un-
stained box.

2 Choose to compensate either using the Area or Height measurements.

3 Choose to compensate based on either mean or median values.

New Auto Compensation window for NovoCyte instrument

uuu
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New Auto Compensation window for NovoCyte Quanteon instrument

4 Edit photodetector gain of each channel. Click Reset All photodetector Gain 
to reset photodetector gains of all channels to default values. Every NovoCyte 
instrument has the default  photodetector gain setting. An underlined photo-
detector gain text as shown above for the B530 channel indicates it has been 
modified and is not the default value. A non-underlined photodetector gain 
indicates that it is the default setting.

5 Click OK. In the Experiment Manager panel, a Compensation Specimen node gets cre-
ated with blank control samples created for the compensation calculation. The samples 
include the channels selected in the New Auto Compensation window.

n

To modify the automatic compensation settings, right-click on the Compensation Speci-
men node in the Experiment Manager panel. Select Auto Compensation Setup…. The Auto 
Compensation Setup window appears. Modifications to the automatic compensation set-
tings can be made in this window. Click OK to save the modifications.
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5.4.1.2	 Preparing Samples for Automatic Compensation

To calculate the compensation, experimental data will need to be collected for each of 
the control samples in the compensation specimen node. For the unstained sample, the 
sample should be prepared without any fluorophores added. For the other control samples 
in the compensation specimen node, the samples should be stained with only the cor-
responding stain. For example, a FITC control sample should be stained with only FITC.

In addition, control samples can also be copied and pasted or imported from a FCS file 
into the sample, but for the compensation to be correct, the user must ensure that the 
samples meet the correct staining conditions and photodetector gain settings.

5.4.1.3	 Automatic Calculation of the Compensation Matrix

Automatic Gating

After the acquisition of a compensation control sample, the sample data are automatically 
compensated. For each of the compensation specimens, the software automatically gates 
the main population in a density plot. In addition, the positive and negative groups are 
identified and gated on a histogram plot.

 �If an unstained sample is used, the Main gate in the unstained sample is used as the 
negative group for the control samples in calculating compensation.

In most cases, the automatic gating finds the appropriate populations, but if necessary, the 
user can also adjust the gates using the following method:

►► �Open the scatter plot for the sample and modify the position or size of the polygonal 
Main gate to enclose the correct main population.

►► �Another option is to create a new gate in the scatter plot to enclose the correct main 
population, and then apply the new gate to the histogram containing the Positive and 
Negative gates. See Section 5.2.4 for more information on applying a gate to a plot.

►► �Adjust the Positive and Negative gates in the histogram to enclose the correct popula-
tion.

 �It is possible to remove the Main gate, but the Positive and Negative gates cannot be 
deleted. If the Main gate is removed, it has to be recreated manually on the unstained 
sample.
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 �After modifying the gates, if the user would like to restore the gate to the default posi-
tion, in the Experiment Manager panel, select the sample, right-click, and select Reset 
Plots.

Automatic Calculation of the Spillover Values

After the acquisition of the compensation specimen is completed, the fluorescence spill-
over of each dye is automatically calculated and displayed in the spillover matrix. In the 
matrix, the fluorophore is listed in the row and the spillover channel is listed in the col-
umn.

In an example of calculating spillover, the spillover of FITC into the PE channel using me-
dian or mean height measurements is shown below. The values below are measured from 
the single stained FITC sample.

Spillover of FITC into PE = 
   (XPE,positive-XPE,negative)

(XFITC,positive-XFITC,negative)

Where, XPE,positive is the median or mean in the PE-H channel of the positive FITC popula-
tion, and so on.

If median is used for calculation, the above spillover value will be adjusted slightly so that 
after compensation, the median in PE-H channel of the negative FITC population and the 
median in the PE-H channel of the positive FITC population are closely aligned.

Automatic Calculation of the Spillover Matrix

In the following figure, the spillover of the single stained FITC sample is automatically 
calculated. In the matrix, the fluorophore is listed in the row and the spillover channel 
is listed in the column. In this figure, the FITC fluorophore spillover is 9.4007% into PE, 
2.2213% into PerCP, 0.0067% into PE-Cy7 and 0.0025% into APC.

Following figure shows the entire spillover matrix automatically calculated. To open this, 
double click the Compensation node of Compensation Specimen in the Experiment Man-
ager Panel. The spillover values of this matrix are from all single stained samples’ spillover 
matrices.
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5.4.1.4	 Application of Automatic Compensation Results

To apply the compensation matrix to experimental samples, in the Experiment Manager 
panel copy the compensation matrix under the Compensation Specimen and paste it to the 
Compensation node under the desired sample.

 �The compensation matrix is calculated at specified photodetector gains. It should only 
be applied to samples that were acquired with the same photodetector gains.

5.4.1.5	 Conduct Automatic Compensation from Imported FCS Files

To perform auto-compensation directly from the imported FCS file:

1 Click Home → Auto Compensation to open the New Auto Compensation window. Select 
the Import Samples from FCS files.

 �This window can also be accessed by right clicking the experiment file and select-
ing New Auto Compensation in the Experiment Manager window.

uuu
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2 Select the single file or multiple files while pressing the Shift key in the keyboard. Click 
Open to import the selected file(s) to the software.

3 Ensure all the selected FCS files are successfully imported to the software. Click OK to 
continue.

4 Set the compensation parameters in the New Auto Compensation window (i.e. Area or 
Height, Median or Mean). Ensure the selected channel parameter for each single stained 
sample is correct. To select different single stained sample file, click the file name, select 
the desired file from the pull-down menu. If a channel parameter does not need to be 
included for the compensation, click the blank area in the pull-down menu. The check 
box in front of the corresponding channel parameter will be automatically unselected.

 �The software will automatically associate the imported FCS file with the selected 
channel parameter based on the keyword of the file name(e.g. B530). Users need 
to verify and select the correct FCS file for each fluorescence detection channel.

uuu
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5 Click OK and NovoExpress will automatically calculate the compensation matrix based 
on the samples imported. Once generated, the compensation matrix can be applied to 
other experiment samples.

n

5.4.2	 Active Compensation

The compensation matrix for each sample can be set to correct for fluorescence spillover 
in each channel. To open the compensation matrix for a specific sample, in the Experiment 
Manager panel, double-click on Compensation under the sample.

 �The text of the compensation node in the Experiment Manager panel will be blue when 
the matrix is filled and black with the compensation matrix is empty.

In the compensation and spillover matrix, the fluorescent probe is listed as rows and the 
spillover channel is listed as columns.
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5.4.2.1	 Relationship between the Spillover and Compensation Matrix

The spillover matrix and the compensation matrix are inversely related. When the spill-
over matrix is modified, the software automatically updates the compensation matrix.

5.4.2.2	 Editing the Spillover Matrix

The NovoExpress Software has two methods for editing the spillover matrix.

►► �The spillover matrix elements can be manually entered. To manually enter values, 
select the cell in the matrix to edit and directly enter the value. Values can range be-
tween 0 and 300 when entered manually.

►► �The spillover matrix elements can be modified using the slider bar. To use the slider 
bar, select the cell in the matrix and user the slider bar to modify the value. Values can 
range between 0 and 300 when using the slider bar.

Additional options in the Matrix Window:

►► Preview: 

If the Preview box is checked, the plots will be continually updated in real time with-
out exiting out of the matrix window as adjustments are made to the compensation 
and spillover matrices.

►► Clear: 

Click the Clear button to reset the compensation and spillover matrices. The matrix 
elements will be reset to zero.

►► Restore: 

Click the Restore button to restore the matrix to the last saved matrix.

5.4.3	 Quick Compensation Adjustment

The NovoExpress Software’s quick compensation method gives users the option to use a 
slider bar for quick and intuitive adjustment of fluorescence compensation.
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5.4.3.1	 Opening the Quick Compensation Adjustment

From the Home tab of the Menu Bar, click the Quick Compensation button  . Scrollbars 
appear on any two parameters plots with fluorescent parameters opened on the work-
space. Quickly adjust compensation by adjusting the scrollbar.

To hide the quick compensation scrollbars, click again on the Quick Compensation button.

5.4.3.2	 Using the Quick Compensation Adjustment

To use the quick compensation:

1 For a single-stained sample, create a density plot. Set the X-axis parameter as the sam-
ple’s single-stained fluorophore channel. Set the Y-axis as the spillover channel to cor-
rect. For example, to correct for the spillover of FITC-H into PE-H, analyze a sample 
stained only with FITC and use a plot with the X-axis set to FITC-H and the Y-axis set to 
PE-H.

2 Create a quadrant gate to gate the positive and negative populations as shown below.

uuu
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3 Drag the vertical scrollbar to adjust compensation. When the Y-axis parameter mean or 
median in the positive and negative populations are approximately equal, the sample is 
properly compensated.

n

 �Clicking on the blank area of the scrollbar adjusts the compensation by 0.1% incre-
ments, and clicking on the arrows of the scrollbar adjusts the compensation by 0.01% 
increments.

 �When using quick compensation on bi-exponential plots, the display may be slow to 
update.

5.5	 Cell Cycle Analysis

The NovoExpress Software includes a cell cycle analysis feature that allows for the quanti-
fication of cells in each phase of the cell cycle based on DNA content.

5.5.1	 Automated Cell Cycle Analysis

►► Gating Single Cell Population

After collecting the DNA stained cells, use a FSC-H /SSC-H density plot to get the 
target population and exclude cell debris. From the target population, create a Height 
versus Area density plot on the fluorescent channel corresponding to the DNA stain, 
and gate for the single cell population and exclude cell aggregates. This is shown in 
the figure below.
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►► Cell Cycle Analysis

Click on the Cell Cycle Plot button in the Workspace Toolbar to create a cell cycle plot. 
Set the X-axis of the plot to a channel for the DNA content stain, such as PI-A. Ap-
ply the previously created single cell gate to the plot and make sure all events inside 
the single cell gate is on plot scale. The software automatically attempts to fit the data 
and if successful, the results are calculated. To display the statistics, right click on the 
resulting cell cycle histogram and select Show Fitting Result.

Fitting results:

Item Description

Watson The model used for cell cycle fitting

RMS The root mean square error of the fit of the G1, S, and G2 phases. 
A smaller value indicates a better fit.

Freq G1 Percentage in G1 phase

Freq S Percentage in S phase

Freq G2 Percentage in G2 phase

Mean G1 The mean fluorescence intensity of the G1 phase

Mean G2 The mean fluorescence intensity of the G2 phase

G2/G1 The ratio comparing the mean fluorescence intensity of the G1 
to G2 phase

uuu
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Item Description

CV G1 The coefficient of variation of the G1 phase

CV G2 The coefficient of variation of the G2 phase

Freq Sub-G1 Percentage in Sub-G1

Freq Super-G2 Percentage in Super-G2

n

5.5.2	 Manual Cell Cycle Analysis

In some cases, the automatic fitting is not successful or additional constraints need to be 
applied to increase the accuracy of the fitting.

►► Constrain G1 and G2 peaks

To modify the G1 or G2 peaks, click on the peak. Black boxes appear on the left, cen-
ter, and right of the peak. Dragging the boxes adjusts the mean and CV used in the 
fitting. After the modification, the cell-cycle results update automatically.

►► Cell Cycle Setting Window

Right-click on the cell cycle plot and select Cell Cycle Setting to open the Cell Cycle 
Setting window.
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In the Cell Cycle Setting window, there are two mathematical models can be selected, 
the Watson model and the Dean-Jett-Fox model. For Dean-Jett-Fox model, the S Phase 
Shape can be fitted with three options: Rectangle, Trapezoid, and Polynomial. Nor-
mally, select Rectangle if the S phase looks relatively flat, select Trapezoid if the S phase 
is inclined, and select Polynomial if the S phase presents the middle low and the sides 
are high. When analyzing the experimental data for cell cycle S phase synchroniza-
tion, Synchronous S Phase should be enabled. Constraints on the fitting can be applied 
including the mean of G1 and G2 peaks, the CV of G1 and G2 peaks, and the ratio 
between the mean of G1 and G2 peaks. In addition, the color of the fitting curves can 
be set for better visualization of the fitting results.
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5.6	 Cell Proliferation Analysis

5.6.1	 Automated Cell Proliferation Analysis

►► Gating Target Cell Population

On the density plot of FSC-H/SSC-H, create a gate which includes the target cell pop-
ulation you are interested in, for example P1 as show below.

►► Cell Proliferation Analysis

Click on the Cell Proliferation Plot  icon in the Workspace Toolbar to create a cell 
Proliferation plot. Set the X-axis of the plot to a detection channel that relates to the 
proliferation staining dye, such as CFSE-H. Apply the previously created cell gate to 
the plot and make sure all the events inside this gate is within the plot scale. The 
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software automatically attempts to fit the data using the modeling algorithm and cal-
culates the results. To display the statistics, right click the resulting cell proliferation 
histogram and select Show Fitting Result.

Item Description

Model The name of model used for analysis and generates results, 
including Standard and Floating models. 

RMS Root Mean Square error. It is an estimate of the “goodness of 
fit” of the model.

Peaks The count of Peaks.

Peak Log CV Log CV of peak

Peak Ratio The average ratio of all the peak positions.
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where i=0 means the original generation.

Prol. Index Proliferation Index. It is the sum of the number of divisions in 
each generation divided by the number of original cells that 
are divided.
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Item Description

Exp. Index Expansion Index. It is the number of cells divided by the num-
ber of original cells.

Exp. Index = 
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Div. Index Division Index. It is the sum of the number of divisions in each 
generation divided by the number of original cells.
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Rep. Index Replication Index. It is the number of non-original cells di-
vided by the number of original cells that divided.

Rep. Index = 
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Reduced Chi-
Square

Reduced Chi-Square equals the Chi-Square value divided by 
the free degree. It is an estimate of the “goodness of fit” of 
the model.

Freq Gi The percentage of the ith generation. It equals the number of 
cells of ith generation divided by the number of cells.

Mean Gi The mean of the peak of the ith generation.

n

5.6.2	 Cell Proliferation Setting

You can select model to fit the data, format to display the results, and set constraints for 
analyzing cell proliferation data. On a generated Cell Proliferation analysis plot, right 
click and select Cell Proliferation Setting to open the Cell Proliferation Setting window 
as shown below. 

  

►► Select Cell Proliferation Model

The default cell proliferation model is Standard model, which is suitable for the case that 
there are overlaps between peaks of generations. The peak ratios between generations are 
the same. Floating model is only suitable for the case that peaks of generations are distinct, 
and almost no overlap between them. The peak ratios between generations are distinct.
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►► Format the Modeling Display Results

Select Draw Model Sum, Draw Components, and Fill Components to format the cell pro-
liferation modeling results displayed on the plot. Select Show Fitting Results to enable the 
statistical results shown on the plot. 

►► Set Cell Proliferation Constraints

In the Cell Proliferation Setting window, Constraints on the fitting can be applied including 
Peak Count, Peak Ratio, Peak Log CV, and mean value of the parent peak.

5.7	 Statistical Tables

The statistical tables provide a summary from multiple samples, gates, and parameters 
enabling batch analysis and data comparison.

Many of the features of the statistical table can be accessed through the toolbar in the 
Statistical Table window.

Icon Description

Sets the type of statistical table

Adds a column to the table 

Edits a column

Duplicates columns 

Deletes columns

Hides columns 

Selects columns to show

Selects samples to show 

Deletes rows 

Exports table as a CSV file

Opens the Options → Statistical Table window

n

5.7.1	 Creating Different Types of Statistical Tables

Use the following method to create and format a new statistical table.

►► �Creating a New Statistical Table

In the Experiment Manager panel, under the experiment file name, right-click on the 
Tables node and select Create. A new table is created.
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Alternatively, click on the Statistical Table button  , in the Home tab of the Menu 
Bar. This also creates a new statistical table.

The new statistical table will contain Specimen ID, Specimen, Sample, and Run Time 
columns, and lists all of the samples in the experiment file.

►► Creating a New Statistical Table from Template

In the Experiment Manager panel, under the experiment filename, right-click on the 
Tables node and select New from Template, a new table is created.

►► �Selecting the Type of Statistical Table

There are five types of statistical tables to choose from: Default Type, a table With Gate 
as Column, a table With Cell Cycle Analysis Results as Column, a table With Cell Prolif-
eration Analysis Results as Column and a table Specimen as Column. 

New tables are created as The Default Type. To change the table type, click the Table 
Type button  from the toolbar and select the new table type from the drop-down 
menu.

Shown below is an example for a table With Gate as Column.
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Shown below is an example for a table With Cell Cycle Analysis Results as Column.

Shown below is an example for a table With Cell Proliferation Analysis Results as Column.

Shown below is an example for a table With Specimen as Column. Each specimen 
takes up one row in the table

►► �Add columns and rows to the table and close the window.

►► �Rename the statistical table by selecting it from the Experiment Manager panel. Right-
click and select Rename to rename the table.

 �If columns or rows are not added to the table before closing the window, the table will 
not be saved.

5.7.2	 Statistical Table Columns

Two types of columns can be added to the statistical table. These include statistical col-
umns and formula columns. Formula columns are new parameters based on statistical 
parameters and user-defined formulas.

After columns are created, they can be edited, deleted, duplicated, hidden, moved, and 
sorted.
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5.7.2.1	 Add and Edit Columns

►► �Drag and Drop to Add Columns

For the Default statistical table type, dragging and dropping a gate into the statistical 
table creates a percent population column for the gate. For this method, select a gate 
from a plot in the Workspace and drag and drop it into the statistical table window. A 
percent population column is created. Gates can also be selected from the Experiment 
Manager panel and dragged and dropped into the statistical table window to create 
the percent population column. 

►► �Add Column Window

Click on the Add Column button in the toolbar  . The Add Column window will ap-
pear. Select the statistical value, the gate, and the parameter. Click the Add button to 
add the column to the table.

 �For a table with Specimen as Column, the Sample Name should be specified when add-
ing columns. If selecting “All” in the sample list box, the statistical results will be the 
average of all samples in each specimen. For Absolute Count calculation, if Absolute 
Count Unit defined for samples in the specimen is different, the Absolute Count result 
will be empty.

 �To calculate the Stain Index, you need to select two gates. The gate with smaller MFI 
will be used as negative population gate while the gate with larger MFI is used as posi-
tive population gate. Refer to Section 5.3.2 for detailed description of Stain Index.

 �To add Percentile statistics, click on Percentile, enter the Percentile value in the Add 
Percentile window, such as 10 for calculating the 10th percentile. Then click OK and 
10th Percentile item will be added in the statistics column.
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►► Edit a Column

Select the column in the statistical table window and click the Edit Column button , 
in the toolbar. The Edit Column window opens. Select the modifications and click OK 
to edit the column.

By default, the column name is automatically generated. The name can be modified by 
the Column Name box at the top of the Edit Column window.

5.7.2.2	 Formula Columns

In the Add Column and the Edit Column windows, click the Formula tab to enter a user-
defined formula. The formula can be defined using existing column values and basic arith-
metic operations. Click Add or OK to define the formula and create a new column.

 �If the formula is displayed in red, there is an error in the equation.
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5.7.2.3	 Select Multiple Columns

In the header row of the table, click and drag in the top half of the cell to select multiple 
columns.

 �Click and drag in the lower half of the cell to move the column.

5.7.2.4	 Duplicate Columns

Select the column, and click the Duplicate Column button  , in the toolbar to duplicate 
the selected column.

5.7.2.5	 Delete Columns

Select the column, and click the Delete Column button  , in the toolbar to delete the 
selected column.

5.7.2.6	 Show and hide Columns

Select the column, and click the Hide Column button  , in the toolbar to hide the selected 
column.

To show the column again, click the Show Columns button  , and select the column to 
show from the drop-down menu.

5.7.2.7	 Move Columns

In the header row of the table, click and drag in the lower half of the cell to move columns.

 �Click and drag in the upper half of the cell to select multiple columns.

5.7.2.8	 Sort by Columns
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In the header row of the table, double-click on a column header. The rows of the table are 
sorted in ascending order based on the selected column. Double-click on the header again 
to sort in descending order.

5.7.3	 Statistical Table Rows

In the statistical table, the rows list separate populations for analysis.

5.7.3.1	 Add Rows

►► �Filter Rows Window

In the toolbar, click the Filter Rows button  . The Filter Rows window will appear. 
Check the boxes to be used as rows to the table. Unchecked boxes will be excluded 
from the table. Click OK to recreate or delete the rows in the table.

If Automatically check new samples is selected, the samples created later will be added 
into the statistical table automatically. For with Specimen as Column statistical table 
type, if Automatically check new specimens is selected, the specimens created later will 
be added into the statistical table automatically.

►► �Drag and Drop to Add Rows

Drag and drop a sample, a specimen, or a group from the Experiment Manager panel 
into the statistical table window can create new rows for each added sample. 

For the With Gate as Column statistical table type, drag and drop a gate from the 
Experiment Manager panel or plot in the workspace into the statistical table window 
to create rows for the selected gate. If multiple samples contain a gate with the same 
name as the dropped gate, a row is created in the table for each of those samples’ gates.

For the With Cell Cycle Analysis Results as Columns statistical table type, drag and 
drop a cell cycle analysis plot from the Experiment Manager panel or workspace into 
the statistical table window to create a row for the sample. If multiple samples have 
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a cell cycle analysis plot with the same name, a row is added to the table for each of 
those samples.

5.7.3.2	 Select Multiple Rows

Click and drag in the column to the left of the Sample row to select multiple rows. Alter-
natively, hold down Ctrl and click in the column to the left to the Sample row to select 
multiple noncontiguous rows.

5.7.3.3	 Delete Row

Select the row, and click the Delete Rows button  , in the toolbar to delete the selected 
row. Alternatively, select the row and press the keyboard Delete key.

5.7.4	 Statistical Tables Export or Copy Text

Statistical table results can be exported to CSV file or copied to clipboard as text.

5.7.4.1	 Exporting Statistical Tables as CSV File

In the Sample tab toolbar, click the Export CSV File button  . Enter the file path and 
click Save to export the file.

5.7.4.2	 Copying Statistical Table as Text to the Clipboard

Select the cells to be copied by clicking and dragging with the mouse, or select all using 
the keyboard shortcut Ctrl+A. Use the keyboard shortcut Ctrl+C to copy the selected cells 
to the clipboard. The copied table can be pasted to a program, such as Microsoft Excel, for 
further analysis.

5.7.5	 Statistical Table Options

In the toolbar, click the Statistical Table Options button  to open the Statistical Table tab 
of Options window, set Customize Name and Default Visibility of Specimen, Sample, Run 
Time and Gate columns.
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5.7.6	 Statistical Table Management

Statistical tables can be managed in the Experiment Manager panel under the Tables node.

►► �Copy and Paste Statistical Tables

In the Experiment Manager panel, dragging a statistical table and dropping it into the 
Tables node will create a new table with identical information. Alternatively, a statisti-
cal table can be copied and then pasted into the Tables node to also create a new table 
with identical information. 

►► �Delete Statistical Tables

In the Experiment Manager panel, select the table. Right-click and select Delete to de-
lete the table. Alternatively, select the table and press the Delete key on the keyboard.

►► �Rename Statistical Tables

In the Experiment Manager panel, select the table. Right-click and select Rename. 
Enter the new name to rename the table.

►► Export Statistical Table as Template

In the Experiment Manager panel, select the table. Right-click and select Export Tem-
plate... Enter the name for the template in the prompted window and click Save to 
create a template. The template will be saved as a *.nst file. 

5.8	 Heat Maps

The heat map can be used to visualize the data in a well plate format. It uses different 
color to display the result of a specified statistical parameter. The color is determined by 
the color scale set for the statistical parameter to be analyzed. Multiple heat maps can be 
opened at the same time, and one heat map supports up to  four statistical items.
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5.8.1	 Creating a New Heat Map

In the Experiment Manager panel, under the experiment file name, right-click on the Heat 
Maps node and select Create.

Alternatively, click on the Heat Map icon  in the Home tab of the Menu Bar. The Heat 
Map window will show up. 

5.8.2	 Heat Map Window

The heat map window contains heat map and legends. The well plate ID, plate type, and 
whether to show the sample name and statistics can be changed, and the heat map statis-
tics can be edited. In addition, the heat map and legend can be copied and saved as image.

 �If there are multiple samples in the same well, only the first sample will be used to gener-
ate the heat map.

 �If there are samples outside the current plate type, “*” will be displayed in the upper left 
corner of the heat map.
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5.8.2.1	 Heat Map Grid

A heat map can be generated for up to four statistic parameters. Each parameter will be 
displayed in a heat map with a corresponding section as illustrated below, based on the 
number of parameters to be displayed together.

5.8.2.2	 Heat Map for Multiple Statistics

The following figure shows a heat map with two statistics.

 �The gate, color scale, and color scale range of each statistic parameter can be set sepa-
rately. 

5.8.2.3	 Add Statistic

►► Drag and Drop to Add Statistic Parameter

Directly dragging and dropping a gate into the heat map will add the Count param-
eter from the selected into the heat map. To do so, select a gate from a plot in the 
Workspace, drag and drop it into the created heat map. If there is no statistic param-
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eter defined in the heat map, this action will add the Count statistics of the selected 
into the heat map. Otherwise, the current statistic parameter will be replaced by the 
Count statistics of the selected gate. To add the Count of a gate as a new statistic 
parameter, press the Ctrl key while drag and drop a gate. You can also select the gate 
from the Experiment Manager panel and drag and drop it into the heat map to add 
Count statistics of the gate.

5.8.3	 Edit Heat Map Statistic Window

You can add, edit, and remove statistics in Edit Heat Map Statistic window. To do so, click 
the Edit Statistic… button in the heat map. The Edit Heat Map Statistic window will appear. 

►► �Add: Click to add a new statistic to the list. Up to 4 statistic parameters can be added 
into the list.

►► Remove: Click to delete the selected statistic parameter.

►► �Edit Statistics properties: When select a statistic, you can select the statistic type, gate, 
parameter for the statistic, and set whether the statistic is visible in the heat map or 
not.

►► �Select color scale and range: There are two color scale displaying patterns you can 
choose for each statistic in the heat map, Threshold mode and Gradient mode. 

Threshold pattern defines the statistic parameter with two colors, depending on if the 
result is larger or smaller than the defined threshold. Select different color scheme 
from the drop-down list in the Threshold option and enter the Threshold into the text 
box below. 

Gradient pattern shows the statistic parameter in a color gradient. Select different 
color scheme from the drop-down list in the Gradient option. The scale of the statistic 
parameter can be defined as Auto Range (software identifies the minimum and maxi-
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mum value and calculate the range automatically) or you can manually define the 
range by entering the minimum value in the Min. text box and the maximum value 
in the Max. text box. 

5.8.4	 Update Heat Map

When the statistics of a sample are changed in value or in scale, the heat map will be auto-
matically updated in real time.

5.8.5	 Heat Maps Management

Heat maps can be managed in the Experiment Manager panel under the Heat Maps node.

►► Copy and Paste Heat Map

In the Experiment Manager panel, drag a heat map and drop it into the Heat Maps 
node will create a new heat map identical to the original one. Alternatively, a heat 
map can be copied and then pasted into the Heat Maps node to create a new heat map 
identical to the original one. 

►► Duplicate Heat Map

In the Experiment Manager panel, select a heat map. Right-click and select Duplicate 
to create a new heat map identical to the original one. 

►► Delete Heat Map

In the Experiment Manager panel, select a heat map. Right-click and select Delete to 
delete the selected heat map. Alternatively, select the heat map and press the Delete 
key on the keyboard.

►► Rename Heat Map

In the Experiment Manager panel, select a heat map. Right-click and select Rename. 
Enter the new name to rename the heat map.

5.9	 Post Gain

In certain situations, user may want to align a particular peak on different samples on the 
same plot. Post Gain function in NovoExpress software allows such  adjustment to be done 
after data acquisition. 

 �Post Gain does not affect data acquisition. The threshold value entered in the Cytom-
eter Setting panel is based on event data value before Post Gain. 

 �Only accounts with the Post Gain Adjustment privilege can adjust Post Gain.

5.9.1	 Adjust Post Gain

You can adjust the post gain value for each parameter of a sample.

First create a histogram of the desired parameter and click Adjust Post Gain button  , on 
the workspace toolbar. Move mouse to the histogram plot area, hold down the left button 
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of the mouse and drag the histogram curve, then drag and drop the peak of interest to the 
target location. In the example below the left plot is prior to the post gain adjustment and 
the right plot is after the post gain adjustment.

If you want to align peaks of different samples, first create a histogram plot of the param-
eter with multiple overlays of these samples. Set the style of the histogram plot as offset, 
and then use the mouse to drag each histogram curve to align them. In the examples 
below the left plot is prior to alignment and the right plot after alignment using the post 
gain function.

After a parameter is set using post gain, a * mark will be shown with parameter name in 
the statistics information of a plot or in the analysis table, and the value of any statistic 
with post gain will be shown with a * mark.

 �Post gain will have no effect on the calculation of compensation, such that, compen-
sated data will be calculated from the original data first, and the post gain will then be 
applied to the data. Control samples in an auto compensation specimen cannot be set 
using post gain.
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5.9.2	 Clear Post Gain

If you want to clear the post gain of a parameter, on area of axis parameter of any plot 
which contains the parameter, click the Clear Post Gain in the shortcut menu. If the menu 
item is not in the menu, it means that no post gain is set to the parameter.

If you want to clear post gain of all parameters of a sample, click Clear Post Gain menu 
under the main menu Sample, the post gain of active sample will be clear. If the menu item 
is gray, it means that no post gain is set to the parameters of the active sample.

5.9.3	 Apply Post Gain

When pasting an analysis node of a sample to other sample on the experiment manage-
ment tree, post gain will be pasted to the target sample too.

When exporting a sample to an .nct template file in the experiment management tree, post 
gain is contained in that template file too. When importing a template file to an analysis 
node of a sample, post gain will also be imported and applied to the target sample.

5.9.4	 Export Post Gained Data

In Export Events dialog, check the Post Gain option to enable exporting post gained data 
to FCS or CSV file. If the Post Gain option is unchecked, data without post gain will be 
exported.
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If Post Gain option is checked, the sample data exported to FCS file are post gained data, 
and if there is compensation matrix in the sample, the data are first compensated and then 
post gained. If the FCS file is again imported in NovoExpress, post gain can be readjusted 
or cleared, as well as the compensation matrix. If the FCS file is imported into a third party 
software, the third party software will treat the data like an original data, and does not 
know about the original compensation matrix and Post Gain information.

When export post gained data to CSV file, the name of parameters with post gain will be 
followed with a * mark.
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6.	 Experiment Manager

The NovoExpress Software uses a hierarchy structure including groups, specimen, and 
samples to organize and manage experimental data. This section describes how the Ex-
periment Manager panel sets up a hierarchy structure to organize the samples, the use of 
templates, and importing and exporting data. 

6.1	 Experiment Manager Toolbar

Icon Description

Work List: View and edit the work list. Contains information on 
the sample names and collection parameters. Refer to Section 4.2 
Work List for more information. 

Copy the selected node. 

Paste the copied content. 

Create a copy of the currently selected sample or specimen. 

Expand all child nodes of the current node. 

Collapse all child nodes of the current node.

n

6.2	 Hierarchy

6.2.1	 Description

In the NovoExpress Software, the hierarchy structure from high to low is groups, speci-
men, and samples.
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In the figure above, the red arrow indicates the active sample. In the NovoExpress Soft-
ware, the active sample collection parameters are displayed in the Cytometer Setting and 
Cytometer Control panels. In the Experiment Manager panel, double-clicking on a sample 
node will make it the active sample. When switching to a new active sample, the Cytometer 
Setting and Cytometer Control panels will update with the new active samples information, 
and the plots in the Workspace will be replaced with the new active sample’s plots.

Icon Description

 File The experiment file (*.ncf file format)

 Heat Maps This node contains Heat Maps for the experiment file. 
Right-clicking this node allows for creating new heat map.

 Statistical tables This node contains statistical tables for the experiment 
file. Right-clicking this node allows for the creation of new 
statistical tables

 Statistical table Statistical analysis table

 Group This node represents a Group in the organizational hier-
archy. A group can contain multiple specimens and sub 
groups, and specimens will always be placed in front of 
sub groups. 

 Specimen This node represents a Specimen in the organizational hi-
erarchy. A specimen can contain multiple samples. Each 
specimen contains a specimen report. In the node text 
“1:Specimen 1”, the former number is Specimen ID, the 
latter text is Specimen Name.

uuu
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Icon Description

   Sample This node represents a Sample in the organizational hi-
erarchy. The sample is the most basic organizational unit 
and contains sample data collection parameters, instru-
ment settings, fluorescence compensation settings, re-
ports, analysis, and data. The sample icon will display dif-
ferently depending on the status of the sample.

A blank sample without any data collected will appear as

A sample listed for sample acquisition and during acquisi-
tion will appear as 

A sample with data collected will appear as  

 Cytometer settings Cytometer settings contain the sample parameters, the 
acquisition stop conditions, and the sample flow rate and 
threshold settings. See Section 4.1 Cytometer Setting for 
additional information.

 �Fluorescence compensa-
tion

Fluorescence compensation matrix for the sample. If the 
matrix is empty, the node is displayed in black. If the ma-
trix is filled, the matrix is displayed in blue. See Section 
5.4 Fluorescence Compensation for additional information.

 Report Contains a report of the data analysis and is found under 
both specimen and sample nodes.

Reports under specimen nodes can include plots and sta-
tistical analysis for all samples under the specimen.

Reports under the sample nodes can include plots and 
statistical analysis only for the sample.

See Section 7 Report for additional information.

 Analysis Analysis contains the plots and gates for a sample. Un-
der the Analysis node, there are plot nodes and a logic 
gate node. Plot nodes are listed for individual plots of the 
sample, and each plot node contains the gates created 
for the plot. A separate logic gate node contains all of the 
logic gates created for the sample. 

Plot A plot created for the analysis of a sample 

Gate A gate created within a plot

 Logic gate group Contains all logic gates for a sample 

 Logic gate Logic gates

 Red arrow The red arrow indicates the sample is the active sample. 

 /  �Flashing green and 
dark green arrows

Flashing green and dark green arrows indicate the sample 
is being collected.

 /  �Alternatively flashing 
red and green arrows

Flashing red and green arrows indicate the active sample 
is being collected.

n
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6.2.2	 Right-Click Menu

From the Experiment Manager panel, right-clicking each node will bring up a menu of 
functions. The table below lists the specific functions available by right-clicking each node 
type.

Icon Description

 File
New Experiment:

►► New Blank Experiment: Create a blank 
experiment file.

►► New from Template: Create an experi-
ment file from a template.

►► New from Experiment File: Create an ex-
periment file from an existing experiment 
file.

New Sample: Creates a new specimen with 
a new sample included.

New Specimen: Creates a new specimen. 

New Group: Creates a new group. 

New from Template: Imports selected group, 
specimen, and samples from a template. 

New Auto Compensation: Creates a com-
pensation specimen containing samples to 
compute a compensation matrix. 

Open Plots: Opens all plots from all of the 
samples. 

Close Plots: Closes all plots from all of the 
samples.

Paste: Creates a new specimen with the 
copied specimen template.

Paste to All Specimens: Pastes the copied 
specimen template to all specimens.

Paste to All Samples: Pastes the copied sam-
ple template to all samples.

Import FCS Files: Selects a folder to import 
all FCS files within the folder or subfolders 
as samples. Files up to 10 subfolders deep 
from the selected folder will be added and 
organized according to the folder structure.

Export:

►► �Export as Template: Exports the file as a 
template file.

►► �Export to FCS Files: Exports all samples 
as FCS files.

►► �Export to CSV Files: Exports all samples 
as CSV files. 

►► Export Plots: Exports all plots from all 
samples as image files.

Open Folder: Opens the folder containing 
the experiment file.

uuu
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Icon Description

 Heat Maps Create: Creates a new heat map. 

Paste: Pastes a copied heat map.

 Heat Map
Open: Opens the selected heat map. 

Copy: Copies the selected heat map.

Duplicate: Duplicates the selected heat map.

Delete: Deletes the selected heat map.

Rename: Renames the selected heat map.

 Statistical tables Create: Creates a new statistical table. 

Paste: Pastes a copied statistical table.

New from Template: Creates a new statisti-
cal table from an exist template.

 Statistical table Open: Opens the selected statistical table. 

Copy: Copies the selected statistical table.

Duplicate: Duplicates the selected statistical 
table.

Delete: Deletes the selected statistical table.

Rename: Renames the selected statistical 
table.

uuu



153

66

Experiment Manager

Hierarchy

Icon Description

 Group New Sample: Creates a new specimen with 
a new sample included.

New Specimen: Creates a new specimen. 

New Group: Creates a new group. 

New from Template: Imports selected group, 
specimen, and samples from a template. 

New Auto Compensation: Creates a com-
pensation specimen containing samples to 
compute a compensation matrix. 

Open Plots: Opens all plots from all of the 
samples within the group. 

Close Plots: Closes all plots from all of the 
samples within the group.

Paste: Creates a new specimen with the 
copied specimen template.

Paste to All Specimens: Pastes the copied 
specimen template to all specimens in the 
group.

Paste to All Samples: Pastes the copied sam-
ple template to all samples in the group. 

Delete: Deletes the group. 

Rename: Renames the group. 

Import FCS Files: Selects a folder to import 
all FCS files within the folder or subfolders 
as samples. Files up to 10 subfolders deep 
from the selected folder will be added and 
organized according to the folder structure.

Export:

►► �Export as Template: Exports the group as 
a template file.

►► �Export to FCS Files: Exports all samples 
as FCS files.

►► �Export to CSV Files: Exports all samples 
as CSV files.

►► Export Plots: Exports all plots in current 
group as image files.

uuu
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Icon Description

 Specimen New Sample: Creates a new sample in the 
specimen. 

New Sample from Template: Imports the 
samples of the first specimen from a se-
lected template. 

Open Plots: Opens all plots from all of the 
samples within the specimen. 

Close Plots: Closes all plots from all of the 
samples within the specimen.

Copy: Copies the template of the specimen.

Paste: Pastes the template of a copied spec-
imen, or creates a new sample with the cop-
ied sample template. 

Paste to All Samples: Pastes the copied sam-
ple template to all samples in the specimen.

Duplicate: Creates a duplicate of the speci-
men.

Delete: Deletes the specimen. 

Rename: Renames the specimen. 

Import:

►► Import Template: Imports template and 
apply to the selected specimen.

►► Import FCS Files: Selects one or more 
FCS files imported as samples.

Export:

►► �Export as Template: Exports the speci-
men as a template file.

►► �Export to FCS Files: Exports all samples 
as FCS files.

►► �Export to CSV Files: Exports all samples 
as CSV files.

►► Export Plots: Exports all plots in current 
specimen as image files.

uuu
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Icon Description

   Sample Open Plots: Opens all plots from the sample. 

Close Plots: Closes all plots from the sample.

Delete Plots: Deletes all plots from the sam-
ple. 

Create Plot: Creates a new plot for the sam-
ple.

Copy Template: Copies the template of the 
sample. 

Copy Events: Copies the events of the sam-
ple. 

Paste: Pastes the copied template or events 
of a sample.

Duplicate: Creates a duplicate of the sample.

Delete: Deletes the sample. 

Delete Events: Deletes all or part of the sam-
ple’s events. Only accounts with the Delete 
Sample Events privilege can perform this 
operation (Refer to Section 3.3.4).

Rename: Renames the sample. 

Import: Imports a sample template or FCS 
file, as shown below:
 

Export: Exports the sample as a template, 
FCS file, CSV file, or exports all plots of the 
sample as image files.

View Cytometer Status: Displays the cytom-
eter status when the sample is collected.

View Instrument Information: Displays the 
instrument information when the file is cre-
ated or the first sample is collected.

 Cytometer settings Copy: Copies the sample’s instrument set-
tings. 

Paste: Pastes the copied instrument settings 
to the sample. 

Import: Imports the instrument settings from 
a selected template.

uuu
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Icon Description

 �Fluorescence compensation Compensation Matrix: Opens the sample’s 
compensation matrix. 

Spillover Matrix: Opens the sample’s spill-
over matrix.

Clear Compensation: Clears fluorescence 
compensation information of the sample. 

Copy: Copies the sample’s fluorescence 
compensation. 

Paste: Pastes the copied fluorescence com-
pensation to the sample. 

Import: Imports fluorescence compensation 
from a selected sample template.

 Report

Specimen Report: 

Sample Report: 

Open: Opens the report. 

Print: Prints the report. 

Copy: Copies the report template. 

Paste: Pastes the copied report template to 
the sample. Specimen reports and sample 
reports are not able to copy and paste each 
other.

Import: Imports a report template to the 
sample from a selected template file.

 Analysis Open Plots: Opens all plots from the sample. 

Close Plots: Closes all plots from the sample.

Delete Plots: Deletes all plots from the sam-
ple. 

Create Plot: Creates a new plot for the sam-
ple.

Copy: Copies the sample analysis template. 

Paste: Pastes the copied analysis template 
to the sample.

Import: Imports an analysis template to the 
sample from a selected template file. 

Plot Open: Opens the plot. 

Close: Closes the plot. 

Copy: Copies the plot. 

Paste: Pastes a copied gate to the plot. 

Delete: Deletes the plot. 

Rename: Renames the plot.

Save as image…: Save plot as an image file.

uuu
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Icon Description

Gate Create Plot: Creates a new plot including the 
events from the selected gate.

Gating: Selects plots to apply the gate.

Open: Opens the plot containing the gate.

Copy: Copies the gate.

Delete: Deletes the gate. 

Rename: Renames the gate. 

Name with CD Marker: If a fluorescence pa-
rameter is labeled as a CD (Cluster of Dif-
ferentiation) marker in the Parameter panel 
by setting the Alias as CD and a number, 
this labels the gate using the CD markers. 

Change Color: Modifies the color of the gate. 

Show Color: Sets whether to display the 
gates in color. 

Color Precedence: Modifies color prece-
dence of the gate.

Show Name: Shows the gate name in gate 
label on plot. If the Show gate name in gate 
label option in Setting → Analysis is not 
checked, the Show Name menu item here 
will be disabled.

Show Percentile: Shows the percentage of 
the gated events relative to the total number 
of events on the plot. If the Show population 
percentile in gate label option in Setting → 
Analysis is not checked, the Show Percentile 
menu item here will be disabled.

Format: Opens Plot Format dialog to define 
gate format.

Export Events: Exports data for the events 
inside the current gate in either FCS or CVS 
format.

 Logic gate group Create: Creates a logic gate. 

Delete: Deletes all logic gates.

uuu
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Icon Description

 Logic gate Create Plot: Creates a new plot including the 
events from the selected gate.

Gating: Selects plots to apply the gate.

Edit: Opens the logic gate editing window. 

Delete: Deletes the logic gate.

Rename: Renames the logic gate.

Change Color: Modifies the color of the logic 
gate. 

Show Color: Sets to display the logic gates 
in color.

Gating: Selects plots to apply the gate. 

Create Plot: Creates a new plot with the gate 
applied to the plot.

n

6.2.3	 Move Items

Items in the Experiment Manager can be easily re-organized by drag and drop action. 
Select the item using the left key of the mouse. Move the mouse while holding the left key 
to drag the item. When the mouse cursor turns like  , one may move the item to the 
position indicated by the blue line. When the mouse cursor turns like  , one may apply 
the analysis as the template to another item. For more information, see Section 6.3.2 Drag 
and Drop the Template.

 �During the drag, press the ESC key to cancel the drag operation.

 �Experiment Manager supports making multiple selections within tree node to allow 
batch operation of multiple objects. Use Shift key to select continuous nodes on the tree 
and use Ctrl key to select discontinuous nodes on the tree, just like selecting multiple 
files on Windows Explorer. Only nodes of same type can be selected simultaneously. The 
selection menu may have less items available when in multiple selection mode.
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6.3	 Templates

The NovoExpress Software allows for the use of templates to quickly set up experiment 
settings. These files can contain the settings for groups, specimens, or samples. There are 
multiple methods for a template to be applied including: copying and pasting, dragging 
and dropping, adding through the toolbar, and importing and exporting templates.

6.3.1	 Copy and Paste the Template

In the Experiment Manager panel, select a specimen, right-click, and select Copy to copy 
the template of the specimen. To copy the template of a sample, select the sample, right-
click, and select Copy Template to copy the template of the sample.

 

To paste, right-click on the target node and select Paste or Paste to All Samples or Paste to 
All Specimens to apply the template, as shown below:
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The following table lists template information transferred when copying from a source 
node type and pasting to a target node type. In addition to copying and pasting, the table 
below also applies to dragging and dropping (Section 6.3.2) and using the toolbar (Section 
6.3.3) except for one exception described in Section 6.3.2.

The source node Target node

Specimen Specimen: The target specimen report is replaced by the tem-
plate of source specimen report and samples in the target spec-
imen are replaced by copying samples in the source specimen 
and pasting to them.

Group, Experiment File: Creates the same specimen as the 
source specimen in the target group of experiment file.

Specimen Report Specimen Report, Specimen: The target specimen report or 
specimen report of target specimen is replaced by template of 
source specimen report.

Group, Experiment File: The specimen reports of all specimens 
within the target node are replaced by the template of source 
specimen report.

Sample Sample: The cytometer settings, compensation, sample report 
and analysis templates are replaced. If the target sample con-
tains events, cytometer settings are not replaced.

Specimen: Create the same sample in the target specimen 

Groups, Experiment File: All samples in the target node are re-
placed by copying the source sample and pasting them to the 
target node.

uuu
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The source node Target node

Cytometer Setting Cytometer Setting, Sample: The cytometer settings template is 
replaced. If the target sample node contains previously collect-
ed events, only the parameter aliases are replaced.

Specimen, Groups, Experiment File: The cytometer settings tem-
plates for all samples within the target node are replaced.

Compensation Compensation, Sample: The compensation of target sample is 
replaced.

Specimen, Group, Experiment File: The compensations of all 
samples within the target node are replaced.

Sample Report Sample Report, Sample: The report template is replaced by the 
report template of source sample.

Specimen, Group, Experiment File: The sample report templates 
of all samples within the target node are replaced.

Analysis Analysis, Sample: The analysis template of target sample in-
cluding plots and gates is replaced by the analysis template of 
source sample.

Specimen, Group, Experiment File: The analysis templates of all 
samples within the target node are replaced.

Plot Analysis, Plot: If the target node contains a plot with the same 
name as the source node, the plot will be replaced. Otherwise, 
the plot will be created.

Specimen, Group, Experiment File: Either replace or create the 
plot in all of the samples of the target node.

Gate (does not include 
logic gates)

Plot (does not include cell cycle plots): If the target node con-
tains a gate with the same name as the source node, the gate 
will be replaced. Otherwise, the gate is created. Only range and 
bi-range gates can be drawn into a one-dimensional histogram. 
i.e., a rectangular gate cannot be applied to a histogram. Also, 
changing a two-dimensional gate (such as FITC vs. PE, that has 
a rectangular gate drawn in it) to a histogram will delete rect-
angular gates.

Analysis, Sample: Source gate will be pasted to the plot with the 
same plot name as source gate’s plot in the target sample if it 
exists. 

Specimen, Group, Experiment File: Source gate will be pasted to 
all samples in the target node.

n

 �Specimen reports and sample reports cannot copy and paste each other.

6.3.2	 Drag and Drop the Templates

The template from source nodes can also be applied to target nodes by dragging and drop-
ping, as shown below:
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When dragging a node over another, if the mouse turns to  , dropping will apply tem-
plate. If the mouse turns to  , dropping will move and reposition the selected item. For 
more details for moving objects, see Section 6.2.3 Move Items. 

 �Drag a sample node to a specimen node, a pop-up dialog box will ask you to create new 
sample or paste a template to all samples of that specimen; drag a specimen node to a 
group node, a pop-up dialog box will ask you whether create new specimen or paste a 
template to all specimen of that group.

 �During the drag, press the ESC key to cancel the drag operation.

 �Drag a sample node to the workspace (empty area or inside plot window) will apply the 
data analysis template of the current Active Sample to the dragged sample and display 
the data from the dragged sample. In another word, it will keep current analysis tem-
plate and switch the Active Sample to the dragged sample.

6.3.3	 Using the Toolbar

In the Experiment Manager panel, select the source node to be copied. The node will be 
highlighted in yellow (e.g.  ). To copy the selected node, click the Copy 
button  , from the Experiment Manager panel toolbar. To paste the copied node, select 
the target node in the Experiment Manager panel, and click the Paste button  , from 
the toolbar. 

6.3.4	 Import and Export Templates

Export Template

In the Experiment Manager panel, select the sample, specimen, group, or experiment file 
to export. Right-click the selected node and select Export → Export as Template…. The 
template will be exported as a *.nct template file.
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Import Template

►► �Import to Experiment File

If importing to an experiment file, right-click the experiment file node and select New 
from Template….

►► �Import to Specimen

If importing to a specimen, right-click the specimen node and select New Sample 
from Template….
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►► �Import to Sample

If importing to a sample, right-click the sample node and select Import, then Import 
Template….

►► �Import to Cytometer Setting, Compensation, Report, or Analysis

If importing to Cytometer Setting, Compensation, Report, or Analysis, right-click the 
target node and select Import…

6.4	 Importing and Exporting Data

The NovoExpress Software is capable of importing FCS 2.0, 3.0 and 3.1 formatted files for 
data analysis, and it is able to export FCS 3.0, FCS 3.1, and CSV formatted files.
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6.4.1	 Importing Data

There are multiple methods for importing FCS files through the Experiment Manager 
panel:

►► �Select the experiment file node or a group node. Right-click and select Import FCS 
Files…. Select a folder containing the FCS files to import. All FCS files within the 
folder will be imported. Files up to 10 subfolders deep will be imported and organized 
according to the folder structure.

►► �Select a specimen node. Right-click and select Import FCS Files…. Select FCS files to 
import as samples under the specimen node.

 �To import multiple samples, hold down the Ctrl key while selecting samples to select 
more than one sample.

►► �Select a blank sample node. Right-click and select Import, then Import FCS File… . 
Select the FCS file, and data from the file will be imported to the blank sample. It is 
not possible to import data to a sample already containing collected data. To import 
data to a sample already containing data, first clear the sample of any events by right-
clicking the sample and selecting Delete Events.

6.4.2	 Exporting Data

Select the sample, specimen, group, or experiment file node with data to be exported. 
Right-click the node and select Export →Export to FCS Files… or Export to CSV Files…. 
The Export Events window will open.

The Export Events window has the following settings:

►► �Object: This is the node to be exported. If the object is a sample, only the sample will 
be exported. If the object is a specimen, group, or experiment file, all samples within 
the object will be exported.

►► �Gate: The default gate setting is All. In this setting, all events are exported for each 
of the exported samples. A specific gate can be selected using the drop-down menu. 
When a gate is selected, only events within the gate are exported. If an exported sam-
ple does not contain the selected gate, all events within the sample are exported. Also, 
if an exported sample contains the gate but the gate does not include any events, all of 
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the sample’s events are exported.

►► �Path: The path specifies the location to save the exported files. The user can type in the 
textbox or use the button  , to change the path. When the object is a single sample, 
the exported data file is saved directly at the path. When the object is a specimen, 
group, or experiment file, the exported data files is saved in subfolders representative 
of the sample hierarchy organization in the experiment manager.

►► �Specimen Name: Check this box to include specimen name in the name of the ex-
ported file.

►► �Format: This specifies the exported data file format. The default setting depends on 
whether the window was opened using Export → Export to FCS Files… or Export → 
Export to CSV Files…. However, the format can be changed post selection using this 
setting. If you want to import the FCS files to FlowJo with version below v10, please 
select FCS 3.0.

►► �Parameter Range: When exporting as a FCS formatted files, there is the option to set 
the recommends visualization parameter range. The three options are Default, Auto, 
and Plots. When Default is selected, the parameter range is the full range of the Novo-
Cyte System (10 to 224). When Auto is selected, the software automatically calculates 
the best range based on the distribution of the sample data. When Plots is selected, the 
parameter range is determined from parameter ranges used in plots.

►► �Post Gain: This option is enabled only when the samples specified to export have 
Post Gain defined. When checked, exported event value is the value after Post Gain 
adjusted.

After setting the above options, click OK to begin exporting the data.

 �Parameter range of options does not affect the number of events exported. No matter 
what choice was made it will export all the events within specified gate. Export FCS file 
with Auto or Plots parameter range could help third-party software to select the ap-
propriate range when showing plots.

6.4.3	 Copy and Paste Events

In the Experiment Manager panel, data of collected events can be copied and pasted to 
blank samples.

►► �Select the sample containing the events to be copied. Right-click and select Copy 
Events.

►► �Select the empty sample. Right-click and select Paste, or select the Paste button, from 
the toolbar. Data from all of the collected events in the original sample is pasted into 
the blank sample. Note that only events and cytometer settings are pasted. To copy 
and paste Analysis, select the sample containing the Analysis to be copied. Right click 
and select Copy Template. Select the sample to paste the Analysis into. Right click 
and select Paste. Alternatively, dragging and dropping Analysis from one sample to 
another will also copy and paste the Analysis. Similarly, this can be performed with 
Compensation and Report.

 �This is useful when using the Auto Compensation feature during analysis to apply 
single stained compensation controls to the generated Auto Compensation samples.
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7.	 Reports

The NovoExpress Software’s Report function enables the user to quickly generate custom-
izable summaries of analyzed data. This section describes the creation and editing of re-
ports using the NovoExpress Software.

Reports can be created using an Auto mode and a manual mode. In the Auto mode, the 
software generates the report using a fixed format to include user created plots, statistics 
(Gate, Count, % of Parent, Mean X and Mean Y), and basic information (Sample Name, 
Run Time, Cytometer, and Software). In the manual mode, the user is able to add or re-
move elements and adjust formatting.

 �Real-time changes made to a plot within the Report are also applied to sample’s Analy-
sis back in the main interface. Statistics are automatically adjusted.

From the Experiment Manager panel, the report can either be a sample report or a speci-
men report. A sample report can contain plots, statistical information, compensation ma-
trices, and collection information for the sample. A specimen report contains such infor-
mation for all of its samples and basic information of its own. Double clicking on Report 
in the Experiment Manager allows the user to view the report interface window.

After the reports are created, a batch print function (Section 7.6) can be used to generate 
PDF files. 
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7.1	 Report Interface

The report interface window is shown below. It can be opened by double-clicking on the 
report node in the Experiment Manager panel.

The interface window is divided into three main sections: Title Block, Toolbar, and Display 
Area.

The title bar contains the name of the current report in the window.

The toolbar contains the functions available to generate and edit the report.

The display area is the main area of the window. Using this area, the user is able to edit the 
objects displayed and add and delete pages. The objects here forth are referred to as report 
items and include text, graphics, statistical information, fluorescence compensation, and 
plots.

The toolbar functions are described below:

Icon Description

Auto Report Mode: Clicking on this button switches between the 
automatic report generation mode and the manual mode. When 
selected and in automatic mode, the icon appears with a blue bor-
der  . When unselected and in manual mode, the icon appears 
without the blue border  . 

 �The original automatic report can be restored after mak-
ing manually changes in manual mode by re-selecting auto 
report mode.

Report Options: Click to open Report Options dialog. Refer to Sec-
tion 7.3 for detail information of Report Options.

uuu
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Icon Description

Insert Page: This function inserts a page into the report. By default, 
clicking the button inserts a blank page after the current page be-
ing viewed. In the display window, the current page being viewed 
has a red border. From the arrow to the right of the button, a drop-
down menu allows the user to specify Insert Before Current Page 
or Insert After Current Page. 

Delete Page: Deletes the current page. If the report is a single 
page, the page cannot be deleted.

Print: Prints the report. 

Batch Print Reports: Open the batch print reports dialog. Refer to 
Section 7.6.

Print Preview: Displays a print preview of the report. 

PDF: Generates a PDF file of the report.

Insert Text: Inserts a textbox. The user can edit and format the text. 
Text types include: text, sample name, specimen name, operator, 
run time, cytometer, and software. In addition, specimen reports 
contain specimen information text type.

Insert Plot: Click the icon to list the plots for the sample, including 
dot plots, density plots, histogram plots, contour plots, and cell 
cycle plots. Select the plot to insert. The plot is inserted with the 
statistics as shown below.

 

uuu
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Icon Description

Insert Sample Statistics: Inserts a table of gate statistics for a sam-
ple. In a sample report, click the button to insert a gate statistics 
table for the sample. In a specimen report, click the button and 
select a sample from the dropdown menu to insert a gate statistics 
table for the selected sample.

Insert Compensation: Inserts a spillover matrix. In a sample report, 
click the button to insert the spillover matrix for the sample. In a 
specimen report, click the button and select a sample from the 
dropdown menu to insert the spillover matrix for the selected sam-
ple. The spillover matrix cannot be edited from within the report. If 
the spillover matrix is modified in the main interface, the matrix in 
the report window will update.

Insert Photodetector Gain:  Inserts a table of photodetector gain 
setting for a sample. In a sample report, click the button to insert a 
table of photodetector gain setting  for the sample. In a specimen 
report, click the button and select a sample from the dropdown 
menu to insert a table of photodetector gain setting  for the se-
lected sample.

Insert Shape: Click to insert a horizontal line, vertical line, or rect-
angle.

Insert Picture: Click open the Open window, select a picture to in-
sert. The picture will be resized to an appropriate size with the 
original aspect ratio and inserted in the report.

Select: The default is Select All. From the arrow on the right of the 
button, Select Similar Objects is also available.

Page Rotation: Switches the page layout orientation between por-
trait and landscape.

Zoom: Sets the zoom percentage of the displayed page. When re-
port displays is zoomed in or zoomed out (zoom percentage is 
not 100%), user cannot double-click report item to enter into edit 
mode.

Align: Select two or more objects in a page to activate these fea-
tures. When selecting multiple objects, the first object has white 
squares on the border, while additional objects have black squares. 
From the four alignment options (align top, left, bottom, or right), 
select the edge to be aligned. The objects will be moved so that 
the selected edge of all selected objects aligns with the object first 
selected. 

Lock Position: Check this item to forbid moving any object of the 
report. Align Top, Align Left, Align Bottom, Align Right buttons will 
be disabled when Lock Position is checked. 

Make Same Size / Width / Height: Select two or more objects in a 
page to activate these features. When selecting multiple objects, 
the first object has white squares on the border, while additional 
objects will have black squares. From the three resize options 
(make same size, width, or height), select the desired resize di-
mension. The selected objects will be resized to match the selected 
dimension of the object first selected. 

uuu
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Icon Description

Previous: In a sample report, click to switch to the previous sam-
ple’s report. In a specimen report, click to switch to the previous 
specimen’s report.

Next: In a sample report, click to switch to the next sample’s report. 
In a specimen report, click to switch to the next specimen’s report.

Select: Select to view or edit another report.

Set Page Header and Footer: Click to show header and footer edit-
ing interface.

Page: 1/3 Page: Displays the current page and the total number of pages.

n

7.2	 Automatically Generate Reports

The report can be generated through an automated or a manual mode. In the automated 
mode, the user performs the analysis and creates the plots in the main software interface. 
The report will be automatically created with the plots and statistical information added 
without the need for additional input from the user. The user is not able to add, delete, or 
modify the contents of the report in this mode.

To switch the mode from manual to automated, click on the Auto Report Mode button 
in the toolbar  . The prompt below will appear to confirm the switch to the automated 
mode. Click OK, to automatically generate the report.

To switch the mode from automated to manual, click on Auto Report Mode button in the 
toolbar  . The user can now make modifications to the report.

 �When creating a report, it may be best to use the automated mode to generate an initial 
report and then switch to manual mode to modify the report.

7.3	 Report Options

Report Options dialog provides user interface for user to customize report of auto and 
manual mode. To open Report Options dialog, click the Report Options button  in the 
report window toolbar. The Report Options dialog is shown below:
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The settings in Plot Options panel are used for customizing plots inside report. They are 
effective for both auto and manual report mode.

►► Show Gate Name in Gate Label: 

If selected, gate name is displayed in gate label on the plot.

►► Show Population Percentile in Gate Label: 

If selected, gate label is displayed with the percentage of the population within the 
gate.

►► Plot Title Options: 

If clicked, a drop down menu will show as below.

zz Show Plot Title: 

If selected, plot title is displayed on the report plot.

zz Sample Name:

If selected, the sample name is displayed in the report plot title.
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zz Specimen Name:

If selected, the specimen name is displayed in the report plot title.

zz Gating Name:

If selected, the gating name is displayed in the report plot title.

zz Gating Hierarchy:

If selected, the gating hierarchy is displayed in the report plot title.

The settings in Auto Report Mode Options panel are used for customizing auto report. 
They are only effective for auto report mode.

►► Number of Plots per Row: 

Sets how many plots are shown in one row.

►► Plot Statistics: 

If selected, shows gate statistics of plot.

►► Sample Statistics: 

If selected, shows gate statistics of sample.

►► Compensation: 

If selected, shows compensation matrix.

►► Photodetector Gain: 

If selected, shows the photodetector gain setting.

►► Insert Page Break Before Each Sample: 

Only available for specimen report. If selected, a page break will be inserted before 
each sample.

►► Show Statistics Columns: 

Selects statistical items to display.

►► Select Plots: 

Selects plots to display on report.

►► Select All: 

Selects all plots to display on report.

►► Set as Default: 

Sets above settings as default setting for new reports.

►► Apply to All: 

Applies above settings to all report in the experiment.

7.4	 Report Editor

In the manual mode, the user is able to freely edit the report. Options include adding, 
removing, and editing objects in the report



174

77

Reports

Report Editor

7.4.1	 Add Report Objects

Objects can be added to the report through the toolbar, Work Space, and Experiment Man-
ager panel. To add objects using the toolbar, use the insert functions described in Section 
7.1 Report Interface. From both the Work Space and Experiment Manager panel, objects 
corresponding to the sample can be dragged and dropped into the report.

7.4.2	 Select Report Objects

Click on an object to select it in the report. An object can have one of two selected states. 
After clicking on an object, the object will be highlighted. In this state, the object is bor-
dered by a black dashed line with white control points. If the object is then double-clicked, 
it is in the edit state, and the object is bordered by a red dashed line with black control 
points. Different operations can be performed on the object depending on the selected 
state. The two states are shown below.

This is the object after being selected:

This is the object selecting and in the editing state:

To have multiple objects selected simultaneously:

►► �In the toolbar, click the Select All button  , to select all of the objects in the report.
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►► �Left-click and drag in the report to enclose objects inside of the dashed rectangle. Ob-
jects within the dashed rectangle will be selected when the mouse button is released.

►► �Select an initial object. In the toolbar, click Select All, then Select Similar Objects. All 
objects in the report of the same type as the initial object will be selected.

►► �Select an object. Press and hold the Ctrl key to select additional items.

When multiple items are selected, the first item is bordered by a black dashed line with 
white control points and additional items are bordered by black dashed lines with black 
control points.

7.4.3	 Edit Report Objects

Double-click on a selected object or right-click on the object and select Edit to enter the 
editing mode for that object. This section will describe the editing options available for 
the objects.

7.4.3.1	 Edit Text

Double-click on the textbox or right-click on the textbox and select Edit to enter editing 
mode. In this mode, text formatting tools will appear. Right-click on the textbox and select 
Insert to insert sample information including sample name, specimen ID, specimen name, 
operator, run time, cytometer and software information, as shown below. This can also be 
accessed by clicking the Insert Text  icon’s drop-down menu in the tool bar.

7.4.3.2	 Edit Plots and Statistics

Double-click on the plot or right-click on the plot and select Edit to enter editing mode. 
Plots can be edited in the report by right-clicking in the plot to access the plot tools. 
Modifications made to the plot will also be updated to the plot in the main interface. In 
addition, if the plots are modified in the main interface, the plots in the report will also 
update automatically. 

Double-click on the statistics box or right-click on the statistics box and select Edit to 
enter editing mode. Right-click in the selected statistics box to choose the columns to 
display, as shown below.
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7.4.3.3	 Edit Shapes

Double-click on an inserted shape (horizontal lines, vertical lines, or rectangles) or right-
click on the shape object and select Edit to ender editing mode. A Shape Properties win-
dow will appear. In the window, line width, style, and color can be set.

7.4.3.4	 Edit Pictures

Double-click on the picture or right-click on the picture and select Edit to enter editing 
mode. The Open window will appear, and users can select an image to replace the current 
picture.
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7.4.4	 Aligning Report Project Items

There are multiple methods to align objects in a report.

►► �Use the mouse to drag an object within the report. As the object is dragged, smart 
guides appear when the object is aligned with other objects in the report. Drag the 
object until it is aligned with the appropriate other objects, and release the mouse but-
ton to set the object at the new location.

►► �Select the object and use the ↑, ↓, ←, → keys on the keyboard to move the object. 
Move the object until the object appears to be aligned with the appropriate other 
objects.

►► �Select multiple objects. Select the appropriate align tool from the toolbar depending 
on the edge of the object to be aligned (Align Top ; Align Left ; Align Bottom 
; Align Right ). The objects will be aligned along the selected edge relative to the 
position of the first selected object. (The first selected object will be displayed with 
white control points, while other selected objects will be displayed with black control 
points.)

7.4.5	 Resizing Objects

There are two methods to resize objects in a report:

►► �Select an object. Click and drag on the control points of the object to resize the object.

►► �Select multiple objects. Select the tool to Make Same Size, Make Same Width, or Make 
Same Height. The objects will be resized to match the appropriate dimensions of the 
first selected object. (The first selected object is displayed with white control points, 
while other selected objects are displayed with black control points.)

7.4.6	 Ordering Object Levels

When objects are overlapped in the report, the object that is displayed is determined by 
the ordering of the object. To change the ordering of an object, select the object. Right-
click on the object and select Ordering. Options then include Bring to Front, Bring For-
ward, Send Backward, and Send to Back. Select the appropriate movement for the object. 
Objects toward the front are displayed over objects further back.

7.4.7	 Cut, Copy, Paste, and Delete

►► �Cut: Select an object. Use the keyboard shortcut Ctrl+X or right-click and select Cut 
to cut an object.

►► �Copy: Select an object. Use the keyboard shortcut Ctrl+C or right-click and select 
Copy to copy an object. The copied object can be pasted to the office software such as 
Word, Powerpoint, and Excel.

►► �Paste: After cutting or copying an object, the object can be paste from the clipboard 
using the keyboard shortcut Ctrl+V or right-click and select Paste. The object will be 
pasted at the specified location.

►► �Delete: Select an object. Use the keyboard Delete key or right-click and select Delete 
to delete an object.
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7.4.8	 Insert or Delete Pages

To insert or delete pages, use the Insert Page and Delete Page button from the toolbar. For 
more information, see Section 7.1 Report Interface.

7.4.9	 Header and Footers

7.4.9.1	 Headers and Footers Working Interface

The header and footer displays information at the top and bottom of the pages, respec-
tively, in the report. To edit the header and footer, click the Set Page Header and Footer 
button  , from the toolbar. As shown below, the rectangular region at the top and bottom 
of the page for the header and footer is outlined. A toolbar containing functions to edit 
the header and footer is also available. At this time, the header and footer can be edited.

Toolbar for Header and Footer Functions:

Icon Description

Insert Text: Inserts a textbox. 

Insert Page Number: Inserts page numbers. Select between two styles: 1,2,3 
... or 1/3, 2/3 ....

Insert Shape: Inserts a horizontal line, vertical line, or rectangle. 

uuu
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Icon Description

Insert Picture: Inserts a picture. 

Set Page Header and Footer: Click to exit header and footer editing mode.

n

7.4.9.2	 Edit Headers and Footers

To edit the header, click in the header region at the top of the page. Once selected, the 
region is bordered by a red rectangle. The toolbar can now be used to add objects to the 
header.

To edit the footer, click in the footer region at the bottom of the page. After selected, the 
region is bordered by a red rectangle. The toolbar can now be used to add objects to the 
footer. The default footer includes an object for page number.

The methods for editing the header and footer are consistent with the rest of the report 
interface with the following exceptions.

►► �The level of the objects in the header and footer cannot be ordered. Newer created ob-
jects are automatically created more towards the top. Objects in the header and footer 
are behind objects created in the main report interface.

►► �Smart guides are not available to help align objects in the header and footer.

►► �Copying and pasting objects is unavailable in the header and footer.

►► �Variables such as sample name, specimen ID. Specimen name, operator, run time, and 
cytometer and software information cannot be inserted into textboxes in the header 
or footer.

After editing the header and footer is complete, click the Set Page Header and Footer but-
ton  , to return to the main report interface. The header and footer will display on all 
pages of the report.

7.4.9.3	 Copy the Header and Footer Settings to Other Reports

To transfer the header and footer from one report to another, copy and paste the report as 
a template as described in Section 6.3 Templates.

7.5	 Report Output

The reports can be printed or converted to a PDF file.

►► To Print:

Click the toolbar Print button  . Alternatively, right-click the report node in the 
Experiment Manager panel and select Print. The print window will appear. Select the 
correct printer and print the report.

►► To Convert to PDF:

Click the toolbar PDF button  . The Save As window will appear to save the report 
as a PDF file.
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7.6	 Batch Print Reports

To batch print reports:

In the main interface window, click the Batch Print Reports button in the Home tab of the 
Menu bar. Alternatively, select File → Print → Batch Print Reports. The Batch Print Reports 
window will appear.

The reports are listed on the left side of the Batch Print Reports window. Use the check-
boxes to select the reports to be printed. On the right side of the window, select either to 
print the report or generate PDF files for the report. 

If printing, select a printer and click Print. 

If generating a PDF, select a file path to save the PDF files. If the Specimen name box is 
checked, the PDF files will be saved in the format specimen name_sample name_YYYYM-
MDD_hhmmss. If the box is unchecked, the PDF files will be saved in the format sample 
name_YYYYMMDD_hhmmss. Click Print to begin generating the PDF files.

 �One PDF file will be created for each report selected by default. If Merge reports in 
the same specimen/group/experiment is checked, all reports of one specimen/group/
experiment will be printed into one PDF file.

After clicking Print a progress bar will appear as shown below.
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During the printing process, click Cancel to stop the printing.
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8.	 QC Test

Quality control (QC) test is an essential part of the maintenance of the NovoCyte and 
NovoCyte Quanteon  system. In QC test, NovoCyte QC particles are used to check the 
instrument performance. Measured data are used to determine if the performance of 
NovoCyte or NovoCyte Quanteon system fall into the standard range to ensure stable 
and reliable operation of the instrument. This section covers running the QC test and 
reviewing the QC test report.

8.1	 Run the QC Test for NovoCyte Instrument

To run the QC test:

1 Save the NovoCyte QC particles Lot file.

Download the Lot File for the specific batch of NovoCyte QC particles from http://www.
aceabio.com/novocyte/qc-particles. Save the Lot File in a specific directory in the Novo-
Express Software’s installation directory. (Save the file in C:\Program Files (x86)\NovoEx-
press\QC \QC Beads, if the installation directory is C:\Program Files (x86)\NovoExpress). 
Saving the Lot file is only done once for each new batch of NovoCyte QC particles. After 
saving the Lot File to the directory, the lot ID for the specific batch will be listed when 
running the QC test.

2 Prepare the QC particles by diluting the beads with dilution buffer. 

First thoroughly mix the NovoCyte QC particles. In a test tube, add 2 drops of NovoCyte 
QC Particles (Generation 2, Cat. # 8000004) to 1 mL of dilution buffer (0.8 mL PBS and 0.2 
mL ACEA NovoRinse solution). Vortex the microsphere suspension. Place the prepared 
QC particles sample in the sample holder of the instrument.

3 In the NovoExpress Software, click the QC Test button in the Instrument tab of the Menu 
Bar to open the QC Test window. The window is shown below.

QC Test: Step 1 Fill in Test Information

In the window, enter the name of the operator, select the QC particles lot ID, and click 
Next. If the correct QC particles lot ID is not listed, please refer to the first step to down-
load and save the QC particles Lot File.

uuu
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4 Click Run to begin the test. The instrument will begin collecting events and the results 
will be displayed in real-time on the QC Test window.

QC Test: Step 2 Run QC Test

5 After data collection is complete, click the Report button to view the test results.

QC Test: Step 3 Test Report

From the figure, the QC test will provide results for various parameters. Click Print to print 
the test report.

 �To view the history of the resulting QC data, click QC Test Report from the Instrument 
tab of the Menu Bar (described in Section 8.3). Highlight the date to be viewed and select 
the QC Test Report tab.

The QC test provides a result for each tested parameter. There are three possible results.

►► �Pass: The parameter meets performance requirements.

►► �Failed: The parameter does not meet the performance requirements.

►► �Acceptable: The parameter does not meet the factory calibration requirements, but 
the use of the instrument does not affect experimental results.

The QC test provides a result of the test, Pass or Failed or Acceptable. If failed, a label in 
red will show on report to indicate the reason of failure.

n
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8.2	 Run the QC Test for NovoCyte Quanteon Instrument

To run the QC test:

1 Save the NovoCyte QC particles Lot file.

Download the Lot File for the specific batch of NovoCyte QC particles from http://www.
aceabio.com/novocyte/qc-particles. Save the Lot File in a specific directory in the Novo-
Express Software’s installation directory. (Save the file in C:\Program Files (x86)\NovoEx-
press\QC \QC Beads, if the installation directory is C:\Program Files (x86)\NovoExpress). 
Saving the Lot file is only done once for each new batch of NovoCyte QC particles. After 
saving the Lot File to the directory, the lot ID for the specific batch will be listed when 
running the QC test.

2 Prepare the QC particles by diluting the beads with dilution buffer. 

First thoroughly mix the NovoCyte QC particles. In a test tube, add 2 drops of NovoCyte 
QC Particles (Generation 2, Cat. # 8000004) to 1 mL of dilution buffer (0.8 mL PBS and 0.2 
mL ACEA NovoRinse solution). Vortex the microsphere suspension. Place the prepared 
QC particles sample in the sample holder of the instrument.

3 In the NovoExpress Software, click the QC Test button in the Instrument tab of the Menu 
Bar to open the QC Test window. The window is shown below.

QC Test: Step 1 Fill in Test Information

In the window, enter the name of the operator, select the QC particles lot ID, and click 
Next. If the correct QC particles lot ID is not listed, please refer to the first step to down-
load and save the QC particles Lot File.

uuu
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4 Click Run to begin the test. The instrument will begin collecting electronic noise, optical 
noise and  events, the results will be displayed in real-time on the QC Test window.

QC Test: Step 2 Collect Electronic Noise

QC Test: Step 2 Collect Optical Noise

QC Test: Step 2 Collect Events

uuu
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5 After data collection is complete, click the Report button to view the test results.

QC Test: Step 3 Test Report

The QC Test Report will provide results for various parameters. Click Print to print the test 
report. Click Open Data File to open the QC file.

 �To view the history of the resulting QC data, click QC Test Report from the Instrument 
tab of the Menu Bar (described in Section 8.3). Highlight the date to be viewed and select 
the QC Test Report tab.

The QC test provides a result for each tested parameter. There are three possible results.

►► �Pass: The parameter meets performance requirements.

►► �Failed: The parameter does not meet the performance requirements.

►► �Acceptable: The parameter does not meet the factory calibration requirements, but 
the use of the instrument does not affect experimental results.

The QC test provides a result of the test, Pass or Failed or Acceptable. If failed, a text in 
red will show on report to indicate the reason of failure.

n
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8.3	 View QC Test Report

The QC test report function stores previous QC test results and provides a data analysis 
feature to track instrument performance changes over a period time. To open the QC 
Test Report window, click QC Test Report from the Instrument tab of the Menu Bar. The 
window is shown below.

The QC Test Report window contains the following sections.

Interface Description

Title Area Displays the report name and the Print button. Click the Print button to 
print the currently displayed QC Test Report or Levey-Jennings Report 
page.

Query Area Query a time interval for QC test reports. As shown:

uuu
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Interface Description

QC Test Report Displays the QC test report for a selected report from the query results. 
As shown:

Levey-Jennings 
Report 

Displays the QC test data over time to observe trends in instrument per-
formance. As shown:

Open Data File Open the QC data file of the selected report.

Print Click the Print button in the top right corner of the window to print QC 
test reports or Levey-Jennings reports.

n
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9.	 Troubleshooting

9.1	 Troubleshooting for NovoCyte Instrument

The following table lists possible causes for warning and error prompts from the status bar when 
connecting with NovoCyte instrument.

Message ID Software Messages Possible Causes Recommended Solutions 

0x0001 Collision of SIP The movement of 
the SIP is blocked 
by some obstacles

Locate and clear the obstacles. 
Click the OK button in the 
prompted dialog box or wait 10 
seconds for automatic error han-
dling. The instrument will move 
the SIP to the home position. 
This procedure will take about 3 
minutes. 

Incorrect plate 
selected in plate 
manager

Select the correct plate in the 
plate manager window.

Incorrect positioning 
of plate in No-
voSampler Pro

►► Position the plate on the 
shaker correctly. Ensure the 
plate is seated flat on the 
stage inside the clamps.

►► Re-calibrate NovoSampler 
Pro. 

Dirty SIP or SIP 
wash apparatus

Clean the SIP or SIP wash ap-
paratus following the procedures 
described in Section 1.1 Preven-
tative Maintenance in NovoCyte® 
Maintenance Guide.

0x0002 Running out of NovoFlow NovoFlow solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoFlow container 
following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide.

Fluidic station is not 
working properly

Replace the fluidic station.

0x0003 Running out of Novo-
Rinse 

NovoRinse solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoRinse con-
tainer following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide. 

Fluidic station is not 
working properly

Replace the fluidic station.

uuu
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Message ID Software Messages Possible Causes Recommended Solutions 

0x0004 Running out of Novo-
Clean

NovoClean solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoClean con-
tainer following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide.

Fluidic station is not 
working properly

Replace the fluidic station.

0x0005 Waste container is full Waste container is 
too full to continue 
to run any samples

Empty the waste container fol-
lowing the procedures described 
in Section 2.1.3 Empty Waste 
in NovoCyte® Flow Cytometer 
Operator’s Guide.

Fluidic station is not 
working properly

Replace the fluidic station.

0x0006 System voltage is out of 
range

System Error Restart the NovoCyte instrument.

0x0007 System electric current is 
out of range

System Error Restart the NovoCyte instrument.

0x0008 Firmware configuration 
error

System Error Restart the NovoCyte instrument. 

0x0009 
0x000A
0x000B

…… laser self test error Specified laser is not 
functioning properly

The instrument will automatically 
reset the laser and run a laser 
self-test. It takes approximately 5 
to 10 minutes. 

0x000C 
0x000D
0x000E

…… laser is not con-
nected

Specified laser is not 
detected

Restart the NovoCyte instrument. 

0x000F NovoSampler communi-
cation lost

The cable between 
the NovoSampler 
(Pro) and NovoCyte 
Flow Cytometer is 
not securely con-
nected

Reconnect the cable between 
the NovoSampler (Pro) and 
NovoCyte Flow Cytometer. 

NovoSampler (Pro) 
is not communicat-
ing with NovoCyte

Restart NovoCyte instrument. 

0x0010 NovoSampler (Pro) has 
not been calibrated

NovoSampler (Pro) 
is newly installed or 
re-connected.

Follow the prompted instructions 
to calibrate the NovoSampler 
(Pro).
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0x0011 NovoSampler (Pro) cali-
bration failed……

NovoSampler (Pro) 
is not installed 
properly

Re-install and calibrate the 
NovoSampler (Pro) following the 
procedures described in Section 
1.2 Installation in NovoSampler® 
Operator’s Guide or NovoSam-
pler® Pro Operator’s Guide.

The NovoSampler 
(Pro) cover was 
opened during cali-
bration.

Close the NovoSampler (Pro) 
cover and redo the calibration.

0x0012 The movement of plate is 
out of range

The movement of 
the orbital shaker is 
blocked.

►► Check the path of the orbital 
shaker to make sure there 
are no objects blocking the 
movement. Clear the block if 
there is any. 

►► Click Instrument → No-
voSampler Pro → Calibrate 
in NovoExpress Software to 
re-calibrate the NovoSam-
pler (Pro).

NovoSampler (Pro) 
is not installed 
properly

Re-install and calibrate the 
NovoSampler (Pro) following the 
procedures described in Section 
1.2 Installation in NovoSampler® 
Operator’s Guide or NovoSam-
pler® Pro Operator’s Guide.

0x0013 Cover of NovoSampler 
(Pro) is opened during 
moving plate

The cover of No-
voSampler (Pro) is 
open during moving 
plate

Close the NovoSampler (Pro) 
cover. NovoSampler (Pro) will 
automatically reset and be ready 
for operation.

0x0014 Pressure is out of limit Waste container 
is not correctly 
connected to the 
instrument

Check the quick coupling con-
nectors to ensure the waste 
container is correctly connected 
to the instrument.

Sheath in-line filter 
is clogged 

Replace the sheath in-line filter 
following the procedures de-
scribed in Section 1.2 Replacing 
Fluidic System Consumables in 
NovoCyte® Maintenance Guide.

Flow cell is clogged Conduct Unclog from NovoEx-
press.

0x0015 NovoSampler firmware 
error

NovoSampler or 
NovoSampler Pro 
firmware is not 
working properly 

Re-install or upgrade the No-
voSampler or NovoSampler Pro 
firmware.

0x0016 
0x0017 
0x0018

…… laser does not emit Specified laser is not 
connected properly 
or laser is not work-
ing properly

►► Reconnect the laser cable 
properly.

►► Restart the instrument.
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0x0019 
0x001A 
0x001B

…… laser communica-
tion error

Interference or bad 
connection or bad 
laser

►► Reconnect the laser cable 
properly.

►► Restart the instrument.

0x001C Sample injection probe 
reset failed

Bad connection or 
optocoupler dam-
aged

Click the OK button in the 
prompted dialog box or wait 10 
seconds for automatically error 
handling. Restart the instrument. 

0x001D Sampling Pump reset 
failed

Bad connection or 
optocoupler dam-
aged

Restart the instrument. 

0x001E The SIP module needs to 
be upgraded to support 
NovoSampler Pro

SIP module is not 
compatible with 
connected No-
voSampler Pro

Contact ACEA technical support 
for service.

0x0020 System initialization is 
paused

Liquid level in the 
reagent containers 
is not within normal 
range when Novo-
Cyte is powered up.

►► Make sure that the instru-
ment reagent containers 
are placed correctly and 
the liquid level in each of 
the containers is within the 
normal range.

►► Click OK on the prompted 
dialog to continue system 
initialization.

0x0021 Sheath fluid pump reset 
failed

Bad connection or 
optocoupler dam-
aged

Restart the instrument.

0x0022 Resetting NovoSampler 
Pro to zero position 
failed

NovoSampler Pro 
is not working 
properly.

Click Reset. Restart the No-
voSampler Pro.

0x0023 Resetting NovoSampler 
Pro to home position 
failed

NovoSampler Pro is 
not working prop-
erly.

Click Reset. Restart the No-
voSampler Pro.

0x0100 Instrument cover opened Instrument cover is 
open or not tightly 
closed

Close the instrument cover.

0x0101 NovoFlow running low NovoFlow solution 
is below the pre-set 
volume limit

Refill the NovoFlow container 
following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide.

Fluidic station not 
working properly

Replace the fluidic station.
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0x0102 NovoRinse running low NovoRinse solution 
is below the pre-set 
volume limit

Refill the NovoRinse con-
tainer following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide.

Fluidic station not 
working properly

Replace fluidic station.

0x0103 NovoClean running low NovoClean solution 
is below the pre-set 
volume limit

Refill the NovoClean con-
tainer following the procedures 
described in Section 2.1.2 Add 
Instrument Reagents in Novo-
Cyte® Flow Cytometer Operator’s 
Guide.

Fluidic station not 
working properly

Replace fluidic station.

0x0104 Waste container is close 
to full

Waste is above the 
pre-set volume limit 

Empty the waste container fol-
lowing the procedures described 
in Section 2.1.3 Empty Waste 
in NovoCyte® Flow Cytometer 
Operator’s Guide.

Fluidic station not 
working properly

Replace fluidic station.

0x0105 Cover of NovoSampler 
(Pro) opened 

Cover of NovoSam-
pler (Pro) is opened

Close the cover.

0x0106 NovoSampler (Pro) is 
disconnected when 
powered up

The NovoSampler 
(Pro) is disconnect-
ed when powered 
up

►► Shut down NovoCyte Flow 
Cytometer. 

►► Reconnect the cable of the 
NovoSampler (Pro) to Novo-
Cyte flow cytometer. 

►► Turn on NovoCyte and follow 
the prompts to calibrate the 
NovoSampler (Pro).

0x0109 Fluidics station is not 
connected

Cable between the 
fluidics station and 
the NovoCyte instru-
ment is not properly 
connected 

►► Power down the instrument. 

►► Reconnect the cable bet-
ween the fluidics station and 
the NovoCyte instrument. 

►► Power up the instrument.

0x010A 
0x010B 
0x010C 
0x010D

…… liquid level sensor 
failure

Specified liquid level 
sensor in the fluidics 
station is not work-
ing properly 

►► Reconnect the fluidics stati-
on cable. 

►► Restart the NovoCyte instru-
ment. 

►► Replace the fluidics station.

0x010F Sheath filter is clogged. 
Please replace the 
sheath filter and run the 
Priming procedure

Sheath in-line filter 
is clogged 

Replace the sheath in-line filter 
following the procedures de-
scribed in Section 1.2 Replacing 
Fluidic System Consumables in 
NovoCyte® Maintenance Guide.
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0x0110 Recovering collision error Plate stops at an 
incorrect position

No action is needed. Instrument 
will automatically recover the 
error.

0x0111 Orbital shaker homing 
position reset failure

Orbital shaker of 
NovoSampler Pro is 
not working properly

No action is needed. The 
NovoSampler Pro can be used 
normally.

Communication error 
(code: xx, xx). Please 
restart NovoCyte and 
NovoExpress

USB cable between 
the NovoCyte instru-
ment and worksta-
tion is not connect-
ed properly

►► Reconnect the USB cable 
between the NovoCyte 
instrument and the worksta-
tion. 

►► Restart the instrument and 
NovoExpress software.

n

9.2	 Troubleshooting for NovoCyte Quanteon Instrument

The following table lists possible causes for warning and error prompts from the status bar when 
connecting with NovoCyte Quanteon instrument.

Message ID Software Messages Possible Causes Recommended Solutions 

0x0001 Collision of SIP The movement of 
the SIP is blocked by 
some obstacles

Locate and clear the obstacles. 
The instrument will automatically 
start error handling and move the 
SIP to the home position. This 
procedure will take about 10 sec-
onds. 

Incorrect plate se-
lected in plate man-
ager

Select the correct plate in the 
plate manager window.

Incorrect positioning 
of plate in NovoSam-
pler Q

►► Position the plate on the sha-
ker correctly. Ensure the plate 
is seated flat on the stage in-
side the clamps.

►► Re-calibrate NovoSampler Q. 

Dirty SIP or SIP 
Cleaning  apparatus

Clean the SIP or SIP wash ap-
paratus following the procedures 
described in Section 1.1 Preven-
tative Maintenance in NovoCyte 
QuanteonTM Maintenance Guide.

0x0002 Running out of NovoFlow NovoFlow solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoFlow container fol-
lowing the procedures described 
in Section 2.1.2 Add Instrument 
Reagents in NovoCyte QuanteonTM 
Flow Cytometer Operator’s Guide.

Fluidic station is not 
working properly

Replace the fluidic station.
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0x0003 Running out of Novo-
Rinse 

NovoRinse solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoRinse container 
following the procedures de-
scribed in Section 2.1.2 Add In-
strument Reagents in NovoCyte 
QuanteonTM Flow Cytometer Op-
erator’s Guide. 

Fluidic station is not 
working properly

Replace the fluidic station.

0x0004 Running out of Novo-
Clean

NovoClean solution 
is not sufficient to 
continue to run any 
samples 

Refill the NovoClean container 
following the procedures de-
scribed in Section 2.1.2 Add In-
strument Reagents in NovoCyte 
QuanteonTM Flow Cytometer Op-
erator’s Guide.

Fluidic station is not 
working properly

Replace the fluidic station.

0x0005 Waste container is full Waste container is 
too full to continue 
to run any samples

Empty the waste container fol-
lowing the procedures described 
in Section 2.1.3 Empty Waste in 
NovoCyte QuanteonTM Flow Cy-
tometer Operator’s Guide.

Fluidic station is not 
working properly

Replace the fluidic station.

0x0006 System voltage is out of 
range

System Error Restart the NovoCyte Quanteon 
instrument.

0x0007 System electric current is 
out of range

System Error Restart the NovoCyte Quanteon 
instrument.

0x0008 Firmware configuration 
error

System Error Restart the NovoCyte Quanteon 
instrument. 

0x0009 
0x000A
0x000B
0x4009

…… laser self test error Specified laser is not 
functioning properly

The instrument will automatically 
reset the laser and run a laser 
self-test. It takes approximately 5 
to 10 minutes. 

0x000C 
0x000D
0x000E
0x400A

….laser is not connected Specified laser is not 
detected

Restart the NovoCyte Quanteon 
instrument. 

0x000F NovoSampler communi-
cation lost

The cable between 
the NovoSampler Q 
and NovoCyte Quan-
teon Flow Cytometer 
is not securely con-
nected

Reconnect the cable between the 
NovoSampler Q and NovoCyte 
Quanteon Flow Cytometer. 

NovoSampler Q is 
not communicat-
ing with NovoCyte 
Quanteon

Restart NovoCyte Quanteon in-
strument. 
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0x0010 NovoSampler has not 
been calibrated

NovoSampler Q is 
newly installed or re-
connected.

Follow the prompted instructions 
to calibrate the NovoSampler Q.

0x0011 NovoSampler Q calibra-
tion failed……

NovoSampler Q is 
not installed prop-
erly

Re-install and calibrate the No-
voSampler Q following the pro-
cedures described in Section 1.2 
Installation in NovoSampler® Q 
Operator’s Guide.

The NovoSampler Q 
cover is opened dur-
ing calibration.

Close the NovoSampler Q cover 
and redo the calibration.

The optocoupler of 
NovoSampler Q is 
not working properly

Restart NovoCyte Quanteon in-
strument and redo the calibra-
tion.

The motor of No-
voSampler Q is not 
working properly.

Restart NovoCyte Quanteon in-
strument and redo the calibra-
tion.

0x0012 The movement of plate is 
out of range

The movement of 
the orbital shaker is 
blocked.

►► Check the path of the orbital 
shaker to make sure there 
are no objects blocking the 
movement. Clear the block if 
there is any. 

►► Click Instrument → No-
voSampler Pro → Calibrate in 
NovoExpress Software to re-
calibrate the NovoSampler Q.

NovoSampler Q is 
not installed prop-
erly

Re-install and calibrate the No-
voSampler Q following the pro-
cedures described in Section 1.2 
Installation in NovoSampler® Q 
Operator’s Guide.

0x0013 Cover of NovoSampler 
is opened during moving 
plate

The cover of Novo 
Sampler Q is opened 
during moving plate

Close the NovoSampler Q cover. 
NovoSampler Q will automatically 
reset and be ready for operation.

0x0014 Pressure is out of limit ►► Sample injection 
probe or flow cell 
is clogged

►► Sheath fluid 
in-line filter is 
clogged

►► Waste container 
is not correctly 
connected to the 
instrument 

►► Other fluidic 
components 
are not working 
properly

Follow the prompted instructions 
from NovoExpress to clear the er-
ror.  
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0x0015 NovoSampler firmware 
error

NovoSampler Q firm-
ware is not working 
properly 

Re-install or upgrade the No-
voSampler Q firmware.

0x0016 
0x0017 
0x0018
0x400B

…… laser does not emit Specified laser is not 
connected properly 
or laser is not work-
ing properly

►► Turn off the instrument. 

►► Reconnect the laser cable 
properly.

►► Restart the instrument.

0x0019 
0x001A 
0x001B
0x400C

…… laser communica-
tion error

Specified laser is 
not  communicating 
with the  instrument 
properly or the laser 
is not working prop-
erly

►► Turn off the instrument. 

►► Reconnect the laser cable 
properly.

►► Restart the instrument.

0x001C Sample injection probe 
reset failed

Bad connection or 
optocoupler is not 
working properly

►► Click the OK button in the 
prompted dialog box or wait 
10 seconds for the instrument 
to automatically start the er-
ror handling. 

►► Restart the instrument. 

0x001D Sampling Pump reset 
failed

Bad connection or 
optocoupler is not 
working properly 

Restart the instrument. 

0x0020 System initialization is 
paused

Liquid level in the 
reagent containers 
is not within normal 
range when Novo-
Cyte Quanteon is 
powered up.

►► Make sure that the instru-
ment reagent containers are 
placed correctly and the li-
quid level in the containers is 
within the normal range.

►► Click OK on the prompted di-
alog to continue system initi-
alization.

0x0021 Sheath fluid pump reset 
failed

Bad connection or 
optocoupler is not 
working properly

Restart the instrument.

0x0023 Resetting NovoSampler 
to home position failed

NovoSampler Q is 
not working prop-
erly.

Click Reset. Restart the No-
voSampler Q.

0x0100 Instrument cover opened Instrument cover is 
opened or not tightly 
closed

Close the instrument cover.

0x0101 NovoFlow running low NovoFlow solution 
is below the pre-set 
volume limit

Refill the NovoFlow container fol-
lowing the procedures described 
in Section 2.1.2 Add Instrument 
Reagents in NovoCyte QuanteonTM 
Flow Cytometer Operator’s Guide.

Fluidic station is not 
working properly

Replace the fluidic station.
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0x0102 NovoRinse running low NovoRinse solution 
is below the pre-set 
volume limit

Refill the NovoRinse container 
following the procedures de-
scribed in Section 2.1.2 Add In-
strument Reagents in NovoCyte 
QuanteonTM Flow Cytometer Op-
erator’s Guide.

Fluidic station is not 
working properly

Replace fluidic station.

0x0103 NovoClean running low NovoClean solution 
is below the pre-set 
volume limit

Refill the NovoClean container 
following the procedures de-
scribed in Section 2.1.2 Add In-
strument Reagents in NovoCyte 
QuanteonTM Flow Cytometer Op-
erator’s Guide.

Fluidic station is not 
working properly

Replace fluidic station.

0x0104 Waste container is close 
to full

Waste is above the 
pre-set volume limit 

Empty the waste container fol-
lowing the procedures described 
in Section 2.1.3 Empty Waste in 
NovoCyte QuanteonTM Flow Cy-
tometer Operator’s Guide.

Fluidic station is not 
working properly

Replace fluidic station.

0x0105 Cover of NovoSampler is 
opened 

Cover of NovoSam-
pler Q is opened

Close the cover.

0x0106 NovoSampler is discon-
nected when powered 
up

The NovoSampler 
Q is disconnected 
when powered up

►► Shut down NovoCyte Flow 
Cytometer. 

►► Reconnect the cable of the 
NovoSampler Q to NovoCyte 
flow cytometer. 

►► Turn on NovoCyte Quanteon 
and follow the prompts to ca-
librate the NovoSampler Q.

0x0109 Fluidics station is not 
connected

Cable between the 
fluidics station and 
the NovoCyte Quan-
teon instrument is 
not properly con-
nected 

►► Power down the instrument. 

►► Reconnect the cable between 
the fluidics station and the 
NovoCyte Quanteon instru-
ment. 

►► Power up the instrument.

0x010A 
0x010B 
0x010C 
0x010D

… liquid level sensor 
failure

Specified liquid level 
sensor in the fluidics 
station is not work-
ing properly 

►► Reconnect the fluidics station 
cable. 

►► Restart the NovoCyte Quan-
teon instrument. 

►► Replace the fluidics station.
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0x010F Sheath filter is clogged. 
Please replace the 
sheath filter and run the 
Priming procedure

Sheath in-line filter 
is clogged 

Replace the sheath in-line filter 
following the procedures de-
scribed in Section 1.2 Replacing 
Fluidic System Consumables in 
NovoCyte QuanteonTM Mainte-
nance Guide.

0x0110 Recovering collision error Plate stops at an in-
correct position

No action is needed. Instrument 
will automatically recover the er-
ror.

0x0111 Orbital shaker homing 
position reset failure

Orbital shaker of No-
voSampler Q is not 
working properly

No action is needed. The No-
voSampler Q can be used nor-
mally.

0x1001 Fluidics procedure run 
error

Fluidics procedure 
file is damaged

Restart the instrument.

0x3100 Failed to read optical 
filter information

Optical filter sensor 
is not working prop-
erly

Replace the appropriate filter fol-
lowing the procedures described 
in Section 2.1.6 Verify and Modify 
Instrument Configuration in No-
voCyte QuanteonTM Maintenance 
Guide.

0x3101 Failed to read dichroic 
mirror information

Dichroic mirror sen-
sor is not working 
properly

Replace the appropriate mirror 
following the procedures de-
scribed in Section 2.1.6 Verify and 
Modify Instrument Configuration 
in NovoCyte QuanteonTM Mainte-
nance Guide.

0x3102 Failed to read photode-
tector information

Photodetector sen-
sor is not working 
properly

Restart the instrument.

0x3103 The optical filter informa-
tion has been changed

The optical filter has 
been replaced

Follow the software prompted in-
structions to perform the appro-
priate operation.

0x3104 The dichroic mirror 
information has been 
changed

The dichroic mirror 
has been replaced 

Follow the software prompted in-
structions to perform the appro-
priate operation. 

0x3105 The photodetector 
information has been 
changed

The photodetector 
has been replaced

Follow the software prompted in-
structions to perform the appro-
priate operation.

0x6100 Communication error 
between NovoSampler 
and the orbital shaker

Bad connection be-
tween NovoSampler 
Q and shaker or No-
voSampler Q is not 
working properly.

Restart NovoCyte Quanteon in-
strument.
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0xA003 The temperature of 
the photodetectors is 
abnormal

Ambient tempera-
ture outside the op-
erating range

►► Ensure to have the instru-
ment working at normal am-
bient temperatures.

►► Restart NovoCyte Quanteon 
instrument

More than four tem-
perature sensors 
of the photodetec-
tor module are not 
working properly 

Restart NovoCyte Quanteon in-
strument

0xA100 The temperature of 
the photodetectors is 
abnormal

One to three tem-
perature sensor of 
the photodetector 
module is not work-
ing properly

No action is needed. The Novo-
Cyte Quanteon instrument can 
be used normally.

Communication error 
(code: xx, xx). Please 
restart NovoCyte and 
NovoExpress.

USB cable between 
the NovoCyte Quan-
teon instrument and 
workstation is not 
connected properly

►► Turn off the instrument. 

►► Reconnect the USB ca-
ble between the NovoCyte 
Quanteon instrument and the 
workstation. 

►► Restart the instrument and 
NovoExpress software.

n

9.3	 Technical Support Request

In case you need to contact ACEA technical supports, use the Technical Support Request from 
Home menu to create a request. Technical Support Request Creation Wizard automatically collects 
NovoCyte configurations, NovoExpress system logs, current screenshot, current experiment file 
and other information that helps diagnosis and troubleshooting of NovoCyte instrument. You 
can also attach any other files using this function. 

1 Click Home → Technical Support Request to open the Technical Support Request Creation Wizard.
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2 Click Next button and input request description.

3 Click Next button and select the files to be attached. Any related files including experiment files 
(*.ncf) can be attached.

4 Click Create button to start creating technical support request. 

5

After the request creating process is completed, send the created request files to ACEA techni-
cal support through email (techsupport@aceabio.com). Click Finish to complete this process.

n
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Appendix 1	 Keyboard Shortcuts

Shortcuts Command

Overall Situation

Ctrl+S Save the file 

Ctrl+W Close the file 

Ctrl+O Open the file 

Ctrl+N New file 

Ctrl+[ Switch the active sample to the previous sample 

Ctrl+] Switch the active sample to the next sample 

Ctrl+1 Create a dot plot 

Ctrl+2 Create a density plot 

Ctrl+3 Create a histogram 

Ctrl+4 Create a contour plot 

Ctrl+5 Create a cell cycle diagram 

Ctrl+6 Create a cell proliferation diagram

F5 Run / Stop 

F4 Next sample 

F3 Next sample without template 

F8 Restart

Plot

Ctrl+Z Undo 

Ctrl+Y or Ctrl+Shift+Z Redo 

Alt+1 Change to dot plot

Alt+2 Change the density plot 

Alt+3 Change to histogram 

Alt+4 Change to contour plot 

Alt+5 Change to cell cycle diagram 

Alt+6 Change to cell proliferation diagram

Ctrl++ Zoom In

Ctrl+- Zoom Out

Ctrl+A Auto Range 

Ctrl+F Full Range 
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Shortcuts Command

Ctrl+C Copy the plot or gate 

Ctrl+V Paste gate 

Ctrl+D Duplicate a plot or gate 

Alt+Q Quick compensation 

Ctrl+R Rectangular gate 

Ctrl+E Elliptical gate 

Ctrl+P Polygonal gate 

Ctrl+Q Quadrant gate 

Ctrl+L Logic gates

Ctrl+H Range gates 

Ctrl+B Bi-Range gates 

Ctrl+M Move

Ctrl+T Adjust threshold

Experiment Manager

Ctrl+C Copy

Ctrl+V Paste

Ctrl+D Duplicate

F2 Rename

n
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Appendix 2	 Glossary

Workspace: In the main interface of the NovoExpress Software, the middle area where 
plots are displayed.

Experiment File: The NovoExpress Software saved experimental data files. A file can store 
experimental data from multiple samples. 

Experiment Management: The NovoExpress Software uses samples, specimens, and groups 
in a hierarchy structure to organize the experimental data, instrument settings, analysis 
and other information. The organization is displayed in the Experiment Manager panel. 

Group: A part of the NovoExpress Software’s hierarchy structure. The group can contain 
multiple specimens.

Specimen: A part of the NovoExpress Software’s hierarchy structure. Specimen can be 
composed of many samples; multiple samples of the same test items can be placed in a 
specimen; a clinical specimen can correspond to a patient.

Sample: The basic unit of experimental data organization. Samples contain the informa-
tion from sample data collection, instrument settings, fluorescence compensation, report-
ing, analysis and data.

Blank samples: Samples without collected event data. Blank samples only contain instru-
ment settings. A blank sample must first be created before sample collection begins. Cre-
ated blank samples contain the default settings from the previously created sample. See the 
icon for a blank sample in Section 6.2.

Active sample: The sample currently displayed and being analyzed. The cytometer control 
and settings panels display basic information regarding the active sample. In the Experi-
ment Manager panel, the active sample is indicated by a red arrow. To switch the active 
sample, double-click on a new sample in the Experiment Manager panel, use the Switch 
Active Sample buttons from the Sample tab of the Menu Bar, or use the keyboard shortcut 
Ctrl+[ and Ctrl+].

Sample currently in acquisition: Usually, sample currently in acquisition is same as active 
sample; however, they do not have to be same sample. After sample acquisition is started, 
user can switch active sample to other sample for analysis purpose. In experiment man-
ager panel, sample currently in acquisition has a flash arrow (alternating green and dark 
green). If sample currently in acquisition is same as active sample, the arrow alternating 
red and green.

Event: Refers to a particle that passes the acquisition threshold and has a set of data on 
intensity collected. Events are due to particles including microspheres and cells.

Instrument settings: The settings include the sample, the stop condition, the sample flow 
rate, and the threshold settings. 

Parameters: Refers to fluorescent or scattering intensity measurements. Parameters can be 
differentiated by the specific light channel or measurement type (height or area). 

Stop condition: A defined number of events, length of time, or volume of collection, where 
sample collection is stopped immediately after reaching the condition.

Threshold: The minimum value of defined parameters where if the signal is lower than the 
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defined value, the data will be discarded. By setting an appropriate threshold value, the 
target events can be effectively captured. A threshold value too high will discard target 
events, while a threshold too low will include a large noise from small events being col-
lected.

Sample flow rate: The flow rate of the sample can be used to control the number of events 
collected per second.

Report: Reports can be either a specimen report or a sample report. A sample report can 
contain plots, statistical information, compensation matrices, and collection information 
for the sample. A specimen report will contain information for all of its samples.

Analysis: The process of plotting, gating, and comparing statistical information on col-
lected parameters of samples.

Plot: Tool for displaying sample information, including fluorescence or scattered light in-
tensity. In the NovoExpress Software, plots include dot plots, density plots, histograms, 
contour plots and cell cycle diagrams.

Layer: The option to superimpose multiple plots to make a comparison. This tool is avail-
able with histograms and dot plots. The overlay plots then contain these superimposed 
layers.

Dot plot: Two-parameter plot. Each axis can plot a parameter. Multiple overlapping points 
will be displayed the same as a single point in a dot plot.

Density plot: Two-parameter plot. Each axis can plot a parameter. The color of a point on 
the plot will be an indicator of the number of events at that point.

Histogram: Single-parameter plot. The X-axis will plot a parameter, and the Y-axis will plot 
the number of events. 

Contour plot: Two-parameter plot. Each axis can plot a parameter. The plot uses contour 
lines to indicate the density of populations on the plot.

Cell cycle diagram: Uses a histogram of DNA content to derive cell cycle phase populations 
based on curve fitting to the histogram. 

Cell proliferation diagram: Generates c modeling results to analyze  different cell genera-
tions during the cell proliferation procedure. 

Gate: Used to select a specific population of events. Gate types include rectangular, ellipti-
cal, polygonal, range, and bi-range gates. Gates can also be combined to create logic gates. 
Gates are used to further analyze specific populations.

Logic gates: The combination of individual gates using the logic operators AND, OR, or 
NOT to create logic gates.

Fluorescence compensation: Different fluorescent dyes emit different emission spectrums. 
When emission spectrums overlap, this is known as spectrum overlap. When the overlap 
occurs within a detection channel, fluorescence compensation can be used to mathemati-
cally compensate by removing the signal that does not belong in the channel.

Quick compensation: Use scrollbars in two-parameter plots to quickly adjust the fluores-
cence compensation of a sample.

Automatic compensation: Use a specimen containing an unstained sample and single 
stained samples to automatically calculate a compensation matrix. 
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Absolute count: Number of cells or particles per unit volume. NovoCyte is a volumetric 
instrument, thus, exact volumes of acquired sample can be determined without the need 
for counting beads. After the dilution factor and unit of measure (default is # of events per 
µL) are defined by user, NovoExpress can display number of events within specified gate 
per unit volume in the statistical information chart.

Post Gain: In certain situation, user may want to align a particular peak on different sam-
ples in the same plot. Post Gain function allows such adjustment performed after data 
acquisition.

Templates: Set contains the group, instrument settings, specimens and samples, fluores-
cence compensation, reporting, analysis, etc., can be saved as *.nct file format.

Statistical tables: A customizable table of statistical information for batch data analysis. 
It can contain multiple samples, multiple gates, and statistical information for multiple 
parameters.

Work List: Displays the samples as rows in a table. Sample settings are also listed and can 
be set in the table, including specimen name, sample name, parameters, stop condition, 
sample flow rate, threshold, compensation, and analysis is reporting information. Allows 
the user to quickly create and manage multiple samples.

QC test: In QC test, NovoCyte QC particles are used to check the instrument perfor-
mance. Measured data are used to determine if the NovoCyte System’s parameters fall 
within a standard range to ensure stable and reliable operation of the instrument.

QC test reports include: QC test reports contain parameters for individual QC test results, 
and it can also plot results over a period of time in the Levey-Jennings reports.

Debubble: Clear bubbles present in the sample line.

Cleaning: Clear biological hazards that may exist in the pipeline.

Rinse: Rinse tubing.

Extensive Rinse: Extensively rinse tubing.

Priming: Use after the instrument has been inactive for a long period of time to fill the 
tubing with fresh sheath fluid and clear any bubbles.

Unclog: Clear blockages in the flow cell.

Backflush: Clear blockages in the sample pipeline.

FCS: Data file standard for flow cytometry. NovoExpress is compatible with FCS 3.0 and 
3.1.

Heat Map: Heat map can  be used to visualize the data  in a well plate format. It uses dif-
ferent color to display the result of a specified statistical parameter.

LIS (Laboratory Information System): Result of a statistical table and plots can be exported 
and parsed by LIS.
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